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Notice
Every effort was made to ensure that the information in this book was complete 
and accurate at the time of printing. However, information is subject to change.

Avaya Web Page
The world wide web home page for Avaya is:
http://www.avaya.com

Preventing Toll Fraud 
Toll Fraud is the unauthorized use of your telecommunications system by an 
unauthorized party (for example, a person who is not a corporate employee, 
agent, subcontractor, or working on your company�s behalf). Be aware that 
there is a risk of toll fraud associated with your system and that, if toll fraud oc-
curs, it can result in substantial additional charges for your telecommunications 
services.

Avaya Fraud Intervention
If you suspect that you are being victimized by toll fraud and you need technical 
assistance or support, call the Technical Service Center Toll Fraud Intervention 
Hotline at 1.800.643.2353.

Providing Telecommunications Security
Telecommunications security of voice, data, and/or video communications is 
the prevention of any type of intrusion to, that is, either unauthorized or mali-
cious access to or use of, your company�s telecommunications equipment by 
some party.

Your company�s �telecommunications equipment� includes both this Avaya 
product and any other voice/data/video equipment that could be accessed via 
this Avaya product (that is, �networked equipment�).

An �outside party� is anyone who is not a corporate employee, agent, subcon-
tractor, or working on your company�s behalf. Whereas, a �malicious party� is 
Anyone, including someone who may be otherwise authorized, who accesses 
your telecommunications equipment with either malicious or mischievous in-
tent.

Such intrusions may be either to/through synchronous (time-multiplexed and/
or circuit-based) or asynchronous (character-, message-, or packet-based) 
equipment or interfaces for reasons of:

� Utilization (of capabilities special to the accessed equipment)
� Theft (such as, of intellectual property, financial assets, or toll-facility 

access)
� Eavesdropping (privacy invasions to humans)
� Mischief (troubling, but apparently innocuous, tampering)
� Harm (such as harmful tampering, data loss or alteration, regardless of 

motive or intent)
Be aware that there may be a risk of unauthorized intrusions associated with 
your system and/or its networked equipment. Also realize that, if such an intru-
sion should occur, it could result in a variety of losses to your company, includ-
ing but not limited to, human/data privacy, intellectual property, material assets, 
financial resources, labor costs, and/or legal costs).

Your Responsibility for Your Company�s Telecommunications Security
The final responsibility for securing both this system and its networked equip-
ment rests with you � an Avaya customer�s system administrator, your tele-
communications peers, and your managers. Base the fulfillment of your 
responsibility on acquired knowledge and resources from a variety of sources 
including but not limited to:

� Installation documents
� System administration documents
� Security documents and anti-virus patches
� Hardware-/software-based security tools
� Shared information between you and your peers
� Telecommunications security experts

To prevent intrusions to your telecommunications equipment, you and your 
peers should carefully program and configure your:

� Avaya provided telecommunications systems and their interfaces
� Avaya provided software applications, as well as their underlying hard-

ware/software platforms and interfaces
� Any other equipment networked to your Avaya products

Avaya does not warrant that this product is immune from or will prevent unau-
thorized use of telecommunication services or facilities accessed through or 
connected to it. Avaya is not responsible for any damages or charges that re-
sult from either unauthorized uses or from incorrect installations of the security 
patches that are made available from time to time. 
Suspected security vulnerabilities with Avaya products should be reported to 
Avaya by sending mail to securityalerts@avaya.com.

Federal Communications Commission Statement
Part 15: Class A Statement. This equipment has been tested and found to 
comply with the limits for a Class A digital device, pursuant to Part 15 of the 
FCC Rules. These limits are designed to provide reasonable protection against 
harmful interference when the equipment is operated in a commercial environ-
ment. This equipment generates, uses, and can radiate radio-frequency ener-
gy and, if not installed and used in accordance with the instructions, may cause 
harmful interference to radio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference, in which case the user 
will be required to correct the interference at his own expense.

Industry Canada (IC) Interference Information
This digital apparatus does not exceed the Class A limits for radio noise emis-
sions set out in the radio interference regulations of Industry Canada.

Le Présent Appareil Nomérique n�émet pas de bruits radioélectriques dépas-
sant les limites applicables aux appareils numériques de la class A préscrites 
dans le reglement sur le brouillage radioélectrique édicté par le Industrie Can-
ada.

Trademarks
All trademarks identified by ® and � are registered trademarks or trademarks 
of Avaya Inc. All other trademarks are the property of their respective owners. 

Ordering Information
Call: Avaya Publications Center

Voice 1 800 457-1235   International Voice +1 207 866 6701
Fax 1 800 457-1764      International Fax +1 207 626 7269

Write: GlobalWare Solutions
200 Ward Hill Avenue
Haverhill, MA 01835 USA
Attn: Avaya Account Management

Email: totalware@gwsmail.com

Obtaining Products
To learn more about Avaya products and to order products, visit 
www.avaya.com. 

European Union Declaration of Conformity
The �CE� mark affixed to the equipment means that it conforms to the refer-
enced European Union (EU) Directives listed below:
EMC Directive89/336/EEC   
Low-Voltage Directive73/23/EEC
For more information on standards compliance, contact your local distributor.

Warranty 
Avaya Inc. provides a limited warranty on this product. Refer to your sales 
agreement to establish the terms of the limited warranty. In addition, Avaya�s 
standard warranty language as well as information regarding support for this 
product, while under warranty, is available through the following Web site: 
www.avaya.com/support.



iiiMay 2004 585-310-330, Issue 1

Contents

 About this book. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . i-ix

Purpose . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . i-ix
Intended audiences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . i-ix
How to use this book . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . i-x

Installing a new system. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . i-x
Updating or repairing a system . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . i-xi
Using links in this document . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . i-xi

Trademarks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . i-xii
Related resources . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . i-xii

Documentation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . i-xii
Technical assistance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . i-xii
Training . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . i-xiii
How to comment on this book. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . i-xiii

Chapter 1 Preinstallation requirements
Required documentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-2

Information on the Web. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-2
Documentation and software shipped with the system . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-3

Security considerations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-4
Customer responsibility for the security of their system . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-4
On-site security . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-5
System security. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-5

Initial switch and LAN administration. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-6
Initial switch or PBX administration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-6
Initial LAN administration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-6
Preinstallation planning forms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-6

Test equipment and tools. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-7
Test equipment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-7
Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-7

Hardware requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-8



Avaya Modular Messaging for IBM Lotus Domino Release 1.1 Installation

iv May 2004585-310-330, Issue 1

Chapter 2 Installing Avaya-provided hardware
Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-2
Site requirements for an Avaya MAS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-3

Environmental requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-3
Weight and space considerations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-3
Customer-provided cabinet requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-3
Installation area requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-4
Power requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-4
Grounding requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-5
Demarcation points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-6

Unpacking the hardware  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-7
Required and optional hardware . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-7
Saving the packing materials. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-8

Installing the Avaya MAS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-8
Installing the UPS and EBMs (optional)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-10
Installing the Avaya MAS. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-14
Installing the KVM switch (optional). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-23
Attaching ferrites . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-27
Connecting the USB modem on the MAS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-28
Powering up an Avaya MAS system . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-30

Chapter 3 Installing MAS port boards
Supported MAS port boards  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-2
Installing MAS port boards . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-2

Preparing for the installation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-3
Setting jumpers and switches . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-4
Installing the port boards . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-8

Installing the Dialogic drivers and software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-9
Installing the new Dialogic drivers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-10
Applying the Dialogic Feature Pack. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-10

Connecting the MAS port boards. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-12
Completing the hardware installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-13

Chapter 4 Preparing to install Modular Messaging software
Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-2
Setting up Domino to support Modular Messaging  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-3
Setting up Windows to support Modular Messaging . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-5

Setting up Modular Messaging accounts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-5
Adding an MAS account to the Windows domain . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-6
Setting up the MAS for remote access  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-6

Chapter 5 Configuring a new Avaya MAS
Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-2



Contents

vMay 2004 585-310-330, Issue 1

Switching the monitor to show the correct server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-2
Starting up the system. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-3

Setting up the Windows system  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-4
Running the setup wizard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-4
Assigning IP addresses to this MAS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-6
Completing the initial setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-9

Testing IP addresses using ping . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-11
Installing required software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-12

Installing anti-virus software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-12
Updating Microsoft Windows. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-12
Preparing the MAS to support Domino . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-12
Setting up remote access (optional) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-14

Configuring Modular Messaging components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-15

Chapter 6 Configuring a customer-provided MAS
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-2
Preparing the MAS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-3

Configuring the network card  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-3
Installing anti-virus software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-3
Updating Microsoft Windows. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-3
Running recommended disk checks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-3

Joining the Windows domain. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-4
Adding Modular Messaging accounts to the local Administrators group . . . . . . . . . . . . . . . . . . . . . . 6-5
Adjusting system values  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-6
Installing Windows prerequisite software. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-8
Preparing the MAS to support Domino . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-9

Chapter 7 Installing and configuring the Modular Messaging software
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-2
Installing Modular Messaging software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-3

Running the installation wizard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-3
Installing the Modular Messaging software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-4

Configuring the MAS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-8
Setting up remote access  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-11

Preparing an Avaya MAS for remote access  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-13
Completing remote access setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-14

Chapter 8 Configuring and testing the port boards
Configuring the port boards . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-2

Configuring analog port boards. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-3
Configuring set emulation boards . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-5
Configuring T1- or E1-QSIG boards . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-7

Testing the port boards  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-10



Avaya Modular Messaging for IBM Lotus Domino Release 1.1 Installation

vi May 2004585-310-330, Issue 1

Chapter 9 Configuring the voice mail system
Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-2
Configuring the voice mail system . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-2

Configuring domain-wide features. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-3
Configuring MAS-specific parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-12

Completing initial MAS administration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-14
Setting up and starting messaging services  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-14
Verifying alarming setup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-15

Completing the Domino setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-16
Editing the voice mail summary document  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-16
Installing the DUC client component . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-16
Synchronizing the clocks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-18

Chapter 10 Testing and backing up the system
Adding a test subscriber  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-2
Performing acceptance tests . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-3

Setting up the port monitor  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-3
Creating and sending a call answer message. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-4
Retrieving test messages in integrated mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-4
Creating and sending a test message in nonintegrated mode  . . . . . . . . . . . . . . . . . . . . . . . . . 10-5
Testing the outcalling capability . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-6
Running additional tests  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-8

Administering subsequent MASs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-8
Removing the test subscriber  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-8
Backing up the system. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-9

Chapter 11 Updating Unified Messenger R5.0 to Modular Messaging software
Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11-2

Update requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11-2
Update procedure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11-3
Considerations for multiple-MAS updates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11-4

Preparing the MAS for the update . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11-5
Updating the Dialogic port board drivers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11-6

Preparing for driver installation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11-6
Uninstalling the existing Dialogic drivers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11-7
Installing the new Dialogic drivers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11-8
Applying the Dialogic Feature Pack. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11-8
Reconfiguring the Dialogic port boards . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11-9

Updating messaging software on the MAS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11-10
Updating to Modular Messaging software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11-10
Running a system upgrade . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11-13
Configuring the MAS for the new software  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11-14
Installing the license file and configuring new features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11-15



Contents

viiMay 2004 585-310-330, Issue 1

Setting up and starting messaging services . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11-16
Completing the update  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11-17

Appendix A System planning forms
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-1

Terminology. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-2
Guidelines for completing the forms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-4
MAS services and features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-11
Required licensing information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-12
Switch and messaging information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-14
Support information. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-15

Appendix B Installation checklists
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-1

New Modular Messaging installation on a customer-provided MAS . . . . . . . . . . . . . . . . . . . . . . B-2
New Modular Messaging installation on an Avaya MAS. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-5
Unified Messenger R5.0 to Modular Messaging software update. . . . . . . . . . . . . . . . . . . . . . . . B-9

Appendix C Creating a new tone file
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-1
Learning tones automatically. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-2

Running the PBXpert wizard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-2
Consolidating and saving the TSF file. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-6
Using the new TSF in Dialogic Configuration Manager  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-6

Learning tones manually . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-7
Running PBXpert  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-7
Adding a new tone set. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-8
Learning tone definitions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-8
Testing the tone set . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-10
Consolidating and saving the TSF file. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-10
Using the new TSF in Dialogic Configuration Manager  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-10

Appendix D Reloading software on an Avaya MAS
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .D-1
Loading new MAS software. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .D-1

Appendix E Recovering from a catastrophic disk failure
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . E-1
Recovery procedure  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . E-1

Restoring an MAS after a catastrophic disk failure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . E-2
Restoring Caller Applications after a catastrophic disk failure  . . . . . . . . . . . . . . . . . . . . . . . . . . E-3

Appendix F Obtaining a license for an update
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-1



Avaya Modular Messaging for IBM Lotus Domino Release 1.1 Installation

viii May 2004585-310-330, Issue 1

Planning to submit a license request. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .F-1
Obtaining the MmVMDAudit tool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .F-2

Completing the update planning form  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .F-2
Obtaining license data for an update . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .F-4

Using the MmVMDAudit tool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .F-4
Calculating the number of TTS sessions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .F-6
Recording the required licensing information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .F-7

Sending the license request. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .F-9
Submitting requests in APAC. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .F-9
Submitting requests in Australia  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .F-10
Submitting requests in CALA. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-11
Submitting requests in Canada . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-11
Submitting requests in EMEA . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .F-12
Submitting requests in North America (excluding Canada). . . . . . . . . . . . . . . . . . . . . . . . . . . .F-13

Appendix G Removing Modular Messaging components
Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . G-1
Removing software components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . G-1

Index. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . IN-i



May 2004 585-310-330, Issue 1 ix

 About this book

Purpose
This book, Avaya Modular Messaging for IBM Lotus Domino Release 1.1 Installation, 
Issue 1, contains instructions for installing or updating the Avaya Modular Messaging 
software in an IBM Lotus Domino environment. Information includes:

! Instructions for installing a new system, including equipment assembly, 
set up and configuration, initial administration, and acceptance testing 

! Instructions for updating a system from Unified Messenger Release 5.0 
software

! Disaster-recovery procedures for a hard disk failure, including 
reinstalling the software and restoring lost data 

Intended audiences
This book is intended for system administrators and on-site technical personnel who 
are responsible for installing, configuring, or updating the hardware and software for an 
Avaya Modular Messaging system. 

Users of this book should be familiar with administering Microsoft Windows 2000 and 
IBM Lotus Domino systems. Avaya assumes that users have read the Avaya Modular 
Messaging Concepts and Planning Guide. 

Note: This document is intended to get a Modular Messaging system up 
and running. After the installation, customers are encouraged to 
tailor the Modular Messaging parameters for their site using the 
Avaya Modular Messaging Software Messaging Application Server 
Administration Guide (PDF 3 MB). Copies of the administration 
guide are on the documentation CD and application software DVD. 
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Technicians who install an Avaya-provided Messaging Application Server (called the 
�Avaya MAS� in this guide) should have completed a relevant hardware installation 
training course. See "Related resources" in this preface for information on training.

How to use this book
Review the appropriate section below, depending on whether you are installing a new 
Avaya Modular Messaging system, or updating or repairing a system that was already 
in operation. 

Installing a new system 

This document describes how to install Avaya Modular Messaging software either on a 
customer-provided Messaging Application Server (MAS), or on hardware provided by 
Avaya (called the �Avaya MAS� in this guide). Although most steps are similar for both 
types of installation, this guide does contain sections that are only applicable to one or 
another of these specific hardware types, as noted in the text. 

To install a new system, follow these general steps:

1. Verify that the system meets the requirements specified in the Avaya 
Modular Messaging Concepts and Planning Guide (PDF 2 MB). The 
planning guide explains important concepts and provides information 
that is crucial for planning a Modular Messaging installation. 

2. Complete all the worksheets in Appendix A, ��System planning forms.�� 
You cannot complete an installation or update successfully unless this 
material is complete and accurate. The customer must provide some of 
the information in advance. Check with your regional representative to 
see if the planning forms should be reviewed prior to an installation. 

3. Read Chapter 1, ��Preinstallation requirements.�� This chapter lists 
installation prerequisites, including the required documentation, tools, 
and equipment that you will need to complete an installation. 

4. Install the hardware required for this specific installation: 

! See Chapter 2, ��Installing Avaya-provided hardware,�� if you are 
installing an Avaya-provided Messaging Application Server (Avaya 
MAS) system and any optional peripheral devices provided by Avaya 
Inc. The port boards and much of the required software are already 
installed on an Avaya MAS. 

Note: Print the relevant checklist from Appendix B, ��Installation 
checklists,�� depending on whether you are installing the Modular 
Messaging software on a customer-provided MAS or an Avaya 
MAS. The steps vary for the different setups. Keep the checklist 
handy and use it to track your progress during the installation. 
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! See Chapter 3, ��Installing MAS port boards,�� to install the required 
port boards and Dialogic software in a customer-provided MAS. 

5. Read Chapter 4, ��Preparing to install Modular Messaging software,�� 
which lists prerequisite steps that must be done on the Domino server by 
the system administrator or other authorized personnel. This work must 
be completed before any other Modular Messaging software is installed. 

6. Using the checklist as a guide, follow the directions in each subsequent 
chapter to install, configure, and test the Modular Messaging software. 

Updating or repairing a system

For systems that are already installed, this guide describes update and disk repair 
activities. Follow the relevant procedure below: 

! For a software update: Begin with Chapter 11, ��Updating Unified 
Messenger R5.0 to Modular Messaging software.�� 

� Print the update checklist from Appendix B, ��Installation checklists.�� 

� Complete the "Planning form for update to Modular Messaging R1.1" 
on page F-3 and the "Modular Messaging R1.1 license request - IBM 
Lotus Domino system" on page A-13. 

� Obtain the software and documentation listed in the "Overview" on 
page 11-2. Proceed as directed.

! For an Avaya MAS hard disk repair: Go directly to Appendix E, 
��Recovering from a catastrophic disk failure.�� Proceed as directed.

Using links in this document

For your convenience, the installation guide provides direct linking to other files or 
pages when viewed in PDF form. Links appear in blue text and operate as follows: 

! Internal links within this document (such as to tables, figures, or other 
sections) always work when you are using the PDF version of this guide. 

! If you are using the PDF version of this guide on the documentation 
media or on a Web site that contains the complete document set, you 
can click any blue link to an external document (such as a PDF file or 
HTML file) to go directly to the linked page or document. 

Note: No hardware installation is required if you are using an IP 
H.323 integration on a customer-provided MAS. 

Note: Completely install and test one MAS first, and let it run for 15 
minutes before installing the software on any additional MASs. 
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! If you are using the PDF version of this installation guide on a system 
that is connected to the Internet, you can click the blue link for any Web 
site address (such as www.avaya.com) to go directly to the linked page. 

Trademarks
Avaya and the Avaya Logo are trademarks of Avaya Inc. and might be registered in 
certain jurisdictions. Unless otherwise specified, all trademarks identified by ® and � 
are registered trademarks or trademarks, respectively, of Avaya Inc. 

Microsoft is a registered trademark of Microsoft Corporation. IBM, Lotus and Domino 
are trademarks or registered trademarks of International Business Machines 
Corporation. All other trademarks are the properties of their respective owners.

Related resources
This section describes additional documentation and training available to you.

Documentation

See the inside front cover for information on how to order documentation for this 
product. 

Technical assistance

The following technical assistance is available if needed. 

Remote support center

Your project manager or systems consultant is responsible for providing you with the 
telephone number of the appropriate remote support center.

The following numbers are available for technical assistance with Avaya products and 
services: 

! Within the United States and Canada: call 1-800-876-2835, choose 
prompt 2, and then choose 2 again.

! Within any other country: call your local distributor.

Note: Always refer to the appropriate CD, DVD, or book for specific 
information on planning, installing, administering, or maintaining an 
Avaya system. See the Avaya Support Web site at 
www.avaya.com/support for information on other books and 
CD-ROMs in the documentation set for this product.

http://www.avaya.com
http://www.avaya.com/support
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Help on the system

Online help is available on the MAS. Use the Help menu or Help button (if available) for 
the application or wizard you are in. 

Training 

For information about product training, go to the Avaya Web site at 
http://www.avaya.com and click Training.

How to comment on this book

Avaya is interested in your suggestions for improving this information. Use one of the 
following methods to communicate with us:

Please be sure to include the name of this book:

Avaya Modular Messaging for IBM Lotus Domino Release 1.1 Installation, Issue 1. 

Method Contact

Email infodev@avaya.com

Voice mail or fax 303-538-9625

http://www.avaya.com
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1
Preinstallation requirements

This chapter describes requirements and prerequisites for installing Avaya Modular 
Messaging software on a new system in an IBM Lotus Domino environment. 

Topics in this chapter include: 

Section Page

Required documentation 1-2

� Information on the Web 1-2

� Documentation and software shipped with the system 1-3

Security considerations 1-4

� Customer responsibility for the security of their system 1-4

� On-site security 1-5

� System security 1-5

Initial switch and LAN administration 1-6

� Initial switch or PBX administration 1-6

� Initial LAN administration 1-6

� Preinstallation planning forms 1-6

Test equipment and tools 1-7

Hardware requirements 1-8
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Required documentation

The following documentation is required to install a new Avaya Modular Messaging 
system. Some of this information can be obtained only from the Avaya Web site. Other 
information is available on the Avaya Modular Messaging Documentation CD or the 
DVD shipped with the system software. However, required documentation can also be 
accessed online and printed out prior to beginning the actual installation.

Information on the Web

Required documentation for a new installation is available as follows: 

! The Administrator�s Guide for Lotus Domino Unified Communications for 
Avaya contains information required to install and configure Domino 
Unified Communications (DUC) for Avaya messaging software. This 
guide is available on the IBM Lotus Documentation Web site: 

a. Go to http://www-10.lotus.com/ldd/doc and click the documentation link by 
product. Click Domino Unified Communications, and then click 1.2.2. 

b. Download or view the Domino Unified Communications administrator guide, 
readme file, and client help for Avaya. 

! Configuration notes for integrating the MAS (and any Dialogic port 
boards installed in it) with the PBX or switch at this site. To view these: 

a. Go to the www.avaya.com/support Web site. Under Technical Database, 
click Messaging > Applications > Modular Messaging. 

b. Under General Info, download or print the configuration notes for the 
switch integration you need. 

! An editable Microsoft Word version of the planning forms from Appendix 
A, ��System planning forms,�� and the installation and update checklists 
from Appendix B, ��Installation checklists,�� are also accessible from the 
Avaya Support Web site. To download a Word or PDF version of these 
forms, follow the Avaya Modular Messaging Release 1.1 Documentation 
CD link, and look in the Reference section. See the item below for 
details on accessing documentation CD files online. 

Note: Always check the Avaya Support Web site at 
www.avaya.com/support for recent updates related to this product. 

Note: If you are using the PDF version of this installation guide 
online, you can click any blue link (such as 1.2.2 above, or 
any Web site address) to go directly to the linked Web page. 

Note: This information is available only on the Avaya Support Web 
site and must be obtained prior to installing the software. 

http://www-10.lotus.com/ldd/doc
http://www.avaya.com/support
http://www-10.lotus.com/ldd/notesua.nsf/a08df36b2299a8bc8525665d006dce40/fa75f3e569ae6aa685256daa00566137?OpenDocument
http://www-10.lotus.com/ldd/notesua.nsf/a08df36b2299a8bc8525665d006dce40/fa75f3e569ae6aa685256daa00566137?OpenDocument
http://www.avaya.com/support
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! Additional information needed for installing a new system is in the 
document set on the Avaya Modular Messaging Application Software 
disk and the documentation CD. To access this information online:

a. Under R 1.1, click CD Collections.

b. Click Avaya Modular Messaging Release 1.1 Documentation CD.

c. Under Files, click View HTM.

d. On the Avaya Modular Messaging Documentation CD Release 1.1 page, 
click the link to see the document set for the required configuration (such as 
Avaya Modular Messaging for IBM Lotus Domino). 

e. On the Modular Messaging Help home page, expand Reference.

f. Click to view or print, or right-click to download the files you need:

! The appropriate Dialogic port board installation documents for this 
site (see Table 3-1 on page 3-2 for details)

! Avaya Modular Messaging Subscriber Options User Guide 
(585-310-789, PDF 1 MB), used for acceptance testing

! The installation planning forms in Microsoft Word or PDF format 

Documentation and software shipped with the system

The software and documentation listed in the following table is shipped with every 
Modular Messaging system.  

Note: If you are using the PDF version of this installation guide on 
the documentation media or on a Web site that contains the 
complete document set, you can click any blue link (such as 
PDF above) to go directly to the linked page or document. 

Table 1-1. Required Modular Messaging software

Disk: Purpose:

Avaya Modular Messaging 
Application Software DVD

� Installing the Modular Messaging software, Dialogic port 
board drivers, and Text-to-Speech (TTS) software

� Updating a Unified Messenger Release 5.0 system to 
Modular Messaging Release 1.1 software 

� Accessing a copy of the documentation files (see the 
documentation CD item below for details) 

Avaya Modular Messaging 
Documentation CD 

(2 copies are shipped, one 
for the customer and one for 
the technician) 

Accessing required documentation, including:
� The port board installation documents listed in Table 3-1 

on page 3-2
� Avaya Modular Messaging Subscriber Options User Guide 

(585-310-789, PDF 1 MB), used for acceptance testing 
� Hardware replacement procedures 
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Security considerations

The following security-related issues apply to all Modular Messaging installations.

Customer responsibility for the security of their system 

No telecommunication system can be entirely free from the risk of unauthorized use. 
Customers have ultimate control over the configuration and use of the product and are 
solely responsible for ensuring the security of their systems. Customers who 
administer and use the system can tailor the system to meet their unique needs and 
are in the best position to ensure that the system is secure to the fullest extent 
possible. Customers are responsible for keeping themselves informed of the latest 
information (such as security patches, anti-virus updates, and other relevant 
information) for configuring their systems to prevent unauthorized use. System 
managers and administrators are also responsible for reading all recommendations, 
installation instructions, and system administration documents provided with the 
product so that they can understand the features that can introduce risk of toll fraud 
and the steps that must be taken to reduce that risk.

Avaya does not guarantee that this product is immune from or will prevent 
unauthorized use of telecommunication services or facilities accessed through or 
connected to this product. Avaya is not responsible for any damages or charges that 
result from either unauthorized uses or from incorrect installations of the security 
patches that are made available from time to time. To aid in combating these crimes, 
Avaya maintains strong relationships with its customers and supports law enforcement 
officials in apprehending and successfully prosecuting those responsible.

Avaya Modular Messaging 
OS Boot Software DVD

� For the Avaya MAS only: Reinstalling the boot-image 
software on a new system if needed, or on an Avaya MAS 
hard disk after a catastrophic disk failure. See Appendix D, 
��Reloading software on an Avaya MAS.�� 

CD-only set (special order only): 

Avaya Modular Messaging 
Application Software and 
Languages CD

Installing Modular Messaging Release 1.1 software on an 
MAS, or updating a Unified Messenger Release 5.0 system to 
Modular Messaging Release 1.1 software 

Intel Dialogic Drivers CD Installing or updating Dialogic port board drivers 

Enhanced Email Reader 
Software (3 CDs in set)

Installing ScanSoft RealSpeak Text-to-Speech (TTS) software 
for multiple languages

Documentation CD Identical to the CD shipped with the DVD set 

Table 1-1. Required Modular Messaging software

Disk: Purpose:
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Suspected security vulnerabilities with Avaya products should be reported to Avaya by 
sending email to securityalerts@avaya.com. Reported vulnerabilities are prioritized 
and investigated. Any corrective actions resulting from the vulnerability investigation 
are posted at http://support.avaya.com/security. Whether or not immediate support is 
required, report all toll fraud incidents perpetrated on Avaya services to Avaya 
Corporate Security at securityalerts@avaya.com. In addition to recording the incident, 
Avaya Corporate Security is available for consultation on product issues, investigation 
support, law enforcement, and education programs.

See �Modular Messaging and Security� on the Avaya Modular Messaging 
Documentation CD for more information on system security. 

On-site security

It is the responsibility of the on-site installer to take precautions to protect passwords 
and access to the physical location of the system, as described in this section.

Password security 

To protect password security: 

! Do not leave written passwords lying out or allow anyone to see them.

! At the first opportunity, give the passwords directly to the designated 
customer representative.

! If you suspect that the security of any password has been compromised, 
notify the project manager or system administrator.

System security during the installation

To protect system security during the installation: 

! Remove all test subscribers and test mailboxes from the system when 
the procedures instruct you to do so.

! Always lock the server if you leave it unattended, even for a short period 
of time.

System security

Customers are responsible for obtaining and installing anti-virus software on any 
Microsoft Windows machine that is used to run Avaya Modular Messaging software, in 
accordance with their local policy. In addition, Microsoft Windows security patches 
must be installed and routinely updated to protect the operating system from known 
security weaknesses.

http://support.avaya.com/security
se_toc.htm
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Initial switch and LAN administration

This section describes the initial switch or Private Branch Exchange (PBX) and local 
area network (LAN) administration that must be completed by the customer before or 
during a new Modular Messaging installation. 

Initial switch or PBX administration

Initial switch or PBX administration might or might not be complete when you arrive on 
site, depending on the contract or customer agreements. When you install a new 
server, the switch administration must support: 

! Testing the system with at least one test subscriber. 

! Cut-to-service procedures that provide the subscribers with an active 
coverage path. 

! For configurations that use analog and DSE port boards, the ability for 
testers to call each channel individually. The appropriate party should 
test each channel to be connected to the system before assigning the 
channels to the server or another application.

Verify that initial switch administration and testing is complete.

Initial LAN administration

The LAN administrator must administer the corporate LAN for the messaging system. 
Some LANs might be administered before the on-site installation begins. Other LANs 
require that the administration for a new server be done at the time of installation.  

Preinstallation planning forms

Complete the planning forms in Appendix A, ��System planning forms,�� prior to 
beginning an installation. By acquiring IP address, server, and domain name 
information in advance, you can save hours of installation time and debugging.
 

Note: Avaya is not responsible for the installation, administration, or test 
of communications between customer computers and the LAN.

CAUTION: It is crucial to coordinate the IP addresses that will be used 
with a Messaging Application Server (MAS) with those on 
the corporate LAN. If you specify an IP address for an MAS 
that conflicts with another Ethernet endpoint, the resulting 
traffic problems on the LAN can be extremely difficult to 
diagnose and solve.

!
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Test equipment and tools

The following test equipment and tools are recommended for all new Modular 
Messaging installations.

Test equipment

Recommended test equipment for a successful installation includes: 

! At least one telephone that is connected through the switch or Private 
Branch Exchange (PBX). It must be of the same type as the majority of 
telephones the customer will be using on the system. 

� If the message waiting indicator (MWI) for the system is a lamp, the 
test telephone must be equipped with a lamp. If the MWI is a stutter 
tone, it must be able to give the stutter notification. 

� The test telephone must be placed so that you can easily see the 
monitor while using it. 

! A volt/ohm meter. 

Tools

You should have the following tools on site to successfully install a new system: 

! A medium-width flatblade screwdriver 

! A No. 2 Phillips screwdriver 

! A small pair of needlenose pliers 

! A small pair of wire cutters 

! A sharp, pointed instrument, such as a ballpoint pen

CAUTION: Do not use the point of a lead pencil to operate the system 
reset switch. The graphite can damage a circuit card and 
cause problems, such as electrical shorts.

!
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Hardware requirements

A Modular Messaging software installation requires the following hardware:

! One or more Messaging Application Server (MAS) machines that will run 
the Modular Messaging software. These MASs can be:

� An Avaya-provided Messaging Application Server (called the �Avaya 
MAS� in this guide) on which the port boards and much of the required 
software are already installed. Some preinstallation requirements for 
this configuration are covered in Chapter 2, ��Installing Avaya-provided 
hardware.��

� A customer-provided machine that meets the minimum requirements 
specified in the Avaya Modular Messaging Concepts and Planning 
Guide (PDF 2 MB). This machine requires the appropriate port boards 
and drivers to be installed prior to installing the Modular Messaging 
software as described in Chapter 3, ��Installing MAS port boards.�� 

! A server that is running a compatible release of IBM Lotus Domino 
software. This server is hereafter referred to as the Domino server. The 
Domino server must be in place and operational prior to installing the 
Modular Messaging software. 

Because a Modular Messaging installation requires many steps, print a copy of the 
checklist relevant to this configuration (see Appendix B, "Installation checklists"). 
Check off items as you complete them to track your progress.

Note: No hardware installation is required if you are using an IIP 
H.323 integration on a customer-provided MAS. 

Note: Chapter 4, ��Preparing to install Modular Messaging 
software,�� describes prerequisite steps that must be done 
on the Domino server by the system administrator or other 
authorized personnel. This work can be done before or 
during hardware installation, but must be completed before 
any Modular Messaging software is installed. 
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Installing Avaya-provided hardware

This chapter applies only to installing Avaya-provided hardware, such as one or more 
Avaya Messaging Application Servers (called the Avaya MAS in this guide) and any 
optional peripheral devices provided by Avaya Inc. The port boards and much of the 
required software are already installed for an Avaya MAS.  

Topics in this chapter include: 

Note: Before you can successfully complete the tasks described in this 
section, you must have read Chapter 1, ��Preinstallation 
requirements,�� and verified that all preinstallation requirements 
have been met. 

To install port boards in a customer-provided MAS, continue with 
Chapter 3, ��Installing MAS port boards.��

Section Page

Overview 2-2

Site requirements for an Avaya MAS 2-3

� Environmental requirements 2-3

� Weight and space considerations 2-3

� Customer-provided cabinet requirements 2-3

� Installation area requirements 2-4

� Power requirements 2-4

� Grounding requirements 2-5

� Demarcation points 2-6
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Overview

A new system installation follows these basic steps:

! "Site requirements for an Avaya MAS" on page 2-3

! "Unpacking the hardware" on page 2-7

! "Installing the Avaya MAS" on page 2-8

Because a Modular Messaging installation requires many steps, print a copy of the 
checklist relevant to this configuration (see Appendix B, "Installation checklists"). 
Check off items as you complete them to track your progress.

Unpacking the hardware 2-7

� Required and optional hardware 2-7

� Saving the packing materials 2-8

Installing the Avaya MAS 2-8

� Installing the UPS and EBMs (optional) 2-10

� Installing the Avaya MAS 2-14

� Installing the KVM switch (optional) 2-23

� Attaching ferrites 2-27

� Connecting the USB modem on the MAS 2-28

� Powering up an Avaya MAS system 2-30

Section Page
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Site requirements for an Avaya MAS

This section describes the physical requirements for the installation site, including 
environmental, weight, space, and power considerations for an Avaya Messaging 
Application Server (Avaya MAS).

Environmental requirements

Table 2-1 lists the environmental conditions that must be maintained in the area where 
the Avaya MAS is installed and maintained.  

Weight and space considerations

Table 2-2 lists the weight, height, width, and depth of an Avaya MAS.  

For safety considerations, at least two technicians should be on site and available to 
mount the units.

Customer-provided cabinet requirements

If an Avaya MAS is to be installed in a rack-mount configuration, the customer-provided 
cabinet must meet the following requirements: 

! The cabinet must contain a 4-post rack to support the weight of the 
servers.

! The cabinet must be secured to the floor before you attempt to mount 
any units.

Table 2-1. Environmental requirements

Operating state Temperature Maximum heat output Humidity (noncondensing)

Operating +10 to +35ºC 
(+50 to +95ºF)

730 BTU per hour 20% to 80% RH

Non-operating 
(in storage or being 
shipped)

-20 to +50ºC 
(-4 to+122ºF)

N/A 20% to 90% RH

Table 2-2. Avaya MAS weight and space considerations

Server Weight (full) Height Width Depth

Avaya Messaging Application Server 
(Avaya MAS)

40 lb
(18.1 kg)
(without port boards)

6.8 in.
(17 cm)

16.9 in.
(43 cm)

18.9 in.
(48 cm)
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! The sliding rails and extender brackets provided with each Avaya MAS 
are designed for mounting in cabinets 22.5 to 32 inches in depth.

! The cabinet height must accommodate the number of units to be 
mounted (see Table 2-2 on page 2-3 for server height). It might also 
need to hold the MAS modems and optional equipment, such as the 
KVM switch and UPS units (see Figure 2-1 on page 2-9 for an example).

Installation area requirements

Observe the following when determining where to place the system: 

! Maintain an air-distribution system that provides adequately cooled, 
filtered, and humidity-controlled air. 

! Do not install the Avaya MAS in such a way that the ventilation or fan 
openings are blocked.

! For T1/E1 connections, the circuits require isolation from exposed lines. 
For T1 lines, the customer must provide a CSU (T1) at the building point 
of entry. This CSU must be UL Listed, CSA Certified, or both. For E1 
lines, either the network provider or the customer must provide a CSU 
(E1) or other equivalent protection that has the product safety approvals 
required by the local jurisdictions. 

! Systems installed in Finland, Norway, Sweden, and Australia must be 
installed in a restricted-access location. A restricted-access location is 
defined as an installation location where access can be gained only by 
service personnel or customers who have been instructed on the 
reasons for the restricted access and safety precautions that must be 
taken. A restricted-access location also allows access through the use of 
a tool (such as a lock and key) or other means of security.

Power requirements

Table 2-3 lists the power requirements for the Avaya MAS. The AC power supply 
source must be a single phase 3-conductor (line, neutral, and ground), with a 15 A 
circuit breaker for 100-127 Vac installations or a 10 A circuit breaker for 200-240 Vac 
installations. 

CAUTION: To reduce the risk of fire, use only No. 26 AWG or 
larger telecommunication line cord.!

Table 2-3. Avaya MAS power requirements

Server # of power 
supply units Volts AC Hertz Amperes 

120V/240V

Avaya MAS 1 100-240 +/� 10% 50/60 +/� 3 Hz 10/5
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Consider the server connection to a branch circuit with regard to overload or 
overcurrent protection. Verify the system ratings to ensure that, together with other 
equipment connected to the same branch circuit, an overcurrent or overload condition 
does not exist.

Grounding requirements

An Avaya MAS relies on the ground connection through the mains socket-outlet for 
continued safe operation. Ensure that the AC main outlet to be used to power the 
system (via the power cord or UPS) is a grounded outlet. If you are unsure of the 
ground integrity of the outlet, have a trained and certified electrician check the outlet. 

In addition, observe the following grounding requirements when determining where to 
place the server:

! Use only the power cord provided with each unit to connect it to the 
universal power supply (UPS) or to an AC mains outlet.

! Install the server within 6 feet (2 m) of a grounded AC mains 
socket-outlet.

! Do not use extension cords with the system.

WARNING: The Avaya MASs must be connected to an earthed mains 
socket-outlet. Failure to do so will result in allowing a hazard 
to be present that could cause severe personal injury or 
death.

!

CAUTION: System grounding must comply with the general rules for 
grounding provided in article 250 of the National Electrical 
Code (NEC), National Fire Protection Agency (NFPA), or the 
applicable electrical code in the country of installation.

!
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Demarcation points

This section lists the demarcation points for switches (PBXs) and LAN connectivity.

Demarcation point for switches (PBXs)

The demarcation point for switch (PBX) connections to the Avaya MAS is the wall field 
for Avaya switches. 

For non-Avaya switches, the demarcation point is the end of the connector of the 
Avaya-provided cables for the port boards. Avaya service technicians dispatched for 
the system installation are not responsible for making any connections directly to 
switches that are not maintained by Avaya.

Demarcation point for LAN connectivity 

The demarcation point for the LAN connection to the Avaya MAS is the physical 
Ethernet interface on the server that connects to the corporate LAN. The customer is 
responsible for: 

! Providing the LAN cables that connect the Avaya MAS to the corporate 
system (unless the customer uses Avaya-provided cables, in which case 
the demarcation point is the modular connector at the end of the LAN 
cables) 

! Doing LAN administration that is not performed on the Avaya MAS 

! Maintaining the TCP/IP addresses and administration on the server after 
cutover, unless otherwise specified by contract 

! Providing the IP address, subnet mask, and gateway information for 
administration on the server, as well as any DNS server IP information 
and corporate domain names 

Avaya service technicians dispatched for system installation are not responsible for 
troubleshooting the customer LAN.

Note: Avaya recommends joint acceptance testing for systems integrated 
with switches that are not maintained by Avaya. 
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Unpacking the hardware

This section lists required and optional hardware needed to successfully install and 
maintain an Avaya Modular Messaging system. 

Required and optional hardware

An Avaya Messaging Application Server (Avaya MAS) requires the hardware 
components listed in Table 2-4. Verify that all components needed for this installation 
are on site.

Table 2-4. Required and optional Avaya MAS hardware 

Item Quantity Required/optional

Required equipment:

Avaya Messaging Application Server (Avaya MAS) 1 minimum 
10 maximum

Required

Server AC power cables 1 per Avaya MAS server Required

Front bezel 1 per server Required

Rack-mount assembly (rails, handles, brackets, and 
connecting hardware), or
Rubber spacers for stackable desktop configuration 

1 set of each per server 
(use mount type required)

Required

Ethernet LAN cable 1 per server Required

USB modem (includes USB cable) 1 per MAS server Required

Port board cables (see Table 3-1 on page 3-2) 1 set per port board Required for port boards 

Optional or customer-provided equipment:

Monitor (includes power cord and VGA cable) 1 Optional (can be 
customer-provided)

Keyboard and mouse (includes cords and Y cable) 1 set Optional (can be 
customer-provided

KVM switch (includes power transformer)

KVM switch cable to each server

(includes 1 set of rack-mount brackets, if needed for 
rack-mount setup)

1 KVM switch

1 cable per server

1 set if needed

Optional (other models 
of switching devices can 
be used)
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Saving the packing materials

Save the shipping cartons and all packing materials in case any hardware must be 
returned to the manufacturer. If you ordered more than one Avaya MAS, saving one 
carton and one set of packing materials should be sufficient. Packing materials include: 

! Antistatic bags 

! Cardboard and foam inlays 

Also save the shipping cartons for all peripheral devices (such as the monitor, 
keyboard and mouse, all required modems, and the UPS and any EBMs, if used). 

Installing the Avaya MAS

This section describes how to install one or more Avaya Messaging Application Server 
(Avaya MAS) units. Hardware components that are optional are noted in the text. For 
more information about required and optional hardware, see Table 2-4 on page 2-7. 

The Avaya MAS units can be installed in one or more customer-provided commercial 
cabinets as a rack-mount system or without a commercial cabinet in a stackable 
desktop configuration. This section includes instructions on how to install both 
rack-mount and stackable desktop configurations.

Figure 2-1 on page 2-9 shows an example of an installed rack-mount system. 

Uninterruptible power supply (UPS) with required power 
cord (includes 1 set of rack-mount brackets and rubber 
spacers for a stackable setup) 

1 Optional (type can vary)

Extended battery module (EBM) with required power cord 
(includes 1 set of rack-mount brackets and rubber spacers 
for a stackable setup) 

1 to 4 Optional (can be 
ordered with the UPS)

Table 2-4. Required and optional Avaya MAS hardware 

Item Quantity Required/optional

Note: The packing materials might include a plastic bag designed to 
protect the system from moisture during shipment. Discard this 
bag. It is not reusable. 

Note: The sample figure shows the Avaya MAS servers with their front 
bezels removed.
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Figure 2-1. Example of an installed rack-mount Avaya MAS system (front view)
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1 Customer-provided cabinet (Type can vary. See physical requirements in "Installation 
area requirements" on page 2-4.)

2 EBM (Optional. 0 to 4 can be installed with a UPS.)

3 UPS (Optional. Model can vary.)

4 Avaya Messaging Application Server (Avaya MAS). Up to 10 units can be present. 

5 KVM switch (Optional. Type can vary.)

6 External modem (One is required for every MAS.) 
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Installing the UPS and EBMs (optional)

This section describes how to install an optional uninterruptible power system (UPS) 
and one or more optional extended battery modules (EBMs). 

! Customers might order a different model of UPS than the one described 
in this section, or they can supply their own. See the documentation that 
was provided with the UPS for instructions.

! If a UPS will not be installed, continue with the next section, "Installing 
the Avaya MAS" on page 2-14.

The UPS is an optional component for the Avaya MAS that can protect the system from 
most common power problems, including power failures, power sags, and power 
surges. 

The EBM is an optional component that works in conjunction with the UPS to add 
additional run time for the system. The customer can add up to four EBMs per UPS. 
For more information, see the documentation that was shipped with the EBM and UPS.

To install the UPS and EBMs:

! For rack-mount installations, see "Installing the UPS and any EBMs into 
a rack" below. 

! For a stackable desktop configuration, see "Installing the UPS and any 
EBMs as a stackable configuration" on page 2-12.

Installing the UPS and any EBMs into a rack

In a rack-mount configuration, the UPS and EBMs must be positioned in the rack below 
any Avaya MAS units, with the EBM units in the lowest-available position. 

To install the UPS and EBMs into a rack:

1. Gather the necessary rack-mount hardware, including the mounting 
handles, brackets, and screws. 

2. Place the UPS on a flat, stable surface with the front of the UPS facing 
toward you.
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3. Attach the mounting handle to each bracket using the supplied screws. 
See Item 1 in Figure 2-2.

4. Align the mounting brackets with the screw holes on the side of the UPS 
and secure using the supplied screws. See Item 2 in Figure 2-2.

5. If you are installing one or more EBMs, repeat Steps 1 through 4 for 
each EBM. 

6. Place the EBM into the rack in the lowest-available position and attach 
the EBM to the rack using customer-provided screws. 

7. Place the UPS into the rack in the lowest-available position above any 
EBMs, and attach the UPS to the rack using customer-provided screws.

8. Continue with the "Cabling the UPS and any EBMs" on page 2-13.

Figure 2-2. Attaching mounting handles and bracket for a rack-mount UPS

Note: The EBMs must be installed below the UPS.

Note: If additional EBMs are to be installed into the rack, install them 
above the first installed EBM.
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Installing the UPS and any EBMs as a stackable configuration

To configure the UPS and any EBMs in a stackable configuration:

1. If you are installing one or more EBMs, remove the adjacent corner 
screws from the rear panels as shown in Figure 2-3. If you do not have 
any EBM units, continue with Step 4. 

2. Install the EBM brackets by aligning each bracket with the screw holes. 
Secure the bracket using the supplied screws, as shown in Figure 2-3.

3. Repeat Steps 1 and 2 for each additional EBM.

4. On the bottom unit (either the UPS or an optional EBM), secure four 
rubber spacers to the bottom of the unit, one at each corner.

5. Set the unit on a stable platform. This unit will form the base of the 
stackable desktop configuration.

Figure 2-3. Attaching connecting brackets between a UPS and EBM (back view)
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Cabling the UPS and any EBMs

To cable the UPS and any EBM units: 

1. Connect the EBM cable to the battery connector on the UPS. See Item 1 
in Figure 2-4. 

2. If you must connect additional EBMs, plug the EBM cable of the second 
EBM into the battery connector on the first EBM. 

3. Repeat Step 2 for each additional EBM. Up to four EBMs can be 
connected to the UPS. 

Figure 2-4. Connecting a UPS and an EBM (back view)
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1 UPS (Model can vary. See the provided documentation for details.)

2 EBM (Optional. 0 to 4 can be installed.)

3 EBM battery cable to UPS

4 Battery connectors for additional EBMs if needed (Optional.)

5 UPS power cable to a grounded AC power outlet
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Installing the Avaya MAS 

This section describes Avaya MAS components, and how to install the Avaya MAS in a 
customer-provided commercial cabinet or in a stackable desktop configuration. 

Identifying key components of the Avaya MAS

Figure 2-5 shows the front view of an Avaya Messaging Application Server (Avaya 
MAS).  

Figure 2-5. Avaya MAS (front view with bezel removed)
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1 Redundant chassis fans

2 Chassis fan retaining screw

3 System reset button

4 Disk drive access indicator 

5 System power indicator

6 System power on/off button

7 DVD player

8 IDE disk drive A (hda)
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Figure 2-6 shows the back view of an Avaya Messaging Application Server (Avaya 
MAS). 

Figure 2-6.  Avaya MAS (back view)
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1 Latch for top cover 

2 Power supply 

3 AC power receptacle

4 Power supply on/off switch

5 Mouse connector

6 Keyboard connector

7 USB ports (one of which is used for the required modem)

8  Serial port (COM1)

9 Parallel port (not used)

10 Serial port (COM2)

11 Corporate LAN interface 

12 Audio connectors (not used)

13 Video card (contains monitor connector)

14 Network interface card (not used in this configuration)

15 Port boards (type varies from machine to machine). Up to six port boards can be 
installed in each MAS (depending on the type of board and traffic requirements), 
typically starting from the end of the cabinet. Port boards are not present for IIP 
H.323 integrations. See "Supported MAS port boards" on page 3-2 for details. 
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Attaching the front bezel

The front bezel must be attached to each Avaya MAS as follows: 

1. Insert the bottom of the front bezel into the chassis. See Item 1 in Figure 
2-7.

2. Push the bezel upright until the two upper tabs snap into place under the 
top cover. See Item 2 in Figure 2-7. 

Installing the Avaya MAS in a rack-mount or stackable setup

The Avaya MAS can be installed either in a commercial cabinet in a rack-mount 
configuration, or stacked on top of one another in a desktop configuration. Continue 
with the appropriate section based on the installation method to be used at this site: 

! "Installing an Avaya MAS in a rack-mount configuration" on page 2-17

! "Installing the Avaya MAS in a stackable desktop configuration" on page 
2-19

Figure 2-7. Attaching the front bezel
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CAUTION: The Avaya MAS is heavy. Get another person to 
assist you with lifting and placing the unit.!
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Installing an Avaya MAS in a rack-mount configuration

The task describes how to install one or more Avaya MASs in a commercial cabinet. 
This is also called a rack-mount configuration.  

Before you begin to install the servers into the rack, verify that the necessary 
rack-mount hardware is on site. Required equipment is summarized in Table 2-5.

To install an Avaya MAS into a rack:

1. Gather the necessary rack-mount hardware, as listed in Table 2-5. 

2. Place the server on a flat, stable surface.

3. If the mounting handles are not already attached, attach them now:

a. Connect the handles to the bracket using the supplied flat-head screws. 
See Item 1 in Figure 2-8 on page 2-18.

b. Align the mounting bracket with the screw holes on the side of the server 
and secure it using the supplied flat-head screws. See Item 2 in Figure 2-8. 

4. The mounting rails consist of a narrow, flat piece that connects to the 
server, and a slide. Identify the rails for the left and right side of the 
server as you face the unit from the front (the rack-mount rails are not 
interchangeable). Some rails are labeled LH for left and RH for right.

Note: The first Avaya MAS is typically installed directly above the UPS. If 
a UPS is not present, install the Avaya MAS in any available 
position in the cabinet. 

If more than one Avaya MAS is present, you typically install each 
additional MAS above the first MAS. However, all the Avaya MASs 
do not have to be in the same cabinet.

Table 2-5. Required rack-mount hardware

Part Quantity

Extension bracket (two different lengths might be shipped) 2 per server

Right-side rack-mount rails and slides 1 set per sever

Left-side rack-mount rails and slides 1 set per sever

Front panel handle set (handles and mounting brackets). These 
might already be assembled on some units.

1 set per server

Miscellaneous screws and mounting hardware 1 set per server

Customer provided: Mounting hardware to secure the extension 
bracket and rack-mount slide to the customer-provided rack.

1 set per rack-mount rail 
and extension bracket
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If the set of rails you have is not labeled: 

a. Hold the rail-slide assembly so that the 2-hole bracket that connects to the 
front of the customer rack faces left. See Item 7 in Figure 2-8.

b. Fully extend the slide so that you can see the holes in the flat piece of the 
rail slide that mounts to the server. See Item 4 in Figure 2-8. 

! If the holes appear on the upper side of the flat rail piece, this rail 
connects to the right side of the server chassis. 

! If the holes appear on the lower side of the flat rail piece, this rail 
connects to the left side of the server chassis. 

5. Attach the rack-mount rails to the server as follows:

a. Remove the two screws and retaining bar on the rail slide just in front of the 
server-retaining latch. Set them aside for later. See Item 3 in Figure 2-8.

b. Disassemble the slide (necessary to access all three screw holes).

c. Place the flat piece of the rail slide against the server and secure it with the 
three supplied flat-head screws. See Item 4 in Figure 2-8. 

6. Position the extension bracket on end of the rail slide to provide the 
depth needed for the server to fit in the rack. More than one extension 
bracket might be shipped. Choose the correct length for the cabinet. See 
Item 5 in Figure 2-8.

Note: The holes for mounting to the unit are offset to get the correct 
alignment in the rack. Verify by the position of the holes in the 
bracket that you are installing each rail on the correct side. 

Figure 2-8. Attaching server mounting handles, bracket, and rack-mount rail assembly
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7. Attach the extension bracket to the rear of the rail slide using the 
supplied screws and retaining bar (2 pan-head screws per bracket). See 
Item 6 in Figure 2-8.

8. Connect the extension bracket and rail slide to the customer-provided 
four-post rack using the correct customer-provided hardware for that 
cabinet model. See Item 7 in Figure 2-8.

9. Fully extend the rail slides to the locked-out position.

10. With another technician supporting the unit, align the front of the rail 
slide with the rack-mount rail that is attached to the server.

11. Push the unit onto the rail slide far enough so that the safety catch 
engages.

12. Slide the server completely into the rack. Ensure that the server moves 
smoothly in and out of the rack.

13. Reattach the two screws and retaining bar on the rail slide just in front of 
the server-retaining latch (Item 3 in Figure 2-8, from Step 5-a).

14. Repeat Steps 2 through 13 for each server that must be installed.

15. When all servers are mounted, continue with "Connecting the Avaya 
MAS power cables" on page 2-20.

Installing the Avaya MAS in a stackable desktop configuration

If the system is to be installed in a stackable desktop configuration, you must install 
four rubber spacers on the bottom on each of the servers. This allows you to stack the 
servers on top of one another. See Figure 2-9 on page 2-20 for a sample configuration. 

To install Avaya MASs in a stackable desktop configuration:

1. Gather the rubber spacers shipped with each server.

2. Attach the rubber spacers to the bottom of each of the servers, one at 
each corner. See Figure 2-9 on page 2-20 for an example.

3. Position the UPS (if present), or the first Avaya MAS (if no UPS is 
present) in an appropriate location. See "Site requirements for an Avaya 
MAS" on page 2-3 for details. 

4. Place the second Avaya MAS (if present) on top of the first one. 

CAUTION: For safety, do not stack more than two servers. Use multiple 
stacks if needed. If you have a UPS and an EBM, stack only 
one server on top of them.

!
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5. If more Avaya MASs are present, create a second stack, placing each 
additional MAS on top of the last one.

Connecting the Avaya MAS power cables

To connect the MAS power cables: 

1. Connect the female end of the MAS power cable to the male power 
connector on the back of the Avaya MAS.

2. Connect the male end of the MAS power cable to AC receptacle on the 
back of the UPS (if present), or to an appropriate AC power outlet. See 
Figure 2-10 for an example. 

3. If you have more than one MAS, repeat Steps 1 and 2 for each MAS.

4. If a UPS is present, plug the UPS power cable into an appropriate AC 
power outlet.

Figure 2-9. Installing rubber spacers for a stackable desktop configuration
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Connecting the Avaya MAS port boards

If port boards are present in the Avaya MAS, you are now ready to connect the cables 
supplied for the MAS port boards to the PBX (switch). To do this:

1. Assemble the required cables. 

2. Connect each port on the port boards to the switch (PBX) as required, 
based on the type of board: 

Figure 2-10. Attaching power cables to a UPS (sample configuration)
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1 UPS (Model can vary. See the provided documentation for details.)

2 EBM (Optional. 0 to 4 can be installed.)

3 UPS power cable to a grounded AC power outlet

4 AC power cable to each Avaya MAS 

5 AC power cable to other equipment, such as the required external modem or the 
optional KVM switch and monitor 

6 Additional AC sockets (Use as needed for additional equipment or MASs.)

Note: Check the numbering on the board faceplate to verify that you 
are connecting the correct cable to the correct port. 
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! For analog boards: 

a. Connect each port on the installed analog boards to one end of a standard 
RJ-11 tip/ring cord (individual tip/ring cables and a 12-port harmonica can 
also be used). Note which cables connect to which ports.

b. The other end of the cable must be connected to an analog line on the 
corporate switching system. The organization responsible for maintaining 
the corporate switch should make this connection (see the customer 
contract or the statement of work).

! For set emulation boards: 

a. Connect each port on the Dialogic set emulation board using the D/82U 
cable (Intel part number 86-0155-001). 

b. The other end of the cable must be connected to a 4-wire punch-down 
block on the corporate switching system. The organization responsible for 
maintaining the corporate switch should make this connection (see the 
customer contract or the statement of work). 

! For T1- or E1-QSIG boards: 

a. Connect each port on the Dialogic T1-QSIG or E1-QSIG board using an 
RJ-48C (Ethernet) cable. 

b. Attach a ferrite to this cable. See "Attaching ferrites" on page 2-27. 

c. The other end of the cable must be connected through a patch panel to a 
4-wire punch-down block on the corporate switching system. The 
organization responsible for maintaining the corporate switch should make 
this connection (see the customer contract or the statement of work). 

Connecting the Ethernet cable

A standard Ethernet cable is shipped with every Avaya MAS. You can use this cable or 
a customer-provided cable to connect the Avaya MAS to the corporate LAN. 

To connect each Avaya MAS to the corporate LAN: 

1. Connect one end of the standard Ethernet cable to the RJ45 connector 
on the back of the server. See Figure 2-11 on page 2-23.  

Note: Make sure that you connect the Ethernet cable for the 
corporate LAN to the Ethernet interface on the back of the 
Avaya MAS housing. The Ethernet interface on the NIC in the 
PCI slot is not used in this configuration. 
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2. The other end of this cable must be connected to an Ethernet interface 
on the corporate LAN. 

3. Repeat Steps 1 and 2 for each Avaya MAS in the configuration.

 

Installing the KVM switch (optional)

A keyboard, video, and mouse (KVM) switch can be used to facilitate switching 
between servers in a Modular Messaging installation. See Figure 2-1 on page 2-9 for a 
sample installation.

The model of KVM switch and the specific monitor, keyboard, and mouse used can 
vary from site to site (for example, a flat-panel monitor setup might be used instead). 
This section describes how to install one specific model

To install the Belkin OmniView Pro2 Series KVM switch:

! For rack-mount installations, see "Installing the KVM switch in a 
rack-mount configuration" on page 2-24. 

Note: The organization that is responsible for maintaining the 
corporate LAN should make this connection (see the customer 
contract or the statement of work). 

Figure 2-11. Connecting an MAS to the corporate LAN (rear view)
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1 Ethernet interface to the corporate LAN

2 NIC connection (Do not use in this configuration.) 

Note: If you are not installing a KVM switch, continue with "Attaching 
ferrites" on page 2-27. 
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! For a stackable desktop configuration, see "Installing the KVM switch in 
a stackable configuration" on page 2-24.

Installing the KVM switch in a rack-mount configuration

To install the Belkin OmniView Pro2 Series KVM switch in a commercial cabinet:

1. Gather the necessary rack-mount hardware, including the adjustable 
mounting brackets and screws. 

2. Select a bracket-hole scheme to determine how far the KVM switch 
should protrude from the rack. 

3. Install the two rack-mount brackets on the KVM switch using the 
provided screws. See Figure 2-12 on page 2-24.

4. Install the KVM switch into the rack above the last installed MAS.

5. Continue with "Connecting the KVM cables" on page 2-25.

Installing the KVM switch in a stackable configuration

To install the Belkin OmniView Pro2 Series KVM switch in a stackable desktop 
configuration: 

1. Place the KVM switch on top of the uppermost MAS. (Rubber spacers 
are already in place.) 

2. Continue with "Connecting the KVM cables" on page 2-25.

Figure 2-12. Attaching mounting brackets for a rack-mount KVM
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Connecting the KVM cables

The Belkin OmniView Pro2 Series KVM switch must be connected to the keyboard, 
monitor, and mouse, and then to each MAS, as described in this section. 

Connecting the KVM switch to the keyboard, monitor, and mouse

The KVM switch setup for the keyboard, monitor, and mouse can vary from site to site, 
depending on the equipment and cabling used. This section provides instructions for a 
Belkin OmniView Pro2 Series KVM switch setup. 

To connect the KVM switch to the keyboard, monitor, and mouse:

1. If a new monitor or keyboard and mouse was ordered for this system, 
unpack them now. Otherwise, continue with Step 2. 

a. Set up the monitor in the desired location.

b. Connect the keyboard and mouse to the monitor.

c. Plug the female end of the monitor power cable into the monitor.

d. Plug the male end of the monitor power cable into a free UPS receptacle (if 
available) or into a grounded AC outlet.

2. Connect the VGA cable from the monitor to the female port on the back 
of the KVM switch labeled Console VGA. See Item 1 in Figure 2-13 on 
page 2-26.

3. Tighten the thumbscrews on the video cable connector using either your 
fingers or a small flatblade screwdriver.

4. Connect the PS/2 cables for the mouse and keyboard to their 
corresponding connectors on the back of the KVM switch in the 
Console section using the Y cable. See Item 2 in Figure 2-13.

The mouse connector is color-coded green, and the keyboard connector 
is color-coded purple. 

5. Attach the KVM power cable to the DC power jack labeled DC 12V, 1A 
on the rear of the KVM switch. 

6. Connect the other end of the KVM power cable (the AC-to-DC 
transformer) to a receptacle on the back of the UPS (if present) or to an 
appropriate power outlet.

When power is connected, the LED for port 01 begins flashing.

7. Push the direct-access port selectors for ports 01 through 08 in order. 
The corresponding LED should flash as each button is pressed, 
indicating that the port is ready for the server connection. 

Note: If a new monitor was not purchased with the system, any 15" or 
larger monitor can be used.
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Connecting the KVM switch to the Avaya MAS 

To connect the KVM switch to any installed Avaya MAS units: 

1. Using the provided KVM cable, plug the male VGA connector into the 
VGA port on the first MAS. See Figure 2-13 on page 2-26.

Figure 2-13. Connecting a Belkin OmniView Pro2 Series KVM switch (rear view)
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1 VGA cord from monitor to Console VGA port on KVM switch

2 Y cable to combination keyboard/mouse (setup can vary)

3 DC power jack for transformer cable

4 KVM switch video/keyboard/mouse cable to each server unit

5 VGA connector on the Avaya MAS (in the AGP slot)

6 Keyboard and mouse connectors on the Avaya MAS 

7 Belkin OmniView Pro2 Series KVM switch (This example shows an Avaya MAS 
connected to the first computer port VGA 01. Additional Avaya MASs are connected 
in the subsequent port positions beginning with VGA 02.)
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2. Connect the PS/2 keyboard and mouse connectors of the KVM cable to 
the keyboard and mouse ports on the back of the Avaya MAS.  

3. Connect the other end of the KVM cable to the port labeled VGA 01, 
located on the back of the KVM switch.

4. Connect the ends of the cables to the keyboard and mouse ports located 
directly underneath the VGA 01 port.

5. Repeat Steps 1 through 4 for each additional MAS, connecting to port 
VGA 02, VGA 03 and so on, as needed.

Attaching ferrites

You must attach ferrites to the Avaya MAS video cable and to each T1- or E1-QSIG 
port board cable (if this type of board is present on the MAS) to meet electromagnetic 
conductance (EMC) regulations. You must also attach ferrites to the optional flat-panel 
monitor with an integrated KVM switch (if present).

To install a ferrite on a cable: 

1. For each Avaya MAS: Locate the video connector in the first slot on the 
back of the Avaya MAS.

2. Open the ferrite by gently pulling the fastener away from the body of the 
ferrite. See Figure 2-14 on page 2-28. 

3. Place the cable cord in the groove inside the ferrite. Gently snap the 
ferrite shut.  

4. Attach a large cable tie directly behind the ferrite to secure it. Trim the 
cable tie. 

5. For MASs that use T1- or E1-QSIG port boards: Repeat Steps 2 through 
4 to attach a ferrite to each QSIG port board cable.

6. For systems that use a flat-panel monitor: Repeat Steps 2 through 4 to 
attach a ferrite to the mouse and keyboard cables at each server. One 
ferrite can be used for both cables.

Note: The mouse connector is color-coded green, and the keyboard 
connector is color-coded purple.

Note: Place ferrites as close as possible to the chassis to minimize 
the amount of cable between the ferrites and the chassis.

CAUTION: Handle all ferrites with care. They are easily broken. Do not 
use any that are broken or fractured. Damaged ferrites are 
no longer effective for EMC control.

!
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Connecting the USB modem on the MAS

A USB modem is required for every Avaya MAS. The type of modem varies, depending 
on the location. See the documentation included with the modem if you have questions 
about modem installation, setup, or operation. 

This section describes a MultiTech USB modem setup. See Figure 2-15 on page 2-29 
for an example.

To connect a USB modem:

1. Attach the rubber spacers to the four marked areas in each corner on 
the bottom of the modem (if spacers are not already in place).

2. Place the USB modem on top of the KVM switch or in a secure location, 
as required. 

3. Connect one end of the USB cable to the back of the USB modem.

Figure 2-14. Attaching a ferrite to a cable

1 Ferrite in open position 

2 Ferrite in closed position

3 Cable tie

4 Cable to the computer 
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4. Connect the other end of the USB cable to the back of the Avaya MAS. 
USB port A is recommended, as shown in Figure 2-15. 

5. Connect the RJ-11 cable to the LINE connector on the modem.

6. The other end of the cable must be connected to an analog line on the 
corporate switching system. The organization responsible for 
maintaining the corporate switch should make this connection (see the 
customer contract or the statement of work).

7. Repeat Steps 1 through 6 for every Avaya MAS modem.

Figure 2-15. Connecting a USB modem to an Avaya MAS (rear view)
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Powering up an Avaya MAS system

When every Avaya MAS is installed, power up the system as follows:

1. Verify that the power cables for the MASs and all peripheral devices are 
connected to the UPS or to an appropriate AC power outlet. See Figure 
2-10 on page 2-21 for an example. Connections include:

! UPS (if present): connected to an appropriate AC power outlet.

! All MAS units: each connected to the UPS (if present), or to an 
appropriate AC power outlet.

! KVM switch and monitor (if present): optionally connected to the UPS 
(if present), or to an appropriate AC power outlet.

! External modems: if a power cord is required, it can be connected to 
the UPS (if present), or to an appropriate AC power outlet.

2. If a UPS is present: Press the On button on the front of the UPS. The 
appropriate lamps should light (see the UPS documentation). 

3. Press the power button on the monitor. The power lamp on the monitor 
should light.

4. If an external modem is present, press the On button (if present). The 
appropriate lamps should light (see the modem documentation). 

5. If a KVM switch is installed, verify that the power lamp is lit.

6. Power up each Avaya MAS as follows: 

a. Toggle the power switch at the rear of the unit to on (| is on, 0 is off). 

b. Press the power button on the front of the unit. The power lamp on the front 
of each server should light. 

c. Wait up to 1 minute for the display to appear on the monitor. 

Note: Always power up the UPS first, if a UPS is installed.

Note: See "Identifying key components of the Avaya MAS" on page 
2-14 to locate the two power switches if needed.

Note: The Windows 2000 Server Setup Wizard automatically runs when 
the unit is powered up (see Chapter 5, �Configuring a new Avaya 
MAS�). However, the steps in Chapter 4, ��Preparing to install 
Modular Messaging software,�� must be completed before you 
install any Modular Messaging software on the Avaya MAS.
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3
Installing MAS port boards

This chapter describes how to install Dialogic port boards and their drivers in a 
customer-provided MAS.  

Topics in this chapter include: 

Note: Before you can successfully complete the tasks described in this 
section, you must have read Chapter 1, ��Preinstallation 
requirements,�� and verified that all preinstallation requirements 
have been met. 

Section Page

Supported MAS port boards 3-2

Installing MAS port boards 3-2

� Preparing for the installation 3-3

� Setting jumpers and switches 3-4

� Installing the port boards 3-8

Installing the Dialogic drivers and software 3-9

� Installing the new Dialogic drivers 3-10

� Applying the Dialogic Feature Pack 3-10

Connecting the MAS port boards 3-12

Completing the hardware installation 3-13



585-310-330, Issue 1

Avaya Modular Messaging for IBM Lotus Domino Release 1.1 Installation

3�2 May 2004

Supported MAS port boards

Table 3-1 lists the Dialogic port boards that are supported for all new installations. The 
Dialogic documents provide details about installing and connecting the boards and are 
available on the documentation media provided with the Modular Messaging system.  

Installing MAS port boards

Do this procedure on a customer-provided MAS only. 

If you will be installing Modular Messaging software on a customer-provided 
Messaging Application Server (MAS), you must first install the required port boards and 
the appropriate Dialogic drivers and software as described in this section. 

Table 3-1. Supported MAS port boards 

Protocol Ports Port boards Max # Dialogic files on documentation CD

Analog 4 - 8

12 - 48

Dialogic 4-port T/R board

Dialogic 12-port T/R board

2

4

D/41JCT-LS (PDF 133K)

D/120JCT-LS (PDF 131K)

Digital Set 
Emulation

8 - 40
or
8 - 48

Dialogic D/82JCT-U-PCI-UNIV 5 - Avaya MAS 

6 - other MAS

D/82JCT-U PCI Univ (PDF 234K)

T1-QSIG 23 - 69 Dialogic D/480JCT-2T1 3 DualSpan JCT boards (PDF 104K)

E1-QSIG 30 - 60 Dialogic D/600JCT-2E1 2 DualSpan JCT boards (PDF 104K)

Note: The number of port boards you can install in a customer-provided 
MAS varies depending on the type of MAS used and the number of 
PCI slots available. These instructions assume that up to six PCI 
slots are available in the MAS, and that board installation will begin 
with the 6th PCI slot. Modify these instructions as appropriate for 
this model of MAS. 

Port boards are not used in an IIP H.323 integration. 
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Preparing for the installation

To install Dialogic port boards in a customer-provided MAS:

1. Verify that this MAS meets the minimum requirements to support 
Modular Messaging software. See the Avaya Modular Messaging 
Concepts and Planning Guide (PDF 2 MB) for details. 

2. Print out the appropriate Dialogic PDF file for complete information. See 
Table 3-1 on page 3-2 for a list of the Dialogic documents that cover the 
installation of each type of the board. 

Documents are available on the Avaya Modular Messaging 
Documentation CD or from the www.avaya.com/support Web site. See 
"Required documentation" on page 1-2 for details about accessing 
required information. 

3. If the server is already in operation, schedule down time to install the 
new boards.

4. When ready to begin the installation, shut down the system software and 
power off the system. Unplug the AC power cord for safety. 

5. Open the chassis to access the card slots. 

6. Remove the cover for the PCI slot in which you want to install the new 
board. Set the retaining screw aside. 

! If you are installing multiple boards, remove as many card slot covers 
as are needed. 

! Note the maximum number of boards of a certain type that you can 
install in one MAS, as shown in Table 3-1 on page 3-2.

Note: Insert boards starting from the right-most slot if possible. For 
example, if six PCI slots are in the MAS, insert the port boards 
beginning with PCI slot 6. 

CAUTION: Observe proper electrostatic discharge (ESD) precautions 
when you handle computer components. Wear an antistatic 
wrist strap that touches your bare skin and connect the strap 
cable to an earth ground. For detailed ESD instructions, see 
�Protecting against ESD damage� on the documentation CD.

!

http://www.avaya.com/support
melectro.htm


585-310-330, Issue 1

Avaya Modular Messaging for IBM Lotus Domino Release 1.1 Installation

3�4 May 2004

Setting jumpers and switches

Set the jumpers and switches for board position, bus termination, and other features as 
described in this section. See the Dialogic documentation for details on jumper or 
switch location if needed. 

To set the jumpers and switches on each board:

1. Remove the new port board from its packaging. 

2. Set the jumpers and switches as required for this type of board: 

! D/120JCT-LS 12-port analog boards (see below) 

! D/41JCT-LS 4-port analog boards (see page 3-5) 

! D/82JCT-U set emulation boards (see page 3-6) 

! D/480JCT-2T1 or D/600JCT-2E1 QSIG boards (see page 3-7) 

For D/120JCT-LS 12-port analog boards (4 maximum per MAS): 

a. Set the unique board ID for the new card. Turn the SW100 rotary switch, 
located on the top of the card, to set the board ID according to the slot in 
which you are installing it.

Dialogic port boards typically are placed in the PCI slots starting from the 
right side of the cabinet (see Figure 2-6 on page 2-15 for an example). For a 
6-PCI slot MAS, the board IDs would be: 

! The card in PCI slot 6 is assigned ID 0. 

! The card in PCI slot 5 is assigned ID 1. 

! The card in PCI slot 4 is assigned ID 2. 

! The card in PCI slot 3 is assigned ID 3. 

b. Set the hook-switch state of the new card to ON so that callers hear a busy 
signal when the card is not initialized. Use the SW1 switch, located at the 
top of the card, to set the hook-switch state. See Figure 3-1.

Figure 3-1. D/120JCT-LS analog board on-hook switch

jpvysw1 LAO 081803
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For D/41JCT-LS 4-port analog boards (2 maximum per MAS): 

a. Set the unique board ID for the new card. Turn the SW30 rotary switch, 
located on the top of the card, to set the board ID according to the slot in 
which you are installing it.

Dialogic port boards typically are placed in the PCI slots starting from the 
right side of the cabinet (see Figure 2-6 on page 2-15 for an example). For a 
6-PCI slot MAS, the board IDs would be: 

! The card in PCI slot 6 is assigned ID 0. 

! The card in PCI slot 5 is assigned ID 1. 

b. Set the hook-switch state of the new card to ON so that callers hear a busy 
signal when the card is not initialized. Use the red SW4 switch, located near 
the top of the card, to set the hook-switch state. See Figure 3-2. 

c. If more than one 4-port board is installed in the system, set up the boards 
for Computer Telephony (CT) bus termination. Use the JP2 jumper to set 
CT bus termination as shown in Table 3-1. 

Figure 3-3 shows the JP2 jumper settings. The setting on the left is 
ON (CT bus is terminated). The setting on the right is OFF. 

Figure 3-2. D/41JCT-LS analog board on-hook switch

jpvysw1 LAO 081803
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Table 3-1. D/41JCT-LS analog board CT bus termination settings

Number of cards JP2 jumper CT bus termination

1 OFF Bus is not terminated. 

2 ON pins 1 and 2 Terminate bus on both boards.

Figure 3-3. D/41JCT-LS analog board CT bus termination settings
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For D/82JCT-U set emulation boards (6 maximum per MAS): 

If more than one card is installed in the system, set up the boards on 
either end of the Computer Telephony (CT) bus for bus termination. Use 
the P8 jumper to set CT bus termination as shown in Table 3-2. 

Figure 3-4 shows the P8 jumper settings. The setting on the left is ON 
(CT bus is terminated). The setting on the right is OFF. 

Table 3-2. D/82JCT-U set emulation board CT bus termination settings

Number of cards P8 jumper CT bus termination

1 OFF Bus is not terminated. 

2 ON pins 1 and 2 Terminate bus on both boards.

3 Card 1: ON pins 1 and 2 
Card 2: OFF
Card 3: ON pins 1 and 2 

Terminate bus on the end boards. 

4 Card 1: ON pins 1 and 2 
Card 2: OFF
Card 3: OFF
Card 4: ON pins 1 and 2 

Terminate bus on the end boards. 

5 Card 1: ON pins 1 and 2 
Card 2: OFF
Card 3: OFF
Card 4: OFF
Card 5: ON pins 1 and 2 

Terminate bus on the end boards. 

6 Card 1: ON pins 1 and 2 
Card 2: OFF
Card 3: OFF
Card 4: OFF
Card 5: OFF
Card 6: ON pins 1 and 2 

Terminate bus on the end boards. 

(A special 6-position CT cable is required 
for this configuration. The 
Avaya-provided H100 cable supports 
only up to 5 DSE boards.) 

Figure 3-4. D/82JCT-U set emulation board CT bus termination settings
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For D/480JCT-2T1 QSIG boards (3 maximum per MAS) 
and D/600JCT-2E1 QSIG boards (2 maximum per MAS): 

a. Set the unique board ID for the new card. Turn the SW100 rotary switch, 
located on the top of the card, to set the board ID according to the slot in 
which you are installing it.

Dialogic port boards typically are placed in the PCI slots starting from the 
right side of the cabinet (see Figure 2-6 on page 2-15 for an example). For a 
6-PCI slot MAS, the board IDs would be: 

! The card in PCI slot 6 is assigned ID 0. 

! The card in PCI slot 5 is assigned ID 1. 

! The card in PCI slot 4 is assigned ID 2 (this slot would be used 
only for a D/480JCT-2T1 QSIG board). 

b. If more than one card is installed in the system, set up the boards on either 
end of the Computer Telephony (CT) bus for bus termination. Use the P700 
jumper to set CT bus termination as shown in Table 3-3. 

Figure 3-5 shows the P700 jumper settings. The setting on the left is 
ON (CT bus is terminated). The setting on the right is OFF. 

Table 3-3. D/480JCT-2T1 or D/600JCT-2E1 QSIG board CT bus termination settings

Number of cards P700 jumper CT bus termination

1 OFF Bus is not terminated. 

2 ON pins 3 and 4 Terminate bus on both boards.

3 Card 1: ON pins 3 and 4
Card 2: OFF
Card 3: ON pins 3 and 4 

Terminate bus on the end boards. 
(3 cards are present only if the MAS uses 
D/480JCT-2T1 boards.) 

Figure 3-5. D/480JCT-2T1 or D/600JCT-2E1 QSIG board CT bus termination settings
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Installing the port boards 

To install the new port board:

1. Slide the card edge connector into the slot connector and the card slot 
retainer bracket into the slot guide. Apply pressure to the top of the card 
only, until the edge connector is firmly seated. See Figure 3-6. 

2. Replace and tighten the retaining screw to hold the circuit card in place.

3. Repeat these steps to install any additional port boards.

4. When all boards are in place, attach the Computer Telephony (CT) bus 
cable to connect all the port boards. (This cable is required only if more 
than one board is installed.) To attach the bus cable:

a. Position the CT bus cable so that the colored stripe on the ribbon cable 
faces toward the ports at the back of the chassis.

Figure 3-6. Installing a port board in an MAS 

prvycrdr LAO 081103

CAUTION: Verify that all circuit cards in an MAS are of the same type. 
You cannot mix board types (such as analog tip/ring with 
DSE or T1/E1) within a single MAS.

!
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b. Attach the end connector on the bus cable to the CT bus edge connector at 
the top of the card in the highest numbered slot.

c. Connect the next bus connector to the next port board, and so on.

d. When finished, if the cable has extra connectors or loose ribbon cable, tuck 
the cable down so that it does not snag when you replace the cover.

5. Replace the chassis cover and AC power cord. 

6. Restore power to the system. 

Installing the Dialogic drivers and software

To install the drivers and software required for the new Dialogic port boards:

1. After the system boots, log in to the server using an account that has 
permission to install software (such as the local administrator). 

A Found New Hardware wizard runs for every new Dialogic port board 
installed in the system. 

2. Follow the prompts in the wizard to temporarily disable the Dialogic 
hardware as follows: 

a. On the Welcome screen, click Next. 

b. On the Install Hardware Device Drivers screen, accept the default option 
(Search for a suitable driver) and click Next.

c. On the Locate Driver Files screen, clear the checkbox for Specify a 
location (no boxes will be checked). Click Next.

d. On the Driver Files Search Results screen, verify that Disable the device is 
selected. 

e. Click Finish.

f. Repeat Steps a through e for each repetition of the wizard.

Note: The Dialogic hardware will be activated later when you 
configure the port boards. 
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Installing the new Dialogic drivers

To install the new Dialogic 5.1.1 base release drivers: 

1. Insert the Avaya Modular Messaging Application Software DVD in the 
DVD drive.

For a system that uses CD-ROMs, insert the Intel Dialogic Drivers CD in 
the MAS drive. 

2. Right-click My Computer and select Explore.

3. In Windows Explorer, navigate to the MAS drive (such as D:).

4. Locate the Dialogic files. They are at the root directory of the CD, or 
under a Dialogic Drivers subdirectory of the DVD. 

5. Double-click the file Install_5_11.bat. 

The Intel Dialogic System Software and SDK for Windows System 
Release 5.1.1 for Windows wizard runs. When the installation is 
complete, the system automatically reboots. 

Applying the Dialogic Feature Pack

Next, update the new Dialogic drivers with the 5.11 Feature Pack (FP1): 

1. Log back in to the server when the reboot is complete. 

2. A command (cmd) window opens, explaining which batch file to run 
next. Press any key to continue.

3. Right-click My Computer and select Explore.

4. In Windows Explorer, navigate to the MAS removable-media drive (such 
as D:), and locate the Dialogic files. 

5. Double-click the file Install_5_11_FP1.bat.

The System Release 5.1.1 Feature Pack 1 wizard runs.

6. On the Welcome screen, click Next.

7. On the License Agreement screen, click Yes.

CAUTION: Several files have similar names. Verify that you 
are about to select the correct file before clicking it.!
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8. On the Customer Information screen:

a. For User Name, type Modular Messaging. 

b. Type the appropriate company name.

c. Click Next.

9. On the Select Components screen:

a. Verify that the box to install the Program Files is checked.

b. Clear the checkbox to not install the online documentation.

c. Click Next.

10. The Start Copying Files screen is displayed. Click Next. 

This step might take several minutes to complete.

11. On the last screen, select Yes, I want to restart my computer now.

12. Click Finish.

The system reboots.

13. Log back in to the server when the reboot is complete.

14. A command (cmd) window opens, explaining which batch file to run 
next. Press any key to continue.

15. Right-click My Computer and select Explore.

16. In Windows Explorer, navigate to the MAS removable-media drive (such 
as D:), and locate the Dialogic files. 

17. Double-click the file Restore_Config.bat.

The program cleans up any temporary installation files and replaces 
certain files used by the Dialogic boards.

18. Remove the disk from the drive. 
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Connecting the MAS port boards

Connect the new MAS port boards to the switch as described in this section.  

1. Assemble the required cables. 

2. Connect each port on the port boards to the switch (PBX) as required:

! For analog boards: 

a. Connect each port on the installed analog boards to one end of a standard 
RJ-11 tip/ring cord (individual tip/ring cables and a 12-port harmonica can 
also be used). Note which cables connect to which ports.

b. The other end of the cable must be connected to an analog line on the 
corporate switching system. The organization responsible for maintaining 
the corporate switch should make this connection (see the customer 
contract or the statement of work).

! For set emulation boards: 

a. Connect each port on the Dialogic set emulation board using the D/82U 
cable (Intel part number 86-0155-001). 

b. The other end of the cable must be connected to a 4-wire punch-down 
block on the corporate switching system. The organization responsible for 
maintaining the corporate switch should make this connection (see the 
customer contract or the statement of work). 

! For T1- or E1-QSIG boards: 

a. Connect each port on the Dialogic T1-QSIG or E1-QSIG board using an 
RJ-48C (Ethernet) cable. 

b. Attach a ferrite to this cable. See "Attaching ferrites" on page 2-27. 

c. The other end of the cable must be connected through a patch panel to a 
4-wire punch-down block on the corporate switching system. The 
organization responsible for maintaining the corporate switch should make 
this connection (see the customer contract or the statement of work). 

Note: Check the numbering on the board faceplate to verify that you are 
connecting the correct cable to the correct port. 

Note: If the boards are ordered through Avaya, the correct cables are 
provided for each board. 
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Completing the hardware installation

To complete the hardware installation on a customer-provided MAS:

! If you intend to access this MAS remotely using a modem (for 
example, through a remote support center), verify that the modem is 
correctly installed and configured. See the documentation included 
with the modem for information about modem installation, setup, and 
operation. 

! If DSE or QSIG boards are installed on this customer-provided MAS, 
you can optionally configure and test the Dialogic port boards now, 
before installing any Modular Messaging software. See Chapter 8, 
��Configuring and testing the port boards,�� for this procedure.  

Note: Dialogic analog boards might require a tone file from a 
directory that will not be available until after the Modular 
Messaging software is installed. If this system uses an Avaya 
switch, you might configure the analog boards more easily by 
using the tone file that is provided with the Modular Messaging 
software. 
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4
Preparing to install Modular

Messaging software

This chapter describes how to set up the IBM Lotus Domino and Microsoft Windows 
environment to support Avaya Modular Messaging software. 

Topics in this chapter include: 

Note: The steps in this chapter must be done before installing Modular 
Messaging software on any MAS in the system. 

These steps are performed by the Domino system administrator, 
Windows domain administrator, or other authorized personnel. 
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Setting up Domino to support Modular Messaging 4-3
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� Setting up Windows to support Modular Messaging 4-5

� Adding an MAS account to the Windows domain 4-6

� Setting up the MAS for remote access 4-6
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Overview

This chapter describes how to set up the IBM Lotus Domino and Microsoft Windows 
environment to support Avaya Modular Messaging software. System preparation steps 
include:

1. Setting up the Domino Directory and domain for Modular Messaging. 

2. Doing tasks in Microsoft Windows to support Modular Messaging 
including setting up Modular Messaging accounts on the Domino 
Directory Server with the correct permissions, adding the MAS accounts 
to the Windows domain, and setting up the system to support remote 
access. 

To successfully set up the system to support Modular Messaging software, you need:

! A completed copy of the relevant planning forms listed in Appendix A, 
��System planning forms,�� including: 

� The "Modular Messaging MAS planning form" on page A-7 showing 
the NetBIOS name of each MAS, the default (or primary) peer Domino 
server, and the Windows domain.

� The "Modular Messaging logon accounts form" on page A-10 showing 
the customer-specified Modular Messaging account names and 
passwords. 

! Access to Domino Unified Communications (DUC) software and the 
latest installation and configuration documentation available from IBM 
Lotus. 

CAUTION: All servers must meet the requirements listed in Avaya 
Modular Messaging Concepts and Planning Guide (PDF 2 
MB), available on the documentation media shipped with the 
system. Review this document to verify that all the Domino 
servers, MASs, and client machines are ready to support 
Modular Messaging software.

!
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Setting up Domino to support Modular Messaging

This section summarizes how to prepare the IBM Lotus Domino environment to 
support Avaya Modular Messaging software. 

To create IBM Lotus Domino environment and Modular Messaging interoperability, 
complete the following procedures in each Domino domain:

1. Install the DUC server component on each mail server that hosts voice 
mail subscribers, and on the Domino mail server that stores the mail files 
for the MAS voice servers. 

2. Install the DUC administration component to update the Domino 
directory for Modular Messaging. This step has two parts:

a. Run the administration component installation program once per Domino 
domain to �Update the design of the Domino Directory on the server.� This 
program extends the Domino Directory design to support Avaya Modular 
Messaging, including adding fields for Modular Messaging to the Other tab 
in the Person document and adding an Avaya Voicemail Domains view. 

b. Only on machines that will be used to administer Modular Messaging 
subscribers, run the administration component installation program again to 
�Install administration component on this machine.� This allows the user of 
this machine to enable subscribers for Modular Messaging. 

Note: For complete steps on installing and configuring DUC to support 
Avaya Modular Messaging, see the Administrator�s Guide for Lotus 
Domino Unified Communications for Avaya, available on the IBM 
Lotus Documentation Web site www-10.lotus.com/ldd/doc under 
the product Domino Unified Communications 1.2.2. 

You must install the Lotus Domino Administrator client before you 
can install DUC administration software. 

Note: This procedure installs several new mail templates based upon 
the version of Domino that you are running. These templates 
are required to support Modular Messaging. 

You must stop the Domino server to install the components, 
and then start it up again to proceed. 

Note: A machine with the administration component installed is 
required for acceptance testing. See "Testing the outcalling 
capability" on page 10-6. 

CAUTION: Do not install the DUC Administration Component on a 
Messaging Application Server (MAS).!

http://www-10.lotus.com/ldd/notesua.nsf/a08df36b2299a8bc8525665d006dce40/fa75f3e569ae6aa685256daa00566137?OpenDocument 
http://www-10.lotus.com/ldd/notesua.nsf/a08df36b2299a8bc8525665d006dce40/fa75f3e569ae6aa685256daa00566137?OpenDocument


585-310-330, Issue 1

Avaya Modular Messaging for IBM Lotus Domino Release 1.1 Installation

4�4 May 2004

3. Register each MAS voice server as a Notes user so that it has a user 
name, ID file, and mail file. These files are used to route voice messages 
through the Domino domain. Considerations include: 

! Choose no password expiration if permitted at this site. Record the 
password for this account to facilitate Modular Messaging software 
installation. See Item 7 on the "Modular Messaging MAS planning 
form" on page A-7. 

! Save a copy of the Notes user ID file so that it can be accessed 
during Modular Messaging software installation. Record the complete 
path and file name (such as C:\temp\masacct1.id). See Item 8 on the 
"Modular Messaging MAS planning form" on page A-7. 

! The registration process also creates a mailbox file in the default mail 
folder of the peer Domino server. Record the path and file name 
(such as mail\zippy.nsf). See Item 9 on the "Modular Messaging MAS 
planning form" on page A-7. 

4. Create an access control list (ACL) group for the MAS voice servers 
(such as VMServer_ACL_Group, where VMServer identifies the voice 
mail domain). See Item 10 on the "Modular Messaging MAS planning 
form" on page A-7. Add this group to the Domino Directory in each 
Domino domain that MAS voice servers must access. 

5. Edit the ACL of the Domino Directory database to give MAS voice 
servers and administrators the correct level of access. To do this: 

a. Create two new roles that must be named UMAdmin and UMServer. 

b. Add the voice server ACL group to the ACL and give it the UMAdmin and 
UMServer roles, user type PersonGroup, the Create documents privilege, 
and Author or higher access. 

c. Assign the following access to all administrators who will enable DUC 
subscribers: UMAdmin and UserModifier roles, the Create documents 
privilege, and Author or higher access.

6. Edit the ACL of the Administration Requests database to give MAS voice 
servers and administrators the correct level of access. To do this, assign 
the Create documents privilege and Author or higher access.

Note: If password expiration is required, contact the Modular 
Messaging software provider to change the password on the 
MAS side after it has been changed on the Domino side. 

CAUTION: Do not voice-mail enable the Modular Messaging account. 
This must be an email-only account for call processing to 
work. It will fail to work correctly if voice mail is enabled. 

!
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The Domino Directory is now enhanced to store Modular Messaging subscriber 
information in the Person document. Continue with the procedures in this guide to 
complete the installation and administration of the Modular Messaging system. 

Setting up Windows to support Modular Messaging

This section describes how to set up the Microsoft Windows environment to support 
the Avaya Modular Messaging software. 

Setting up Modular Messaging accounts

Create a Modular Messaging service account and a remote access account to support 
Avaya Modular Messaging software as directed in this section. 

Create the Modular Messaging accounts as follows: 

1. Log in to the Windows domain server using an account that has 
privileges to create new user accounts (such as administrator).

2. Create a new Modular Messaging service account that has domain user 
privileges (such as mmacct). See Item A6 on the "Modular Messaging 
logon accounts form" on page A-10. This account is used for installing 
and administering the Modular Messaging software on each MAS. 

3. Create a new account to allow remote support personnel to access and 
administer the Modular Messaging system (such as craft). See Item A7 
on the "Modular Messaging logon accounts form" on page A-10. 

4. Add both Modular Messaging accounts to the Administrators group 
that will be used to administer the Messaging Application Server (MAS). 

Note: You must set up the Modular Messaging service account on the 
Windows directory server in same Microsoft Windows domain as 
the Domino server and give it Administrator rights. 

Note: Passwords for Modular Messaging accounts should be at least 
8 characters long. See the logon form for details. 

If you need to change the password for the Modular Messaging 
service account at some point, contact the software-provider 
for the password-changing procedure. 

Note: If you change the password for the remote access account, be 
sure to notify the appropriate remote support organization. 
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Adding an MAS account to the Windows domain

Before the Modular Messaging software is installed, the domain administrator should 
create computer accounts for each MAS and define the Modular Messaging service 
account as a user that has permission to join the Windows domain. This procedure 
facilitates remote access setup (see "Setting up the MAS for remote access" on page 
4-6) and Modular Messaging software installation (see "Completing the initial setup" on 
page 5-9 and "Joining the Windows domain" on page 6-4). 

To add a new computer account to the Active Directory:

1. Log in to the Active Directory server using an account that has privileges 
to add a computer account to a domain (such as Administrator).

2. Click Start > Programs > Administrative Tools > Active Directory 
Users and Computers.

3. In the Active Directory Users and Computers window, expand the 
directory for the Windows domain that you will use for Modular 
Messaging (such as zodiac.loc.avaya.com). 

4. To create a new computer account, right-click Computers, and then 
select New > Computer. 

a. In the New Object - Computer window, type the computer name for the 
MAS (such as zippy). See Item 1 on the "Modular Messaging MAS planning 
form" on page A-7.

b. Click Change to specify that a different user or group that can add this 
computer to the domain. 

c. In the Select User or Group window, double-click the Modular Messaging 
service account (such as mmacct). 

d. Click OK to close this window. 

5. If more than one MAS is to be installed, repeat Step 4 until all MASs are 
added. 

Setting up the MAS for remote access

Remote access allows technical support personnel to dial into a system to correct 
problems and perform routine maintenance. Unless other arrangements have been 
made, use the following procedure to allow the MAS to support remote access calls. 

1. The Active Directory Users and Computers window should already be 
open. If not, repeat Steps 1 through 3 in "Adding an MAS account to the 
Windows domain" above to log in to an account with the appropriate 
privileges and access the Active Directory. 

2. In the left pane, under the directory for the domain that will be used for 
Modular Messaging (such as zodiac.loc.avaya.com), click Users. 
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3. In the right pane of the window, double-click RAS and IAS Servers to 
bring up the properties window.

4. In the RAS and IAS Servers Properties window:

a. Click the Members tab.

b. Click Add.

c. In the Select Users, Contacts, Computers, or Groups window, double-click 
the first MAS (such as ZIPPY). It has a blue terminal icon beside it.

d. Verify that the correct computer name is shown underlined in the list box.

e. Repeat Steps c and d to add all MASs to this list. See the "Modular 
Messaging MAS planning form" on page A-7. 

f. Click OK to close this window.

g. Click OK again to close the RAS and IAS Servers Properties window.

5. In the right pane, double-click the account to be used for remote 
technical support (such as craft or Support Account). 

6. In the properties window for the technical support account: 

a. Click the Dial-in tab.

b. Under Remote Access Permission (Dial-in or VPN), select Allow access.

c. CallBack Options should remain at No Callback.

d. Click OK. 

7. Close the Active Directory Users and Computers window. 
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5
Configuring a new Avaya MAS

This chapter is relevant only to an Avaya-provided Messaging Application Server 
(Avaya MAS) installation. It describes how to complete the Windows 2000 Server 
Setup Wizard and initial configuration after a new Avaya MAS is powered up (see 
"Powering up an Avaya MAS system" on page 2-30).  

Topics in this chapter include: 

Note: Before you can do the tasks described in this section, a system 
administrator must have successfully completed the tasks in 
Chapter 4, ��Preparing to install Modular Messaging software.�� 

If you are using a customer-provided MAS, continue with Chapter 
6, ��Configuring a customer-provided MAS.��

Section Page

Overview 5-2

Setting up the Windows system 5-4

� Running the setup wizard 5-4

� Assigning IP addresses to this MAS 5-6

� Completing the initial setup 5-9

Testing IP addresses using ping 5-11

Installing required software 5-12

� Installing anti-virus software 5-12

� Updating Microsoft Windows 5-12

� Preparing the MAS to support Domino 5-12

Configuring Modular Messaging components 5-15
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Overview

You must configure every new Avaya Messaging Application Server (Avaya MAS) for 
local operating settings and to work correctly on the corporate local area network (LAN) 
as described in this section. In addition, you must prepare it to operate correctly in the 
Microsoft Windows and Domino environment. 

To successfully set up an Avaya MAS, you need:

! A completed copy of all the forms in Appendix A, ��System planning 
forms,�� including the "Modular Messaging MAS planning form" on page 
A-7 and the "Modular Messaging logon accounts form" on page A-10.

! All required hardware installed as described in Chapter 2, ��Installing 
Avaya-provided hardware.��

! A printout of the Avaya MAS installation checklist (see "New Modular 
Messaging installation on an Avaya MAS" on page B-5). Check off steps 
as you complete them to track your progress.

Switching the monitor to show the correct server

Use whatever method is required at this site to have the monitor display the Avaya 
MAS that you are administering. 

For a Belkin OmniView Pro2 KVM: the KVM switch is normally connected to the first 
Avaya MAS (MAS#1) through the first computer port (VGA 01). Subsequent MASs (if 
present) are connected to computer ports VGA 02, VGA 03, and so on. 

To show a different server on the monitor:

1. Slowly press Scroll Lock, then Scroll Lock again, and then the up (or 
down) arrow key to change to the server connected to a higher (or 
lower) port number. 

Alternatively you can type the port number instead of pressing the up or 
down arrow key (such as 01 for port 1). See the KVM switch 
documentation for complete user instructions.

2. If you cannot access the correct server, see "Connecting the KVM 
cables" on page 2-25 and verify that the cable connections are correct. 
To correct cabling problems, power down the system and correct the 
cabling. Then power up the system again.

CAUTION: Use the completed planning forms from Appendix A, 
��System planning forms,�� to enter the correct values. Do not 
guess at the values or use the examples shown in this guide. 
If you do, the operation of the customer LAN might be 
damaged.

!
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Starting up the system

The Avaya MAS begins to boot after power up. 

1. If the Avaya MAS is not already on, power up the unit now (push the 
power button on the front panel). 

See "Powering up an Avaya MAS system" on page 2-30 for details, if 
needed. 

2. Optional: When the system begins to boot, you can:

a. Press Esc when the splash screen is displayed.

b. Press the space bar to skip the memory check. 
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Setting up the Windows system

After the Avaya MAS boots, a setup wizard guides you through the Windows system 
configuration process. Complete all steps as directed. 

Running the setup wizard

To complete the setup wizard:

1. On the Welcome to the Windows 2000 Server Setup Wizard screen, 
click Next. (If you wait, the wizard automatically shows the next screen.) 

2. On the License Agreement screen, review the text. 

a. If you agree to the terms, choose I accept this agreement. 

b. Click Next.

3. On the Regional Settings screen: 

a. Verify that the settings are correct. 

b. To change system and user locales, click the first Customize button. 

c. In the Regional Options window, on the General tab:

(1) Select the locale from the drop-down list.

(2) Update the language settings if needed. Click Apply. 

(3) Click the other tabs in order, and verify that the Numbers, 
Currency, Time, and Date settings are correct for this system. 
The defaults should reflect the locale you selected.

(4) Click the Input Locales tab. Verify the locale and keyboard 
settings. 

(5) When finished, click OK to close the Regional Options window.

d. Click Next.

4. On the Personalize Your Software screen, enter the customer name and 
organization in the appropriate fields. See Item 22 on the "Modular 
Messaging MAS planning form" on page A-7. Click Next. 

Note: If you decline the terms, you cannot proceed with the 
installation. 
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5. On the Your Product Key screen:

a. Type the Windows product key for this MAS (each unit has a unique product 
key). 

b. Click Next.

6. On the Licensing Modes screen:

a. Select Per Server (if not already selected).

b. For Number of concurrent connections, type 50.

c. Click Next.

7. On the Computer Name and Administrator Password screen:

a. Change Computer name to the required host name (NetBIOS name) for 
this MAS (such as zippy). See Item 1 on the "Modular Messaging MAS 
planning form" on page A-7. (The name is forced to upper case.)

b. Enter and confirm the new password for the administrator account for this 
machine (case is important). See Items A1 to A5 on the "Modular 
Messaging logon accounts form" on page A-10.

c. Click Next. 

8. On the Modem Dialing Information screen: 

a. Select the country or region.

b. Enter the area code or city code.

c. If needed, enter the prefix required to access an outside line (such as 9).

d. Select the type of dialing used (typically Tone dialing).

e. Click Next. 

9. On the Date and Time Settings screen: 

a. Set the date and time settings. 

b. Set the time zone and daylight savings values, as needed.

c. Verify the settings, and then click Next. 

The system pauses to update its settings.

Note: This number must be entered exactly as shown. It is located on 
a sticker or tag on the side or rear of each MAS unit.

Note: This screen is displayed only if a modem is connected. See 
"Connecting the USB modem on the MAS" on page 2-28. 
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10. On the Network Settings screen, when prompted:

a. Select Custom settings.

b. Click Next.

Assigning IP addresses to this MAS

Use the completed "Modular Messaging MAS planning form" on page A-7 to assign IP 
addresses and other TCP/IP properties for the corporate LAN interface that this MAS 
will use. 

On the Networking Components screen for device Intel(R) PRO/100 VE Network 
Connection, specify the IP addresses for the corporate LAN for this MAS as follows:

1. In the components box, select Internet Protocol (TCP/IP).

2. Click Properties.

The Internet Protocol (TCP/IP) Properties window is displayed. See 
Figure 5-1 on page 5-7 for an example. 

3. In the Internet Protocol (TCP/IP) Properties window:

a. Select Use the following IP address.

b. Change the IP address, subnet mask, and default gateway to the corporate 
LAN values for this MAS as listed on the "Modular Messaging MAS 
planning form" on page A-7 (see Items 14, 15, and 16). 

c. Select Use the following DNS server addresses. Specify the corporate 
DNS IP addresses as follows:

(1) For Preferred DNS server, enter the first Corporate DNS server 
IP address from the planning form, if any (see Item 17). 

(2) For Alternate DNS server, enter the next Corporate DNS server 
IP address from the planning form, if any (see Item 17).

(3) Click the Advanced button.
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The Advanced TCP/IP Settings window is displayed. 

(4) Click the DNS tab. See Figure 5-2 on page 5-8 for an example.

Figure 5-1. Sample corporate LAN TCP/IP properties 
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(5) On the Advanced TCP/IP Settings DNS tab, enter the following: 

! To add IP addresses for any additional corporate DNS servers, click 
Add (see Item 17 on the "Modular Messaging MAS planning form" on 
page A-7). Click Add or press Enter to approve each entry. 

! Select Append these DNS suffixes (in order). Click Add.

! In the TCP/IP Domain Suffix window, in the Domain suffix field, 
enter any corporate domain suffixes listed for Item 18 on the system 
planning form (for example, loc.avaya.com and avaya.com). After 
each entry, click Add. Repeat as needed to add all required suffixes.

! In the DNS suffix for this connection field, enter the suffix for the 
fully qualified corporate LAN domain name. Do not include the 
machine name (for example, loc.avaya.com). See Item 13 on the 
"Modular Messaging MAS planning form" on page A-7.

! If required for this location, select the options to Register this 
connection�s addresses in DNS and Use this connection�s DNS 

Figure 5-2. Sample advanced TCP/IP settings for the corporate LAN
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suffix in DNS registration. See Item 19 on the "Modular Messaging 
MAS planning form" on page A-7.

(6) If WINS is used at this location, click the WINS tab. Enter the 
following:

! To enter WINS addresses, click Add. Enter the IP address for the 
WINS server needed for information resolution. Click Add. Repeat 
this step until all required WINS addresses are entered. See Item 20 
on the "Modular Messaging MAS planning form" on page A-7.

! Adjust other settings on this page if required. 

(7) Click OK to close the Advanced TCP/IP Settings window.

4. Click OK to close the Internet Protocol (TCP/IP) Properties window.

5. On the Networking Components screen, click Next.

A Networking Components screen for device Intel(R) PRO/100+ PCI 
Adapter screen is displayed. This LAN interface is not used in this 
configuration.

6. Click Next.

Completing the initial setup

Complete the initial administration for this MAS as follows: 

1. On the Workgroup or Computer Domain screen:

a. Select the second option, Yes, make this computer a member of the 
following domain.

b. Enter the name of the corporate Windows domain that the MAS is to join 
(such as zodiac). See Item 2 on the "Modular Messaging MAS planning 
form" on page A-7. (The name is forced to upper case.)

c. Click Next.

d. You are prompted to enter the user name and password that will allow this 
machine to join the Windows domain. Proceed as follows:

(1) Enter the name of an account that has permissions to join the 
Windows domain. This is typically the Modular Messaging service 
account, if the domain administrator has set it up as described in 
"Adding an MAS account to the Windows domain" on page 4-6. 
The account name must be in the format domain\account name 
(such as zodiac\mmacct). 

(2) Enter the correct account password.

Note: Avaya strongly recommends that you do not use DHCP 
settings for this installation. Use only static IP addresses. 
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(3) Click OK.

It might take several minutes to join the domain.

e. If a Network Identification message welcomes you to the domain, click OK.

f. Click Next.

2. On the Completing the Windows 2000 Setup Wizard screen, click 
Finish.

The machine reboots. 

3. When the reboot is complete, press Ctrl+Alt+Del and log in as follows:

a. In the Log On to Windows window, verify that the user name is 
Administrator. 

b. Enter the same password that you typed for the administrator account when 
you set up this machine. See Items A1 to A5 on the "Modular Messaging 
logon accounts form" on page A-10.

c. Press Enter or click OK. 

4. If a Found New Hardware wizard runs, follow the prompts to complete 
each wizard. The system runs the hardware wizard once for every 
Dialogic port board installed in the MAS. 

Temporarily disable the Dialogic hardware as follows:

a. On the Welcome screen, click Next. 

b. On the Install Hardware Device Drivers screen, accept the default option 
(Search for a suitable driver) and click Next. 

c. On the Locate Driver Files screen, clear the checkbox for Specify a 
location (no boxes will be checked). Click Next.

d. On the Driver Files Search Results screen, verify that Disable the device is 
selected. Click Finish.

e. Repeat Steps a through d for each repetition of the wizard.

Note: If the Found New Hardware wizard comes up in a tiny window, 
press Esc to cancel the wizard. Subsequent wizards should 
then start in a normal-sized window. The skipped wizard runs 
the next time the system restarts. Complete it then.

If you reinstalled the operating system (see Appendix D, 
��Reloading software on an Avaya MAS,��) and ran the Found 
New Hardware wizards then, the wizards do not run again. 

This wizard does not run for IIP H.323 configurations. 
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Testing IP addresses using ping

Use this procedure to verify that the IP addresses for this MAS are correct and are 
working as expected with the corporate LAN.

To test the IP addresses for this MAS: 

1. Open a Command prompt window:

a. Click the Start button, and then select Run. 

b. In the Run window Open field, type cmd and press Enter. 

2. At the command prompt, ping any IP addresses administered on the 
corporate network and verify success. See Items 16 and 17 on the 
"Modular Messaging MAS planning form" on page A-7 for examples.

3. Optional: If you are using a corporate DNS, you might also want to ping 
other machines by name. Any name tests should show the corporate IP 
address for the destination you ping. 

4. If the ping test fails, verify that the network connections to the MAS are 
good. If the connections are good, check the administration. 

5. When finished, type exit and press Enter to close this window.

Note: Submenu choices are indicated with a right angle sign (>) in 
the rest of this document. For example, the procedure above 
would appear as Start > Run.

Note: For a name test to succeed, the machine names must be 
administered on the corporate DNS. If a corporate DNS is not 
used, ping will not be able to resolve the corporate name.
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Installing required software

You must install some required software on the Avaya MAS before proceeding. Check 
with the customer for the procedures and software required at this site.

Installing anti-virus software 

Avaya strongly recommends that anti-virus software be installed on any Microsoft 
Windows machine that is used to run Avaya Modular Messaging software. The type of 
virus-checking software used and the method of installation depends upon the 
customer requirements and local implementation. 

Updating Microsoft Windows

A new Avaya MAS contains the most current Microsoft Windows software at the time it 
is shipped. However, if the system is not installed promptly, the latest Microsoft 
Windows system updates, security patches, and hot fixes should be installed to protect 
the operating system from known security weaknesses. Check with the appropriate 
Windows administrator for the software update procedures to use at this site. 

Preparing the MAS to support Domino

If either the Messaging Application Server or the Mailbox Monitor Server software 
component is to be installed on this MAS, you must install the appropriate IBM Lotus 
Domino software on the MAS to allow the Modular Messaging and Domino systems to 
communicate. To support clustering, use at least the 6.0.1 version of the Notes client 
with the latest critical fixes. 

CAUTION: The intended outcome of this procedure is to set up a Lotus 
Notes client for the Modular Messaging service account 
(such as mmacct) on the MAS. On an Avaya MAS, this 
service account is not created until "Configuring Modular 
Messaging components" on page 5-15. If you install the 
Notes client software now, it will set up the client under the 
administrator account. To work around this problem, either: 
� Edit the Notes client for the Modular Messaging service 

account if you install the client software now (this might 
require reinstalling the client software), or

� Cancel out of the Installation wizard when it runs at the 
end of the configuration section, and install the Notes 
client software then. See the end of the procedure on 
page 5-16 for details. 

!
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Do the following on each MAS before you install the Modular Messaging software:  

1. Install the Notes client on the MAS as a single-user installation (if the 
system prompts you for that selection). Reboot the system if prompted.

2. Obtain a copy of the Lotus Notes ID file for this MAS account (such as 
C:\temp\masacct1.id) from the Domino administrator. See Item 8 on the 
"Modular Messaging MAS planning form" on page A-7. 

3. Copy the Lotus Notes ID file (such as masacct1.id) to the Notes data 
directory on this MAS. The default local path varies per Domino release 
as shown, but use the required path for this Domino installation:

! Release 5: C:\Lotus\Notes\Data

! Release 6: C:\Program Files\Lotus\Notes\Data 

4. Configure the Notes client to connect to the Domino server using this ID 
file as follows: 

a. Click Start > Programs > Lotus Applications > Lotus Notes. The first 
time you access this option, a wizard runs.

b. On the Lotus Notes Client Configuration wizard, choose the following 
options (click Next to proceed after each screen): 

(1) Choose Connect to Domino server. 

(2) For Connection type, select LAN. (Set up options and proxies 
appropriate for your network topology.) 

(3) For Domino Server Name, use the Domino hierarchical server 
name (such as domino1/zeppelin, where domino1 is the peer 
Domino server and zeppelin is the Domino domain). See Item 6 
on the "Modular Messaging MAS planning form" on page A-7. 

(4) Browse to the Lotus Notes ID file for this MAS (such as 
masacct1.id) in the Notes data directory. Select the ID file. 

(5) Enter the password used when the user of this MAS voice server 
was registered. See Item 7 on the "Modular Messaging MAS 
planning form" on page A-7. 

(6) Do not create an Internet account or a new server. 

Note: You must install the Lotus Notes client only on any MAS that will 
have either the Messaging Application Server or the Mailbox 
Monitor Server Modular Messaging software component installed. 
(For example, the Tracing Server does not require the Notes client 
to be installed if it is the only Modular Messaging service on that 
machine.) See "MAS features list" on page A-11 to confirm if the 
Lotus Notes client must be installed on this particular MAS.
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(7) Specify replication settings and email sending options as follows: 

! In the Lotus Notes Client Configuration wizard, on the Additional 
Services screen, select Replication settings for sending and 
receiving mail. 

! On the Set Up Replication screen, clear the checkbox for Do not 
automatically send outgoing messages to server. 

! Set How many e-mail messages should collect in your outgoing 
mail box before Notes sends them? to a low number, such as 1. 

(8) If prompted, select IBM Lotus Notes as the default messaging 
program. To specify the default messaging program manually: 

! Access the Internet Properties or Options page for your browser.

! On the Programs tab, for E-mail, select Lotus Notes. 

c. When done, click Finish and then OK. 

5. Close the Notes client before proceeding.

Setting up remote access (optional)

As an option, you can activate remote access support now instead of waiting until after 
you install the Modular Messaging software. If you want to enable remote access 
support as soon as possible, do the steps appropriate for the Avaya MAS in "Setting up 
remote access" on page 7-11, and then return to this section. 

Note: This is not the default setting. You must clear this setting for the 
client software to work correctly. 

CAUTION: Do not set up Microsoft Outlook or Outlook Express on a 
Messaging Application Server (MAS). 

The Notes client installed on the MAS is for use by the MAS 
only. Using it for any other purpose could result in voice 
server exception errors.

Do not install any DUC software on an MAS voice server. 

!
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Configuring Modular Messaging components

Complete the basic machine setup of this Avaya MAS by specifying the message store 
and setting up Modular Messaging accounts for this MAS.

To complete basic Avaya MAS configuration:

1. Double-click the OSConfigWizard.exe icon on the desktop. 

The Modular Messaging OS Component Configuration Wizard runs.

2. On the Welcome screen, click Next.

3. On the Modular Messaging setup information screen:

a. Select the message store type Lotus Domino. 

b. For Windows NetBIOS domain, enter the NetBIOS name of the Windows 
domain (such as zodiac). See Item 2 on the "Modular Messaging MAS 
planning form" on page A-7.

c. Click Next.

4. On the next Modular Messaging setup information screen, enter the 
Modular Messaging account information as follows: 

a. Under Existing account information:

! For Modular Messaging (MM) account, enter the 
customer-defined Modular Messaging service account logon 
name (such as mmacct). Type the password in each password 
column to confirm it. See Item A6 on the "Modular Messaging 
logon accounts form" on page A-10.

! For Services account, enter the customer-defined technical 
support account logon name (such as craft). Type the password in 
each password column to confirm it. See Item A7 on the "Modular 
Messaging logon accounts form" on page A-10.

b. Under New account information, for Administrator account for MAS, 
enter the customer-defined local administrator account logon name for this 
MAS (such as mas1-admin or mas2-admin). Type the password in each 
password column to confirm it. See Items A1 to A5 on the "Modular 
Messaging logon accounts form" on page A-10.

c. Click Next.

5. Wait while the system processes the information you have entered. The 
system automatically restarts.

As the machine reboots, you might see a Hardware Profile/Configuration 
Recovery screen. Wait for the program to move on, or press Enter. 
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6. After the MAS reboots, you are prompted to log in. 

a. When prompted to log in, press Ctrl+Alt+Del. 

b. In the Log On to Windows window, check the user name. It should be the 
Modular Messaging service account (such as mmacct).

c. Enter the correct password for this account. See Item A6 on the "Modular 
Messaging logon accounts form" on page A-10.

7. When prompted to insert the Modular Messaging application software:

a. Insert the Avaya Modular Messaging Application Software DVD in the DVD 
drive. 

b. Close the drive door and wait for the green LED to go out. 

c. Click OK. 

8. If a Completed Configuration process screen is displayed, click Finish. 

9. The Modular Messaging Installation Wizard runs automatically. 

Note: Do not insert the boot-image Avaya Modular Messaging OS 
Boot Software DVD! 

CAUTION: If you did not yet install the Notes client software on this MAS 
(see "Preparing the MAS to support Domino" on page 5-12 
to verify if the client software is required on this MAS), you 
must install it before running the Modular Messaging 
Installation Wizard. To do this: 
� Cancel out of the Modular Messaging Installation Wizard 

when it runs. 
� Do the steps in "Preparing the MAS to support Domino" 

on page 5-12 to install the Notes client now under the 
Modular Messaging service account login (such as 
mmacct). 

� Continue with "Running the installation wizard" on page 
7-3 to install the Modular Messaging software. 

If the Notes client is already installed on this MAS and you 
can see the client software when you are logged into the 
Modular Messaging service account, continue with 
"Installing the Modular Messaging software" on page 7-4. 

!
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6
Configuring a customer-provided

MAS

This chapter is relevant only to a customer-provided Messaging Application 
Server (MAS) installation. It describes how to set up a customer-provided MAS to 
support Avaya Modular Messaging software.  

Topics in this chapter include: 

Note: Before you can do the tasks described in this section, a system 
administrator must have successfully completed the tasks in 
Chapter 4, ��Preparing to install Modular Messaging software.�� 
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Overview

If you are installing Modular Messaging software on a customer-provided MAS, you 
must first configure it to support the Modular Messaging software and to operate 
correctly in the Microsoft Windows and Domino environment. 

To successfully set up a customer-provided MAS, you need:

! A completed copy of all the forms in Appendix A, ��System planning 
forms,�� including the "Modular Messaging MAS planning form" on page 
A-7 and the "Modular Messaging logon accounts form" on page A-10. 

! All required hardware installed as described in Chapter 3, ��Installing 
MAS port boards.��

! A printout of the appropriate installation checklist (see "New Modular 
Messaging installation on a customer-provided MAS" on page B-2). 
Check off steps as you complete them to track your progress.
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Preparing the MAS

Do the following steps as required for this MAS. 

Configuring the network card

For each customer-provided MAS, the network card must be configured to support a 
corporate LAN connection. This procedure is similar to that used for the Avaya MAS in 
"Assigning IP addresses to this MAS" on page 5-6. Use the completed "Modular 
Messaging MAS planning form" on page A-7 to assign IP addresses and other TCP/IP 
properties for the corporate LAN interface that this MAS will use. 

Installing anti-virus software

Avaya strongly recommends that anti-virus software be installed on any Microsoft 
Windows machine that is used to run Avaya Modular Messaging software. The type of 
virus-checking software used and the method of installation depends upon the 
customer requirements and local implementation. 

Updating Microsoft Windows

The latest Microsoft Windows system updates, security patches, and hot fixes must be 
installed to protect the operating system from known security weaknesses. Check with 
the Windows administrator for the software update procedures to use at this site. 

Running recommended disk checks

Avaya recommends that the MAS drive be maintained to prevent possible problems. 
The system administrator should run the following on a regular basis: 

! Disk Defragmenter system tool 

! chkdsk command 

If this MAS has been in service and has not been recently maintained, run the two 
procedures recommended above. You can do this now if convenient, or at the end of 
the installation (see "Backing up the system" on page 10-9). 

CAUTION: Use the completed planning forms from Appendix A, 
��System planning forms,�� to enter the correct values. Do not 
guess at the values or use the examples shown in this guide. 
If you do, the operation of the customer LAN might be 
damaged. 

Avaya strongly recommends that only static IP addresses be 
assigned to MAS interfaces and machines.

!
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Joining the Windows domain

You must manually join the appropriate Windows domain as follows:

1. Switch the monitor to show this MAS. 

2. Log in to the local administrator account for this MAS: 

a. In the Log On to Windows window, change the user name to the local 
administrator account name (such as mas1-admin). See Items A1 to A5 on 
the "Modular Messaging logon accounts form" on page A-10. 

b. Enter the password for this account.

c. If the Log in to: field shows a different domain, use the drop-down box to 
select this local machine (it should be the default). 

d. Press Enter or click OK.

3. Right-click My Computer and select Properties.

4. In the System Properties window, click the Network Identification tab.

5. Click Properties. In the Identification Changes window: 

a. Under Member of, select the Domain option.

b. Type the corporate Windows domain NetBIOS name, such as zodiac. See 
Item 2 on the "Modular Messaging MAS planning form" on page A-7. 

c. Click OK.

6. A Domain Username And Password window might appear. Enter the 
name and password of an account that has permissions to join the 
Windows domain. This is typically the Modular Messaging service 
account, if the domain administrator has set it up as described in 
"Adding an MAS account to the Windows domain" on page 4-6. The 
account name must be in the format domain\account name (such as 
zodiac\mmacct). 

7. If a Welcome to the domain message is displayed, click OK.

8. When prompted to reboot, click OK. 

9. Click OK to close the System Properties window. 

10. When prompted to restart the machine, click Yes. You must reboot. 

Note: Depending on the local configuration, you might need to enter 
the fully qualified name here, such as zodiac.loc.avaya.com. 
This name is a combination of Items 2 and 13 on the "Modular 
Messaging MAS planning form" on page A-7. 
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Adding Modular Messaging accounts to the local 
Administrators group

For the accounts to work correctly, the Modular Messaging service account (required 
for software installation and administration) and the technical support remote access 
account must be added to the local administrators group as follows:

1. Log in to the local administrator account for this MAS (see "Joining the 
Windows domain" on page 6-4 for details if needed). 

2. Click Start > Programs > Administrative Tools > Computer 
Management. 

3. In the Computer Management window, under System Tools, expand 
Local Users and Groups, and then click Groups. 

4. Double-click the Administrators group in the right pane.

5. In the Administrators Properties window, click Add.

6. In the Select Users or Groups window:

a. Under the Look in drop-down, select the Windows domain you just joined, 
such as zodiac. See Item 2 on the "Modular Messaging MAS planning form" 
on page A-7.

b. On the Enter Network Password window, enter an account name and 
password that has permission to access the Windows domain controller. 
This is typically the Modular Messaging service account, if the domain 
administrator has set it up as described in "Adding an MAS account to the 
Windows domain" on page 4-6. The account name must be in the format 
domain\account name (such as zodiac\mmacct).

c. Click OK.

7. Scroll down to the Modular Messaging service account, such as 
mmacct. See Item A6 on the "Modular Messaging logon accounts form" 
on page A-10. 

a. Double-click it or click Add to add it to the Administrators group. 

The account name might appear in the format domain\account name (for 
example, zodiac\mmacct) or as an email account, such as 
mmacct@zodiac.loc.avaya.com. 

b. Click OK.

8. Repeat Steps 5 through 7 to add the technical support remote access 
account, such as craft. See Item A7 on the "Modular Messaging logon 
accounts form" on page A-10. 

9. Click OK to close the Administrators Properties window.
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10. Close the Computer Management window.

Adjusting system values

Some default values on the system must be adjusted to support Modular Messaging as 
described in this section. 

Adjust the values for the Event Viewer as follows: 

1. Right-click My Computer and select Manage. 

2. In the Computer Management window, in the left pane, expand Event 
Viewer. 

3. Right-click Application and select Properties.

4. On the General tab of the Application Properties window, under 
Log size, adjust the following values: 

a. Avaya recommends that you set Maximum log size to at least 102400 KB. 

b. Select the option Overwrite events as needed. 

5. Click OK to close the properties window. 

6. Close the Computer Management window. 

Adjust File and Printer Sharing properties as follows: 

1. Right-click My Network Places and select Properties. 

2. Double-click Local Area Connection to open the properties window.

3. Select File and Printer Sharing for Microsoft Networks and click 
Properties. 

4. In the properties window, on the Server Optimization tab under 
Optimization, select Maximize data throughput for network 
applications. 

5. Click OK to close the properties window.

6. Close all open windows. 
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Adjust the Windows 2000 Server operating system values as follows: 

1. Right-click My Computer and select Properties. 

2. In the System Properties window, click the Advanced tab, and then click 
Performance Options. 

3. In the Performance Options window, adjust the following values: 

a. Select the option Background services. 

b. Click Change to change the virtual memory size.

(1) Under Paging file size for selected drive, set both the Initial 
size and Maximum size to the recommended value +11 MB. 

(2) Click Set, and then click OK to close the Virtual Memory window. 

c. Click OK to close the Performance Options window.

4. On the Advanced tab of the System Properties window, click Startup 
and Recovery. 

5. In the Startup and Recovery window, under System Failure, verify that 
the checkbox to Automatically reboot is checked. Click OK. 

6. Close the System Properties window. 

7. Restart the system before proceeding: 

! If you are prompted to restart the system, click Yes. 

! If the system does not prompt you, manually restart the system now. 
For example, press Ctrl+Alt+Del, and then click Shut Down. Select 
Restart from the drop-down list and click OK. 

The system reboots. 

8. When the reboot is complete, log in to the Modular Messaging service 
account: 

a. In the Log On to Windows window, change the user name to the Modular 
Messaging service account name (such as mmacct). See Item A6 on the 
"Modular Messaging logon accounts form" on page A-10.

b. Enter the password for this account.

c. Using the drop-down box, change the Log in to: field to show the correct 
Windows domain, such as zodiac. See Item 2 on the "Modular Messaging 
MAS planning form" on page A-7. 

d. Press Enter or click OK. 



585-310-330, Issue 1

Avaya Modular Messaging for IBM Lotus Domino Release 1.1 Installation

6�8 May 2004

Installing Windows prerequisite software

If this MAS will have the Messaging Application Server service installed on it, and if 
Simple Network Management Protocol (SNMP) will be used for alarming at this site 
(see "Required switch and messaging information" on page A-14), you must install and 
enable the appropriate Microsoft Windows services to support SNMP. 

To install and enable Windows SNMP services:

1. Log in to an account that has permissions to install software on this 
machine (such as the local administrator account if needed, or the 
Modular Messaging service account, such as mmacct). 

2. Insert the Microsoft Windows Operating System CD in the MAS drive.

3. Click Start > Settings > Control Panel.

4. In the Control Panel window, double-click Add/Remove Programs.

5. In the Add/Remove Programs window, in the left column, click 
Add/Remove Windows Components. 

6. In the Windows Components Wizard window, click the checkbox to 
select Management and Monitoring Tools and click Next. 

7. In the Management and Monitoring Tools window, click the checkbox to 
select Simple Network Management Protocol. 

8. Complete the wizard to install the SNMP services.  

9. After the software is installed, enable the required services as follows: 

a. Right-click My Computer and select Manage. In the Computer 
Management window, the left (Tree) pane, expand Services and 
Applications, and then click Services.

b. In the right pane, scroll down to Simple Mail Transport Protocol (SMTP). 
Double-click the service to open the properties window. 

c. In the properties window: 

(1) On the General tab, set the Startup type to Automatic. 

(2) Click Apply. 

Note: You must install the required SNMP software before installing the 
required IBM Lotus Domino software in the next section. 

Note: If this service is already installed (the box is checked), click 
Cancel to close the wizard. 
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(3) Under Service status, click Start. 

(4) Wait for service to start, and then click OK to close this window.

d. Repeat Steps b and c to enable SNMP Trap Service if required (this 
service must be enabled only if you intend to use the Return trap 
acknowledgement type). 

10. When finished, close all open windows. 

11. After the required Windows services are installed and enabled, apply 
any Windows system updates, security patches, and hot fixes to the 
update the new services. Check with the Windows administrator for the 
appropriate software update procedures to use at this site. 

Preparing the MAS to support Domino

If either the Messaging Application Server or the Mailbox Monitor Server software 
component is to be installed on this MAS, you must install the appropriate IBM Lotus 
Domino software on the MAS to allow the Modular Messaging and Domino systems to 
communicate. To support clustering, use at least the 6.0.1 version of the Notes client 
with the latest critical fixes.  

Do the following on each MAS before you install the Modular Messaging software:

1. Install the Notes client on the MAS as a single-user installation (if the 
system prompts you for that selection). Reboot the system if prompted. 

2. Obtain a copy of the Lotus Notes ID file for this MAS account (such as 
C:\temp\masacct1.id) from the Domino administrator. See Item 8 on the 
"Modular Messaging MAS planning form" on page A-7. 

Note: You must install the Lotus Notes client only on any MAS that will 
have either the Messaging Application Server or the Mailbox 
Monitor Server Modular Messaging software component installed. 
(For example, the Tracing Server does not require the Notes client 
to be installed if it is the only Modular Messaging service on that 
machine.) See "MAS features list" on page A-11 to confirm if the 
Lotus Notes client must be installed on this particular MAS.

CAUTION: You must log in to the Modular Messaging service account 
(such as mmacct) before installing the Notes client software, 
so that the client software is set up for the correct account on 
the MAS. See Step 8 on page 6-7 for details if needed. 

!
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3. Copy the Lotus Notes ID file (such as masacct1.id) to the Notes data 
directory on this MAS. The default local path varies per Domino release 
as shown, but use the required path for this Domino installation:

! Release 5: C:\Lotus\Notes\Data

! Release 6: C:\Program Files\Lotus\Notes\Data 

4. Configure the Notes client to connect to the Domino server using this ID 
file as follows: 

a. Click Start > Programs > Lotus Applications > Lotus Notes. The first 
time you access this option, a wizard runs.

b. On the Lotus Notes Client Configuration wizard, choose the following 
options (click Next to proceed after each screen): 

(1) Choose Connect to Domino server. 

(2) For Connection type, select LAN. (Set up options and proxies 
appropriate for your network topology.) 

(3) For Domino Server Name, use the Domino hierarchical server 
name (such as domino1/zeppelin, where domino1 is the peer 
Domino server and zeppelin is the Domino domain). See Item 6 
on the "Modular Messaging MAS planning form" on page A-7. 

(4) Browse to the Lotus Notes ID file for this MAS (such as 
masacct1.id) in the Notes data directory. Select the ID file. 

(5) Enter the password used when the user of this MAS voice server 
was registered. See Item 7 on the "Modular Messaging MAS 
planning form" on page A-7. 

(6) Do not create an Internet account or a new server. 

(7) Specify replication settings and email sending options as follows: 

! In the Lotus Notes Client Configuration wizard, on the Additional 
Services screen, select Replication settings for sending and 
receiving mail. 

! On the Set Up Replication screen, clear the checkbox for Do not 
automatically send outgoing messages to server. 

! Set How many e-mail messages should collect in your outgoing 
mail box before Notes sends them? to a low number, such as 1. 

Note: This is not the default setting. You must clear this setting for the 
client software to work correctly. 
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(8) If prompted, select IBM Lotus Notes as the default messaging 
program. To specify the default messaging program manually: 

! Access the Internet Properties or Options page for your browser.

! On the Programs tab, for E-mail, select Lotus Notes. 

c. When done, click Finish and then OK. 

5. Close the Notes client before proceeding.

CAUTION: Do not set up Microsoft Outlook or Outlook Express on a 
Messaging Application Server (MAS). 

The Notes client installed on the MAS is for use by the MAS 
only. Using it for any other purpose could result in voice 
server exception errors.

Do not install any DUC software on an MAS voice server. 

!
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7
Installing and configuring the
Modular Messaging software

This chapter describes how to install the Modular Messaging software on an Avaya 
Messaging Application Server (Avaya MAS) or a customer-provided MAS.  

Topics in this chapter include: 

Note: Before you can successfully complete the tasks described in this 
section, you must have completed the system preparation tasks in 
Chapter 4, ��Preparing to install Modular Messaging software.�� 

All hardware installation must be complete and the MAS configured 
as described in Chapter 5, ��Configuring a new Avaya MAS,�� and 
Chapter 6, ��Configuring a customer-provided MAS.�� 

Section Page
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Overview

You must install and configure the Modular Messaging software as described in this 
chapter. The tasks described in this chapter apply to both an Avaya Messaging 
Application Server (Avaya MAS) and a customer-provided MAS. 

To successfully install and configure Modular Messaging software, the following must 
be complete:

! The forms in Appendix A, ��System planning forms,�� specifically:

� "Modular Messaging MAS planning form" on page A-7

� "Modular Messaging logon accounts form" on page A-10

� "MAS features list" on page A-11

! The appropriate prerequisite tasks, including:

� For an Avaya MAS, the tasks described in Chapter 5, ��Configuring a 
new Avaya MAS.�� 

� For a customer-provided MAS, the tasks described in Chapter 6, 
��Configuring a customer-provided MAS.�� 

Note: Installing the Modular Messaging software from a Microsoft 
Windows 2000 Terminal Services Client session is not supported. 
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Installing Modular Messaging software

You must install the required Modular Messaging software and configure each MAS as 
described in this section.  

Running the installation wizard

If you are continuing an installation from Chapter 5, ��Configuring a new Avaya MAS,�� 
the Modular Messaging Installation Wizard runs automatically. Continue with "Installing 
the Modular Messaging software" on page 7-4.

If you are configuring a customer-provided MAS, you must run the Modular Messaging 
Installation Wizard manually as follows:

1. Log in to the Modular Messaging service account, if you are not already 
logged in:

a. Click Start > Log off admin-account.

b. Click Yes when prompted to confirm the logoff. 

c. Press Ctrl+Alt+Del to log on.

d. In the Log On to Windows window, change the user name to the Modular 
Messaging service account name (such as mmacct). See Item A6 on the 
"Modular Messaging logon accounts form" on page A-10.

e. Enter the password for this account.

f. Using the drop-down box, change the Log in to: field to show the correct 
Windows domain, such as zodiac. See Item 2 on the "Modular Messaging 
MAS planning form" on page A-7. 

g. Press Enter or click OK.

2. Shut down system monitoring applications (such as Microsoft Windows 
2000 Service Control) and temporarily disable anti-virus software. 

Note: Completely install and test one MAS first, and let it run for 15 
minutes before installing any additional MASs. 

CAUTION: If anti-virus software is installed, Avaya recommends that 
you disable it before you install the Modular Messaging 
software to prevent possible negative interactions. Enable 
the virus-checking software again after the software 
installation is complete. The installation and configuration 
procedure takes from 15 to 30 minutes. 

!
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3. Insert the Avaya Modular Messaging Application Software disk in the 
MAS drive. 

4. Close the drive door and wait for the green LED to go out. Click OK. 

5. Run the Modular Messaging Installation Wizard as follows:

a. In Windows Explorer, navigate to the MAS drive (such as D:).

b. Navigate to the Install directory.

c. Double-click the file setup.exe.

The Modular Messaging Installation Wizard runs and searches for 
packages relevant to this configuration.

6. Click the Read Me button to review the Readme file for recent notices.

7. To change the default installation path (optional): 

a. Click the Change button.

b. Browse to an existing destination directory, or use the New Folder button to 
create a new directory for the installation. 

Installing the Modular Messaging software

Use the Modular Messaging Installation Wizard to install the appropriate Modular 
Messaging software components.

To install the Modular Messaging software:

1. Use the "MAS features list" on page A-11 to identify the software 
packages that must be installed on this particular MAS.

2. On the main screen, verify that the Configuration drop-down box shows 
Lotus Domino. 

3. In the components list, select the boxes for any messaging services you 
must install on this MAS. 

a. Required on every MAS: 

! Administration Tools

! Diagnostic Tools 

Note: For Avaya MAS systems: Do not insert the boot-image Avaya 
Modular Messaging OS Boot Software DVD! 

Note: You cannot define different installation paths for individual 
components. 
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b. Required on every MAS that will handle calls: 

! Messaging Application Server (includes the Alarming Server, 
which also installs the Event Monitor Server, Performance Monitor 
Server, and Process Monitor Server) 

! Prompt Files (at least one set is required on every MAS) 

c. Required on this MAS as specified by the customer: See "MAS features list" 
on page A-11 for the specific services you must put on this server. Click the 
appropriate checkboxes to select each service. Services include:

! Call Me Server (includes the Mailbox Monitor Server)

! Caller Applications Editor

! Language Packs 

! Message Waiting Indicator (MWI) Server (also includes the 
Mailbox Monitor Server)

! Tracing Server 

4. When all required services are selected, click Install.

5. Wizards run for all the Modular Messaging software packages you 
selected. Complete each wizard as directed. 

The following components install automatically (no response is needed): 

! Administration Tools (required) 

! Caller Applications Editor (optional on any machine) 

! Diagnostic Tools (required) 

! Language Packs (optional on any MAS) 

! Prompt Files (required). This step might take several minutes. 

6. The following components must be installed on every MAS that will 
handle calls:

! Alarming Server 

! Messaging Application Server 

The wizards for these components must be completed as follows: 

a. When one of the above server installation wizards runs, click Next.

Note: These software components are not required on an MAS that 
does not handle calls, such as a machine that has only the 
Caller Applications Editor or Tracing Server installed on it. 
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b. When prompted, enter the following account information:

! For Domain, enter the NetBIOS name of the Windows domain 
(such as zodiac). See Item 2 on the "Modular Messaging MAS 
planning form" on page A-7.

! For User Name and Password, enter the Modular Messaging 
service account name (such as mmacct) and its password. See 
Item A6 on the "Modular Messaging logon accounts form" on 
page A-10. 

! Click Next. 

c. Click Install.

d. To complete the wizard, click Finish.

7. The following software components can be installed on any MAS, but 
only once per voice mail domain (VMD):

! Mailbox Monitor Server (by default, this is installed first if the Call Me 
or MWI Server is selected) 

! Call Me Server 

! Message Waiting Indicator (MWI) Server 

! Tracing Server 

The wizards for these components must be completed as follows: 

a. When one of the above server installation wizards runs, click Next.

b. When prompted, enter the name of this MAS machine (such as zippy). See 
Item 1 on the "Modular Messaging MAS planning form" on page A-7. Click 
Next. 

c. When prompted, enter the password for the Modular Messaging service 
account (such as mmacct). See Item A6 on the "Modular Messaging logon 
accounts form" on page A-10. Click Next. 

d. For the Mailbox Monitor Server: You must provide Notes security 
information as follows:

(1) For Mailbox Monitor Lotus Notes ID, verify the path of the ID file 
on this MAS (such as C:\Lotus\Notes\Data\masacct1.id). See 
"Preparing the MAS to support Domino" on page 6-9 for details. 

(2) Enter the password for the Lotus Notes MAS account. See Item 7 
on the "Modular Messaging MAS planning form" on page A-7.

(3) Click Next. 

e. Click Install.

f. To complete the wizard, click Finish.
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8. For a system that uses CD-ROMs, you are prompted to insert additional 
disks to install the RealSpeak Text-to-Speech software in multiple 
languages. When prompted to insert installation disk 2: 

a. Remove the Avaya Modular Messaging Application Software and 
Languages CD from the drive. 

b. Insert the first Enhanced Email Reader (Text-to-Speech) RealSpeak 
software CD in the drive and close the door. 

c. Wait for the green LED on the drive to go out. Click OK. 

d. After the disk is copied, you are prompted to insert the next disk: 

! Insert the next RealSpeak TTS software CD in the drive.

! Repeat Steps b and d for each RealSpeak TTS software CD.

Allow several minutes for the RealSpeak software to install. When the 
installation is complete, the wizard returns to the main screen. 

9. To complete the installation, click Close.

10. When prompted, click Restart to restart the system now. 

11. Remove the media from the MAS drive. 
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Configuring the MAS

To configure Modular Messaging software on this MAS:

1. When the reboot is complete, press Ctrl+Alt+Del to log back in. Use the 
Modular Messaging service account (such as mmacct) and its 
password. See Item A6 on the "Modular Messaging logon accounts 
form" on page A-10.

The Messaging Application Server Configuration Wizard runs. 

2. For the Lotus Notes Security screen: 

a. Verify that the Lotus Notes ID file shows the correct path that the MAS 
needs to access the Domino server. If the path is missing or incorrect, click 
Browse to select the correct path. See "Preparing the MAS to support 
Domino" on page 6-9 for details. 

b. Enter the password for the Lotus Notes MAS account. See Item 7 on the 
"Modular Messaging MAS planning form" on page A-7. 

c. Click Next.

3. For the Peer Lotus Domino Server Selection screen: 

a. Verify that the Lotus Domino Server field shows the correct Domino 
hierarchical server name in coded form (where CN= the Windows NetBIOS 
name of the Domino server and O= its Domino domain name, such as 
CN=domino1/O=zeppelin). Depending on the system setup, a country code 
might also be present (such as C=US). 

If the Domino hierarchical server name is missing or incorrect, type 
the name or click Browse to select the correct Domino server (the 
name is forced to upper case). See Item 6 on the "Modular 
Messaging MAS planning form" on page A-7. 

b. Verify that the External Caller Mailbox field shows the correct path and file 
name the Domino mailbox file for this MAS (such as mail\zippy.nsf). If the 
name is missing or incorrect, type the correct name. See Item 9 on the 
"Modular Messaging MAS planning form" on page A-7. 

c. Click Next.

The Service configuration might take several minutes.

4. For the Peer Directory Servers Selection screen: 

a. Verify the Primary Directory Server information (this is typically the peer 
Domino server). See Item 3 on the "Modular Messaging MAS planning 
form" on page A-7.

Note: You must specify the complete path to the Notes ID file for this 
MAS. For example, C:\Lotus\Notes\Data\masacct1.id 
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(1) To change the Server Name, type the new name or click Browse 
to select the correct Domino server. The name must be entered in 
coded form and is forced to upper case. 

(2) To change the Database Name, type the path and name of the 
Domino directory database (for example, names.nsf). See Item 5 
on the "Modular Messaging MAS planning form" on page A-7.

b. If secondary Domino directory servers are required to support multiple 
domains, click New Server. Enter the name of the Domino server in the 
other domain. See Item 4 on the "Modular Messaging MAS planning form" 
on page A-7. 

c. Click Next.

The Service configuration might take several minutes.

5. For the Voice Mail Domain Selection screen:

a. Select a new or existing voice mail domain as follows:

! For MAS#1: Select the option First server in a new voice mail 
domain. 

! For a subsequent MAS: Select the option Subsequent server 
in an existing voice mail domain. 

b. Click Next. 

6. On the Voice Mail Domain Selection screen: 

a. Specify the voice main domain as follows:

! For MAS#1: Enter the unique voice mail domain name for this set 
of MAS machines (such as zebra). See Item 11 on the "Modular 
Messaging MAS planning form" on page A-7. 

! For a subsequent MAS: Verify that the existing voice mail 
domain name is displayed in the drop-down box (such as zebra). 

b. Click Next. 

The VMD configuration might take several minutes.

Note: The voice mail domain name is case sensitive. 

CAUTION: Do not select First server in a new voice mail domain 
unless this is the first MAS to be installed at this site. If you 
are doing an update or are restoring an MAS after a disk 
failure, you must join the existing VMD to avoid problems. 
See "Recovering from a catastrophic disk failure" on page 
E-1 for details. 

!
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7. For a subsequent MAS: An Offline Storage Location screen is displayed 
only if offline access is enabled in the voice mail domain and if an offline 
message store has not been selected. Browse to an existing, shared 
directory in the domain to set up the remote offline message store, used 
to synchronize messages in a multiple-MAS configuration. See Item 12 
on the "Modular Messaging MAS planning form" on page A-7. 

a. For Store Location, click Browse. 

b. In the Browse for Folder window, navigate to the specified directory. 

c. Select the folder and click OK. 

The name must appear in the format \\locationname\sharename 
(such as \\zorro\OfflineStore).

d. Click Next. 

8. For a subsequent MAS: The Caller Application screen is displayed if 
Caller Applications are deployed in the domain. 

a. Use the default setting for this step.

b. Click Next. 

9. On the User Information screen, click Next.

This step might take several minutes. 

10. On the Setup Complete screen, click Finish.

11. If you disabled the anti-virus software on this MAS, enable it again now.

CAUTION: If you are restoring an MAS following a disk failure, see 
"Restoring Caller Applications after a catastrophic disk 
failure" on page E-3 for instructions about this feature. 

!
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Setting up remote access

Remote access allows technical support personnel to dial into a system to correct 
problems and perform routine maintenance. Unless other arrangements have been 
made, use the following procedure to set up the MAS to take incoming service calls. 

To set up this MAS for remote access: 

1. Activate remote access service as follows:

a. Access the window to monitor services using one of these methods:

! Double-click the Monitor icon on the desktop (if present). In the 
left pane, click Services (Local) if it is not already selected. 

! Right-click My Computer and select Manage. In the Computer 
Management window, the left (Tree) pane, expand Services and 
Applications, and then click Services.

b. In the right pane, scroll down to Routing and Remote Access. 
Double-click it to open the properties window.

c. In the Routing and Remote Access Properties window: 

(1) On the General tab, set the Startup type to Automatic. 

(2) Click Apply. 

(3) Under Service status, click Start. 

(4) Wait for service to start, and then click OK to close this window.

d. Close the Monitor window.

2. Access Routing and Remote Access using one of these methods:

! Double-click the Configure icon on the desktop (if present).  

! Click Start > Programs > Administrative Tools > Routing and 
Remote Access.

Note: The modem for this MAS must already be installed and correctly 
configured. See the documentation included with the modem for 
details on modem setup and operation. 

Note: This icon has a .msc extension and is labeled Monitor.msc.

Note: This icon has a .msc extension and is labeled Configure.msc.
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3. Continue as follows:

! If you are setting up a customer-provided MAS, continue with Step 4.

! If you are setting up an Avaya MAS, continue with "Preparing an 
Avaya MAS for remote access" on page 7-13.

4. If you are setting up a customer-provided MAS, preconfigure routing and 
remote access properties as follows: 

a. In the left pane of the window, right-click Routing and Remote Access and 
select Add Server. 

b. In the Add Server window, select This computer. Click OK. 

c. In the left pane, expand Routing and Remote Access to see the new server 
name (such as ZIPPY). 

d. Right-click the server name and select Configure and Enable Routing 
and Remote Access.

(1) A wizard runs. On the Welcome screen, click Next.

(2) Select Remote Access Server and click Next. 

(3) Select TCP/IP yes and click Next. 

(4) Network selection is select the appropriate adaptor. Click Next. 

(5) Select from a specified range of addresses. Click Next. 

(6) On the Address Range Assignment screen, enter the range of 2 
static IP addresses provided by the customer. See Item 21 on the 
"Modular Messaging MAS planning form" on page A-7. 

(7) Click Next again.

(8) On the screen for managing multiple remote access servers, 
choose No to RADIUS. 

(9) Click Finish. 

The Routing and Remote Access service starts. 

5. Continue with "Completing remote access setup" on page 7-14. 
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Preparing an Avaya MAS for remote access

Do the following steps only on an Avaya MAS: 

1. To set up remote access properties for this Avaya MAS:

a. Expand Routing and Remote Access.

b. Expand the server name (such as ZIPPY).

2. Verify that remote access service (RAS) is running as follows:

a. If the server icon shows a green upward-pointing arrow, RAS is running. 
Continue with Step 3.

b. If the server icon shows a red symbol, activate RAS as follows:

(1) Right-click the server name, and select All Tasks > Start.

(2) If prompted to re-enable Routing and Remote Access, click Yes. 

3. Set up a static IP address pool as follows:

a. In the left pane, right-click the server name (such as ZIPPY) and select 
Properties.

b. In the local Properties window for the server, click the IP tab.

(1) Select Enable IP routing.

(2) Select Allow IP-based remote access and demand-dial 
connections. 

(3) Under IP address assignment, select Static address pool. 

(4) If the window shows an IP address range of 0000 to 0000, select 
the displayed range and click Edit. (If no address range is already 
entered, click Add.)

(5) In the New Address Range properties window, enter the range of 
two static IP addresses for this MAS. See Item 21 on the "Modular 
Messaging MAS planning form" on page A-7. 

(6) Verify that the number of addresses is 2.

(7) Click OK.

(8) For the Adapter field, select Local Area Connection 2 for the 
corporate LAN. 

Note: If Avaya is supporting this MAS, use the IP addresses that 
were generated by the Automatic Registration Tool (ART). 
Otherwise, use the IP addresses provided by the customer.



585-310-330, Issue 1

Avaya Modular Messaging for IBM Lotus Domino Release 1.1 Installation

7�14 May 2004

c. Click OK to close the properties window.

Completing remote access setup

Do the following steps on all MASs to set up the modem:

1. Set up inbound remote access to the modem as follows:

a. In the left pane, expand the server name (such as ZIPPY).

b. Right-click Ports and select Properties.

c. In the Ports Properties window, verify that the modem is highlighted, and 
then click Configure.

d. In the Configure Device - <model> window, verify that the checkbox is 
selected to activate Remote access connections (inbound only).

e. Click OK.

f. Click OK to close the Ports Properties window.

2. Verify the modem setup:

a. Click Ports in the left pane.

b. In the right pane, verify that there is an entry for the modem attached to this 
MAS, such as MultiTech ZBA-USB-V92. 

! If the modem entry is present, go to Step 3.

! If the modem entry is missing, continue as follows: 

(1) Verify that the modem is correctly installed. 

For an Avaya MAS, verify that the external modem is plugged into 
the recommended USB port (see "Connecting the USB modem 
on the MAS" on page 2-28).

(2) Click Start > Settings > Control Panel.

(3) Double-click Phone And Modem Options.

(4) The first time you select Phone and Modem Options, a wizard 
runs. 

! Complete the wizard by following the steps on each screen to 
configure the locale settings. 

! When finished, a new entry is displayed in the Locations box on the 
Dialing Rules tab.

(5) In the Phone And Modem Options window, click the Modems tab.
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(6) Verify that the modem is present and attached to a port (typically 
COM3 if you used the recommended USB port).

(7) If the modem is not present or attached to a port, you might need 
to remove the modem entry, and then reinstall the modem.

(8) When finished, click OK to close the Phone And Modem Options 
window.

(9) Close the Control Panel.

(10) Return to Step 2-a and verify that the modem is now present.

3. Close the Configure or the Routing and Remote Access window.
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8
Configuring and testing the port

boards

This chapter describes how to configure and test the Dialogic port boards on an MAS.  

Topics in this chapter include: 

Note: Before you can successfully complete the tasks described in this 
section, you must have successfully completed the tasks in 
Chapter 7, ��Installing and configuring the Modular Messaging 
software.�� 

If you are using an IIP H.323 integration, continue with Chapter 9, 
��Configuring the voice mail system.��

Section Page

Configuring the port boards 8-2

� Configuring analog port boards 8-3

� Configuring set emulation boards 8-5

� Configuring T1- or E1-QSIG boards 8-7

Testing the port boards 8-10
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Configuring the port boards

If Dialogic port boards are installed in this MAS, they must be configured and tested as 
described in this section. Port board administration involves three phases: 

1. The appropriate party must administer the switch for the port boards 
using the configuration notes for this particular PBX or switch 
integration. See "Information on the Web" on page 1-2 for instructions on 
obtaining the configuration notes.

2. Configure and test the port boards as described in this chapter. Some 
steps require you to use the configuration notes.

3. You will complete the port board administration for this MAS as directed 
in "Configuring the voice mail system" on page 9-2. 

Table 8-1 lists supported Dialogic port boards and their associated documents (copies 
of the PDF files are on the Avaya Modular Messaging Documentation CD and the 
application software disk). The type of port boards can vary on different MASs in the 
system, although each MAS can have only one type of board installed in it.

CAUTION: You can only install this system by using the required 
configuration notes for this switch or PBX. The PBX 
administrator must have administered the ports on the 
switch before you can proceed.

!

Table 8-1. Supported MAS port boards 

Protocol Ports Port boards Max # Dialogic files on documentation CD

Analog 4 - 8

12 - 48

Dialogic 4-port T/R board

Dialogic 12-port T/R board

2

4

D/41JCT-LS (PDF 133K)

D/120JCT-LS (PDF 131K)

Digital Set 
Emulation

8 - 40
or
8 - 48

Dialogic D/82JCT-U-PCI-UNIV

Dialogic D/82JCT-U

5 - Avaya 
MAS or 
6 - other 
MAS

D/82JCT-U PCI Univ (PDF 234K)

D/82JCT-U (PDF 240K) 
supported for updates only 

T1-QSIG 23 - 69 Dialogic D/480JCT-2T1 

Dialogic D/240JCT-T1

3 DualSpan JCT boards (PDF 104K)

Span JCT boards (PDF 99K) 
supported for updates only 

E1-QSIG 30 - 60 Dialogic D/600JCT-2E1 

Dialogic D/300JCT-E1-120

2 DualSpan JCT boards (PDF 104K)

Span JCT boards (PDF 99K) 
supported for updates only
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Continue based on the type of port boards installed in this MAS:

! "Configuring analog port boards" on page 8-3

! "Configuring set emulation boards" on page 8-5

! "Configuring T1- or E1-QSIG boards" on page 8-7

Configuring analog port boards 

The following analog port boards can be installed in an MAS: 

! Dialogic 4-port Tip/Ring board (up to 2 per MAS). See the D/41JCT-LS 
PDF file on the documentation media for details.

! Dialogic 12-port Tip/Ring board (up to 4 per MAS). See the 
D/120JCT-LS PDF file on the documentation media for details.

To configure either of these analog boards:

1. Click Start > Programs > Intel Dialogic System Software > 
Configuration Manager - DCM.

The Intel Dialogic Configuration Manager window is displayed.

2. In the Computer Name pop-up window, verify that Local is selected and 
that the correct server name is shown, such as ZIPPY.

3. Click Connect. 

The Dialogic software locates any installed port boards.

4. Under Configured Devices, double-click the name of the first Dialogic 
board shown (such as #0). 

5. In the Dialogic Configuration Manager Properties window:

a. Click the Files tab.

b. Select the TSFFileName parameter (if it is not already selected).  

Note: If you are using a D/41JCT-LS card, you must highlight the 
�Configured Devices� parameter on the DCM display when 
selecting Configure Device. This is necessary to be able to 
view the TSFFilename parameter.

CAUTION: If you cannot find a suitable TSF file for this PBX, you must 
build an appropriate tone file now or the integration will not 
work. Click Cancel in this window, and then see Appendix C, 
��Creating a new tone file.��

!
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c. Locate the prerecorded TSF file for this PBX or switch:

(1) Click the ... button to browse, and then navigate to the 
C:\Avaya_Support\Tone_Files directory. 

(2) In the Search File window, select a TSF file that is appropriate for 
the PBX to which you are connecting (for example, 
Avaya-G3-US.tsf). Double-click the file name. 

The appropriate TSF file is inserted in the Value field.

(3) After an appropriate TSF file is selected, click the Misc tab. 

a. Click the TSFFileSupport parameter. 

b. From the Value drop-down list, select Yes. 

c. Click the DisconnectTone parameter.

d. From the Value drop-down list, select Yes.

e. Click OK to close the properties window.

6. Repeat Steps 4 and 5 for any other installed Dialogic boards (such as 
#1). 

7. When all boards are configured, click the green Start Service button on 
the button bar.

Wait for service to start. When service is started, the Stop Service 
button becomes active and the installed boards show a green light. See 
Figure 8-1 on page 8-5 for an example. 

8. Close the Intel Dialogic Configuration Manager window.

9. Continue with "Testing the port boards" on page 8-10.

Note: You must have selected an appropriate TSF file for this PBX or 
switch before you set the TSFFileSupport parameter to Yes, or 
errors might occur.
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Configuring set emulation boards 

Up to five 8-port Dialogic Digital Set Emulation (DSE) boards can be installed in an 
Avaya MAS, or up to six DSE boards can be installed in a customer-provided MAS. 
See the D/82JCT-U or D/82JCT-U PCI Univ PDF file on the documentation media for 
more information. 

To configure digital set emulation boards:

1. Click Start > Programs > Intel Dialogic System Software > 
Configuration Manager - DCM.

The Intel Dialogic Configuration Manager window is displayed.

2. In the Computer Name pop-up window, verify that Local is selected and 
that the correct server name is shown, such as ZIPPY.

3. Click Connect.

The Dialogic software locates any installed port boards. See Figure 8-2 
on page 8-6 for an example.

Figure 8-1. Sample Dialogic Configuration Manager analog window - service started

Note: The D/82JCT-U board is supported for updates only. 
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4. Under Configured Devices, double-click the name of the first Dialogic 
board shown (such as #0). 

5. In the Dialogic Configuration Manager Properties window:

a. Click the Telephony Bus tab and select the PCMEncoding parameter.

b. On the pull-down list of values, select either A-Law or µ-Law, depending on 
your location. Typically, A-Law is Europe and µ-Law is United States.

c. Click the Misc tab and select the PBXSwitch parameter.

d. On the pull-down list of values, select the name of the PBX (for example, 
use Lucent 2-wire for an Avaya G3 switch).

e. Click the Country tab and select the Country parameter.

f. On the pull-down list of values, select the country.

g. Click OK to close the Dialogic Configuration Manager Properties window.

6. Repeat Steps 4 and 5 for any other installed Dialogic boards (such as 
#1).

Figure 8-2. Sample Dialogic Configuration Manager DSE window - service not started

CAUTION: If the DSE boards are connected to a Nortel (NTM-1) PBX, 
you must reboot the MAS before starting the Dialogic 
drivers. Close the DCM and reboot the system now. When 
the reboot is complete, log back in and reopen the DCM (see 
Step 1), and then continue with Step 7.

!
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7. When all boards are configured, click the green Start Service button on 
the button bar.

Wait for service to start. When service is started, the Stop Service 
button becomes active and the installed boards show a green light. 

8. Verify that the boards are operating correctly. 

a. Check the LED display on the Dialogic board faceplate. It flashes a code for 
each port consecutively as follows:

! Ports that are connected to a phone line and functioning correctly 
show 0 and the port number (such as 00 or 01).

! Ports that are not connected to a phone line or not functioning 
correctly show En, where n is the port number. For example, the 
display reads E3 if there is an error on port 3.

b. If any errors (En codes) are present, check the board configuration, the 
physical connections between the board and the PBX, or the PBX 
configuration itself. (For example, verify that you have configured the 
correct PBX). Repeat Steps 4 through 8 as needed.

9. Close the Intel Dialogic Configuration Manager window.

10. Continue with "Testing the port boards" on page 8-10.

Configuring T1- or E1-QSIG boards 

Either of the following QSIG port boards can be installed in the MAS. See the 
DualSpan JCT boards PDF file on the documentation media for more information. 

! Dialogic D/480JCT-2T1 board (up to 3 boards per MAS)

! Dialogic D/600JCT-2E1 board (up to 2 boards per MAS) 

To configure either T1-QSIG or E1-QISG boards:

1. Click Start > Programs > Intel Dialogic System Software > 
Configuration Manager - DCM.

The Intel Dialogic Configuration Manager window is displayed.

2. In the Computer Name pop-up window, verify that Local is selected and 
that the correct server name is shown, such as ZIPPY.

3. Click Connect. 

The Dialogic software locates any installed port boards. 

Note: The single-span version of these boards (D/240JCT-T1 and 
D/300JCT-E1-120) is supported for updates only. 
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4. Under Configured Devices, double-click the name of the first Dialogic 
board shown (such as #0). 

5. In the Dialogic Configuration Manager Properties window:

a. Click the Interface tab and select the ISDNProtocol parameter.

b. Select the correct value for this board from the pull-down list:

! For E1-QSIG: select QTE

! For T1-QSIG: select QTU

c. Click the Telephony Bus tab and select the PCMEncoding parameter.

d. Select the correct value for the installed board from the pull-down list:

! For E1-QSIG: select A-Law 

! For T1-QSIG: select µ-Law 

e. Click the Misc tab. For the FirmwareFile parameter, verify that default is 
displayed.

f. Click the Country tab and select the Country parameter.

g. On the pull-down list of values, always use United States for either type of 
board. 

h. Click OK to close the properties window.

6. Repeat Steps 4 and 5 for any other installed Dialogic boards (such as 
#1).

7. When all boards are configured, click the green Start Service button on 
the button bar.

Wait for service to start. When service is started, the Stop Service 
button becomes active and the installed boards show a green light. See 
Figure 8-3 on page 8-9 for an example. 

8. Verify that the boards are operating correctly. 

a. Check the LED display on the Dialogic board faceplate. 

! A red status LED lights on the back of the voice card during driver 
start-up.

! If the drivers start successfully, the LED of the board whose port is 
connected to the PBX is replaced by a green LED within 30 
seconds. LEDs on the other boards remain red.

b. If a problem occurs, check the board configuration, the physical 
connections between the board and the PBX, or the PBX configuration 
itself. Repeat Steps 4 through 8 as needed. 
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9. Close the Intel Dialogic Configuration Manager window.

10. Continue with "Testing the port boards" on page 8-10.

Figure 8-3. Sample Dialogic Configuration Manager QSIG window - service started
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Testing the port boards 

Test all port boards and channels to verify that they can send and receive calls. 

Preparing for the test

Prepare for port board testing as follows: 

1. Stop Modular Messaging service as follows:

a. Access the window to monitor services using one of these methods:

! Double-click the Monitor icon on the desktop (if present). In the 
left pane, click Services if it is not already selected. 

! Right-click My Computer and select Manage. In the Computer 
Management window, the left (Tree) pane, expand Services and 
Applications, and then click Services.

b. In the right pane, scroll down to MM Messaging Application Server.

c. Right-click MM Messaging Application Server and select Stop.

2. For Unified Messenger updates, the Dialogic Line Tester program is 
not yet installed. Access the test program on disk as follows: 

a. Insert the Avaya Modular Messaging Application Software disk into the 
MAS drive. 

b. Close the drive door and wait for the green LED to go out. Click OK. 

c. In Windows Explorer, navigate to the MAS drive (such as D:).

d. Navigate to the Install directory, and then to the DLTest subdirectory. 

e. Double-click the file DLTest.exe.

The Dialogic Line Test Application runs.

3. For T1-QSIG or E1-QISG boards, set up the test options as follows: 

a. Click Start > Programs > Avaya Modular Messaging > Dialogic Line 
Tester (or access the program from the applications disk as described in 
Step 2). 

b. In the Dialogic Line Test Application window, click Tools > Options.

c. In the Options window, select the correct values for each field. Use the 
configuration notes to identify the correct values: 

! For Layer 1 Protocol, select the required ISDN protocol from the 
drop-down list.

Note: The values you select here must be the same as those entered 
on the PBX or switch. Check the configuration notes.
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! For Number Type, select the destination number type.

! For Number Plan, select the destination number plan. 

Testing the ports

To test Dialogic port board functionality: 

1. Access the Dialogic Line Test application using one of the following 
methods:

! Click Start > Programs > Avaya Modular Messaging > Dialogic 
Line Tester.

! For Unified Messenger updates, access the DLTest program from 
the applications software disk described in Step 2 on page 8-10. 

The Dialogic Analog - Line Test Application (or DLTest) window is 
displayed. The name of the window varies, depending on the type of port 
boards installed. 

2. Verify that all port numbers and channel designations are listed. See 
Figure 8-4 for an example. 

3. Test the incoming call connectivity of all ports as follows:

a. From a handset on the same PBX, dial each port individually.

! For analog and set emulation boards, use the individual port 
extensions from "Required switch and messaging information" on 
page A-14.

Figure 8-4. Sample Dialogic Analog - Line Test Application window
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! For QSIG cards, repeatedly dial the number for that group of 
ports. The switch connects to the next port in the list each time 
you dial.

b. Check the Status column. Verify that each port shows �Received call� 
followed by �Connected.� See Table 8-2 for different status conditions.

The system should answer each connected call with a standard 
welcome message. 

4. Test the outcalling capability of all ports as follows: 

a. Select a Port in the Dialogic Line Test Application window.

b. Type the number of an extension on this PBX in the Dial Number field.

c. Click Dial Number.

d. When the dialed extension rings, answer the call and hang up.

e. Select the next port number, and click Dial Number again. 

f. Repeat Steps d and e until all ports have been tested.

5. When finished, close the test application window.

6. If a problem occurs, check the board configuration, the physical 
connections between the board and the PBX, or the PBX configuration 
itself. For example, verify that you have configured the correct PBX and 
administered it according to the appropriate configuration notes.

Table 8-2. DL Test status messages 

Status Description Highlight

Channel starting� The channel is being started. Normal

Channels idle� The channel is idle. Normal

Waiting for call� The channel is waiting for an incoming call. Normal

Received call� An incoming call is being processed. Normal

Dialling number� A number is being dialed to make an outgoing call. Normal

Resetting� The user reset the channel. Normal

Line Busy. An outgoing call was made, but a busy tone was detected. Normal

No Answer. An outgoing call was made, but the call was not answered. Normal

Connected. An incoming or outgoing call was answered, so the call is now connected. Normal

Call was disconnected. An incoming or outgoing call was disconnected. Normal

Error. A general error with the channel occurred. Error

Error, No Dial tone 
detected.

An outgoing call was made, but no dial tone was detected before dialing. Error
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Configuring the voice mail system

This chapter describes how to configure the basic Voice Mail System Configuration 
(VMSC) parameters and complete initial Modular Messaging software administration.  

Topics in this chapter include: 

Note: Before you can successfully complete the tasks described in this 
section, you must have successfully completed the tasks in 
Chapter 7, ��Installing and configuring the Modular Messaging 
software,�� and (if port boards are installed) the tasks in Chapter 8, 
��Configuring and testing the port boards.�� 
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Overview

You are now ready to configure the basic Voice Mail System Configuration (VMSC) 
parameters and complete initial Modular Messaging software administration. 

To successfully complete this task, you need:

! A completed copy of the forms in Appendix A, ��System planning forms,�� 
specifically:

� "Modular Messaging MAS planning form" on page A-7

� "Modular Messaging logon accounts form" on page A-10 

� "MAS features list" on page A-11

� "Modular Messaging R1.1 license request - IBM Lotus Domino 
system" on page A-13

� "Required switch and messaging information" on page A-14

� "Support information" on page A-15

! The configuration notes for this PBX or switch. See "Required 
documentation" on page 1-2 for instructions on how to obtain these. 

Configuring the voice mail system 

Voice mail system configuration falls into three areas:

1. Domain-wide administration, some of which must be done on MAS#1 
only (such as initial PBX setup) 

2. Administration of domain-wide features that can be installed on any 
MAS, such as Call Me or Message Waiting Indicator 

3. Port board and feature configuration specific to each MAS 
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This section guides you through the administration of key parameters that are required 
to get a new system operational.  

 

Configuring domain-wide features

This section describes the administration of domain-wide features as follows:

! Required features that must be administered for every Modular 
Messaging system are marked On MAS#1 in this guide. This is to 
ensure the configuration of all required system elements. (Note that, 
except for initial PBX administration, most domain-wide features can be 
administered on any MAS.) 

! Some domain-wide features are optional and can be installed on any 
MAS, including the first one (such as the Call Me and Message Waiting 
Indicator Servers). Use the "MAS features list" on page A-11 to 
determine what features should be configured on a given MAS.

To configure the voice mail system:

1. If you installed multiple languages, specify the preferred language for 
this MAS:

a. Click Start > Programs > Avaya Modular Messaging > Languages.

b. In the Modular Messaging User Properties window, select the Preferred 
language from the drop-down list.

c. Click OK. 

Note: This section is intended to get a Modular Messaging system up 
and running with the basic required features. Customers are 
encouraged to tailor the Voice Mail System Configuration (VMSC) 
parameters for their site after a successful installation using the 
Avaya Modular Messaging Software Messaging Application Server 
Administration Guide (PDF 3 MB), located on the documentation 
media shipped with the system. 

CAUTION: The procedures in this section can only be completed by 
using the required configuration notes for this PBX or switch. 
See "Required documentation" on page 1-2 for instructions 
on obtaining the configuration notes.

!
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2. Verify that Modular Messaging service is started as follows: 

a. Access the window to monitor services using one of these methods:

! Double-click the Monitor icon on the desktop (if present). In the 
left pane, click Services (Local) if it is not already selected. 

! Right-click My Computer and select Manage. In the Computer 
Management window, the left (Tree) pane, expand Services and 
Applications, and then click Services.

b. In the right pane, scroll down to MM Messaging Application Server.

c. Check the Status column.

(1) If the status is Started, continue with Step 3.

(2) If service is not started, right-click MM Messaging Application 
Server and select Start.

The system begins a messaging service startup. 

d. Track the startup progress as follows:

(1) Access the event viewer using one of these methods:

! In the Monitor window, in the left pane, expand Event Viewer 
(Local). 

! In the Computer Management window, in the left pane, expand 
System Tools, and then Event Viewer. 

(2) In the left (Tree) pane, click Application. 

(3) Refresh the window display periodically until you see Telephony 
User Interface event 1241, �TUI service has been enabled.� You 
can then proceed.

e. Minimize this window. You will use it later. 

3. Click Start > Programs > Avaya Modular Messaging > Voice Mail 
System Configuration. 

The Voice Mail System Configuration window is displayed. All MASs 
present in the messaging system are listed.

Note: This icon has a .msc extension and is labeled Monitor.msc.

Note: When you restart messaging service, the window 
immediately shows a status of Started. However, service 
might actually take several minutes to start, depending on 
the number of port boards installed and the integration 
method. 
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4. On MAS#1: Double-click Telephone User Interface.

a. On the General tab, set Number of Digits in a Mailbox to match the 
number of digits in the extension numbers on the customer PBX. See 
"Required switch and messaging information" on page A-14. 

b. Click the Subscriber tab. Verify that Login Failures before Mailbox 
Lockout is 18.

c. Click OK to close this window.

5. To set up Call Me service: Do this step if the optional Call Me Server is 
installed on any MAS. See "MAS features list" on page A-11.

a. Double-click Call Me.

b. In the Call Me - Voice Mail Domain window, on the General tab, click the 
checkbox to Enable Call Me.

c. For Call Me server, specify the MAS on which the Call Me software is 
installed (such as ZIPPY). If this field is blank:

(1) Click the ... button next to the field.

(2) In the Select Computer window, double-click the name of the MAS 
that has Call Me installed (such as ZIPPY).

(3) Click OK to close this window.

6. To set up MWI service: Do this step if the optional Message Waiting 
Indicator Server is installed on any MAS. See "MAS features list" on 
page A-11.

a. Double-click Message Waiting Indicator.

Note: Do the steps in this section under the voice mail domain, not 
for a specific MAS (under Message Application Servers). If 
this site has multiple voice mail domains, verify that you are 
accessing and administering the correct one. 

Although the system prompts you to restart service several 
times during this procedure, you actually must restart service 
only before entering the port board extension numbers in 
"Configuring MAS-specific parameters" on page 9-12, and at 
the end, when configuration is complete.

Note: After you click the next tab, the system notifies you that the 
extension number changes will invalidate all previous 
mailboxes. Click Yes to continue. 
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b. In the Message Waiting Indicator - Voice Mail Domain window, on the 
General tab, click the checkbox to Enable Message Waiting Indicator 
(MWI).

c. For MAS MWI server, specify the MAS on which the MWI software is 
installed (such as ZIPPY). If this field is blank:

(1) Click the ... button next to the field.

(2) In the Select Computer window, double-click the name of the MAS 
that has MWI installed (such as ZIPPY).

d. In the Messaging Application Servers that support MWI list box, list all 
MAS servers that support MWI. To add a server:

(1) Double-click inside the top of the big list box, or click the Add 
(dashed-box) button just above the list box.

(2) A data entry field and ... button appear in the list box. Click the ... 
button.

(3) In the Select Computer window, double-click the name of each 
MAS that supports MWI (such as ZIPPY and ZORRO).

(4) Click OK. 

e. Click OK to close this window.

7. On MAS#1: Set up access permissions to allow authorized users to 
administer the Modular Messaging system or subscribers on the 
directory server. 

a. In the Voice Mail System Configuration window, expand Security. 

b. Double-click System Administration.

(1) In the Permissions for System Administration window, verify that 
the Modular Messaging service account (such as mmacct) is 
listed. If this entry is missing, or to include additional required 
users, click Add. 

(2) In the Select Users, Computers, or Groups window, add the 
appropriate users or groups who require system administration 
permissions (for example, the technical support remote access 
account such as craft). See Item 23 on the "Modular Messaging 
MAS planning form" on page A-7. Double-click the required entry, 
and then click OK. 

Note: The customer might have predefined groups that include users 
who are authorized to perform system or subscriber 
administration. Check with the appropriate system 
administrator for the correct entries to make here. 



May 2004

Configuring the voice mail system

9�7585-310-330, Issue 1

(3) Click OK to close this window.

c. Double-click Subscriber Administration.

(1) In the Permissions for Subscriber Administration window, click 
Add to add the Windows accounts for users who will administer 
subscribers. These user accounts must also be a member of a 
Domino access control list (ACL) and assigned administration 
rights as described in "Setting up Domino to support Modular 
Messaging" on page 4-3.  

(2) In the Select Users, Computers, or Groups window:

! Add the Modular Messaging service account (such as mmacct). 
Double-click it (or click Add), and then click OK.

! Add any additional customer-specified users or groups required to 
administer Domino users and extensions. See Item 23 on the 
"Modular Messaging MAS planning form" on page A-7. Double-click 
the required entry, and then click OK. 

(3) Click OK to close this window.

8. On MAS#1: If multiple languages or the optional Text-to-Speech feature 
are used at this site, double-click Languages. Do the following in the 
Languages - Voice Mail Domain window:

a. For Primary Language, select the primary prompt set that is to be used at 
this site. See "MAS features list" on page A-11. 

b. If the optional Text-to-Speech (TTS) feature is used at this site: 

(1) Click the checkbox to Enable Multilingual Text to Speech. 

(2) In the list box, select all the languages to use for TTS at this site. 
See "MAS features list" on page A-11.

c. Click OK to close this window.

9. To set up the optional offline access feature: Do this step on any MAS. 

a. Double-click Messaging.

b. In the Messaging - Voice Mail Domain window, click the Offline Access 
tab.

c. Click the checkbox to Enable offline access to messages.

Note: The default Subscriber Administration access control list is 
empty. To allow administration of subscribers, at least one 
account or group must be added to the list. 
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d. If multiple MASs are installed, click the checkbox to Synchronize offline 
messages with remote store. Click Browse to select an existing, shared 
directory in the domain for the remote offline message store. See Item 12 
on the "Modular Messaging MAS planning form" on page A-7. 

e. Alter any other parameters in this window as needed. See the Avaya 
Modular Messaging Software Messaging Application Server Administration 
Guide (PDF 3 MB) on the documentation media for details. 

f. When finished, click OK to close this window.

10. On MAS#1: Double-click Serviceability. Enter the following in the 
Serviceability - Voice Mail Domain window:

a. On the General tab, select the type of alarming to be used on this voice 
mail domain for the Modular Messaging system: INADS, SNMP, or none. 

b. If alarming is activated, enter the unique product ID for this system. See 
"Support information" on page A-15 for this number. 

c. Unless directed otherwise, you can accept the default values for the 
following parameters: 

! The conditions for sending an alarm notification

! The alarm level at which notification will be sent (minor or major)

! The system behavior for stopping Modular Messaging service

d. If you selected SNMP alarming, click the SNMP tab. See "SNMP alarming 
information" on page A-15 to enter the required values. 

! For Network Management Station, specify the corporate 
network management system (NMS) that will monitor the Modular 
Messaging system for alarm notifications (traps). Either type the 
IP address or fully qualified domain name for the NMS in the field, 
or click Browse to navigate to and select the appropriate NMS.

!  For Context (community), enter the name of the context or 
community to which the NMS belongs (such as public).

!  For Acknowledgement type, select either Return trap (to have 
traps actively acknowledged) or Ping surround (to send a ping to 
the NMS before and after sending a trap to assume trap receipt). 

If you select Return trap acknowledgement:

(1) Return to the Monitor or the Computer Management window to 
see the list of Windows services (the window might already be 
open or minimized). See Step 2-a for instructions, if needed. 

Note: A modem must be present to select INADS alarming.
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(2) In the right pane, scroll down to SNMP Trap Service. Double-click 
it to open the properties window. 

(3) On the General tab, set the Startup type to Automatic. 

(4) Click Apply. 

(5) Under Service status, click Start. 

(6) Wait for service to start, and then click OK to close this window.

(7) Minimize the Monitor or the Computer Management window for 
later use. 

e. Click OK to close the Serviceability - Voice Mail Domain window.

11. On MAS#1: Obtain and install a license for this system. 

Obtain a license using one of these methods:

! If remote technical support will be used for this system: 

a. Place a licensing support call to the appropriate remote support center. 
Provide the required information for "Modular Messaging R1.1 license 
request - IBM Lotus Domino system" on page A-13. Be sure to include the 
complete dial-in information needed for the MAS. 

! For new systems, the remote support center will provide some of 
the information needed to generate a license, including the 
information in Items L1 through L3 for "Modular Messaging R1.1 
license request - IBM Lotus Domino system" on page A-13. 

! If an update is specified for Item L4, the on-site installer must 
provide the required information. See Appendix F, ��Obtaining a 
license for an update,�� for this procedure. 

b. Continue the installation while the remote support center generates a valid 
license for this system. When ready, the remote support center will install 
the license file using remote access. 

c. After you are notified that the license file is installed, do the steps in 
"Verifying license installation and specifying TTS sessions" on page 9-11. 

Note: If SNMP Trap Service is not present, it must be installed. See 
"Installing Windows prerequisite software" on page 6-8 for 
procedures for installing Windows service components. 

Note: The procedure for obtaining a license file varies. See the 
www.avaya.com/support Web site for the latest information. 
For licensing questions, contact your remote support center 
(see "Sending the license request" on page F-9). 

http://www.avaya.com/support
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! If remote technical support will not be used for this system: 

a. Provide all the required information for "Modular Messaging R1.1 license 
request - IBM Lotus Domino system" on page A-13. To obtain the VMD ID: 

(1) In the Voice Mail System Configuration window, right-click 
Licensing and select Copy Host ID to clipboard. 

This is the unique ID for this voice mail domain (VMD ID) that 
identifies this particular system. 

(2) Open the document where you want to record this information (for 
example, the editable Word version of the "Modular Messaging 
R1.1 license request - IBM Lotus Domino system" on page A-13). 
Alternatively, you can open a text-editor application (such as 
Notepad) to capture this data. 

(3) Right-click and select Paste to copy the VMD ID from the 
clipboard to the appropriate place in the document. See Item L1 
on "Modular Messaging R1.1 license request - IBM Lotus Domino 
system" on page A-13. 

(4) Include in the file the information for Items L2 through L4 on 
"Modular Messaging R1.1 license request - IBM Lotus Domino 
system" on page A-13.

For updates, see "Obtaining license data for an update" on page 
F-4 for this procedure. 

(5) Complete the rest of the form as required. When finished, Save 
the file. 

b. If needed, transmit the file to an email-accessible location. Send the license 
request by email to the appropriate license generation address, such as 
osg@avaya.com. See "Sending the license request" on page F-9 for 
requirements for sending license requests in various regions. 

c. Continue the installation while the remote support center generates a valid 
license and returns a license file for this system through email. 

d. After the license file is obtained, install the license as follows: 

(1) Transmit the license file (such as wlmNNNNNlicense.xml) to the 
MAS using the customer method of choice (FTP, memory stick, 
and so on). The recommended location for the license file is on 
MAS#1 in the C:\Avaya_Support directory. 

CAUTION: Use the copy-and-paste method of recording the VMD ID if 
possible. If you try to manually enter the VMD ID, it is easy to 
make mistakes. The VMD ID in the generated license must 
exactly match that of the target system or it will fail to install. 

!
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(2) To install the license, in the Voice Mail System Configuration 
window, right-click Licensing and select Import License. 

(3) On the License Import Wizard welcome screen, click Next.

(4) On the Importing the License screen, click Browse. 

(5) Navigate to the location where the license file is stored (such as 
C:\Avaya_Support). 

(6) Double-click the appropriate *.xml license file. (If more than one 
file is present, verify that you select the correct one.) 

(7) Click Next to install the license.

(8) When the procedure is complete, click Finish. 

e. Continue with "Verifying license installation and specifying TTS sessions" 
below. 

Verifying license installation and specifying TTS sessions

After the license file is installed, verify the license installation, and then 
set up the TTS sessions per MAS as follows: 

a. In the Voice Mail System Configuration window, double-click Licensing.

b. In the Licensing - Voice Mail Domain properties window, on the General 
tab, verify that the correct values for this customer are displayed.

c. Click the Text-to-Speech tab. Every MAS in the voice mail domain is listed. 

(1) For each MAS, double-click the TTS link, such as Text to speech, 
ScanSoft RealSpeak, Any Language. 

(2) In the Edit Sessions window, enter the number of TTS sessions 
required for this MAS (for example, 2 sessions per MAS). See 
"MAS features list" on page A-11. 

(3) When finished, click OK. 

d. Click OK again to close the Licensing properties window.

12. On MAS#1: Set up PBX service for the system.

a. In the Voice Mail System Configuration window, right-click PBXs and select 
Add New PBX Type.

b. For Telephony Type, select the type of port board that is installed in this 
MAS (such as Dialogic Analog).

Note: If this site has multiple voice mail domains, verify that you are 
accessing the correct one, or the license file will not work. 
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c. In the PBXs scroll box, select the type of switch integration that you have 
(such as Dialogic Avaya G3 CLAN).

d. Click OK to close this window.

e. In the Voice Mail System Configuration window, expand PBXs.

f. Double-click the PBX entry you just added.

g. Using the configuration notes for this PBX or switch, set up the specific PBX 
parameters required for this integration of the system. 

Configuring MAS-specific parameters

After the domain-wide parameters have been configured, set up the port boards and 
features specific to this MAS. 

To specify MAS-specific parameters: 

1. In the Voice Mail System Configuration window, expand Message 
Application Servers. See Item 1 on the "Modular Messaging MAS 
planning form" on page A-7 for MAS names. 

a. For MAS#1: The first time you access this item, a Telephony Configuration 
Wizard helps you set up the basic PBX integration details for all MASs in 
this domain. Complete the wizard as prompted. 

b. For a subsequent MAS: Right-click the server name (such as ZORRO), 
and then select Telephony Configuration Wizard to run the wizard. 
Complete all steps in the wizard, as prompted. 

2. After you complete the wizard, you must restart service so that you can 
configure the voice ports: 

a. Access the window to monitor services using one of these methods:

! Double-click the Monitor icon on the desktop (if present). In the 
left pane, click Services if it is not already selected.

! Right-click My Computer and select Manage. In the Computer 
Management window, the left (Tree) pane, expand Services and 
Applications, and then click Services.

Note: Although the configuration notes for this PBX or switch might 
include some of these steps, read through this section first to get 
an overview of the whole configuration procedure.

Note: If the wizard does not start automatically, right-click the server 
name (such as ZIPPY), and then select Telephony 
Configuration Wizard.
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b. In the right pane, scroll down to MM Messaging Application Server. 
Right-click it and select Stop. 

c. When service is stopped, right-click MM Messaging Application Server 
again and select Start.

The system begins a messaging service startup. 

d. Track the startup progress as follows:

(1) Access the event viewer using one of these methods:

! In the Monitor window, in the left pane, expand Event Viewer 
(Local). 

! In the Computer Management window, in the left pane, expand 
System Tools, and then Event Viewer. 

(2) In the left (Tree) pane, click Application. 

(3) Refresh the window display periodically until you see Telephony 
User Interface event 1241, �TUI service has been enabled.� You 
can then proceed.

e. When service is restarted, minimize this window.

3. In the Voice Mail System Configuration window, expand Message 
Application Servers. 

a. Expand the entry for the server name (such as ZIPPY). 

b. Double-click Telephony Interface. Configure the port boards in this MAS. 
Use the configuration notes. See "Required switch and messaging 
information" on page A-14 for port board extensions.

c. Double-click PBX Type. Select the same type of PBX service as you did in 
Step 12 for "Configuring domain-wide features" on page 9-3. Verify that the 
entry in the PBXs box is highlighted, and click OK. 

d. Double-click PBX Integration and configure the integration type for this 
system. Use the configuration notes to specify or confirm the detailed 
settings required by this switch integration.  

Note: When you restart messaging service, the window immediately 
shows a status of Started. However, service might actually take 
several minutes to start, depending on the number of port 
boards installed and the integration type.

Note: Some values might already be set. Follow the configuration 
notes for this PBX integration.

Note: To set the maximum number of MWI sessions allowed at one 
time, see "MAS features list" on page A-11.
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e. If multiple port groups are used (for example, to support MWI), double-click 
Port Groups. See "Required switch and messaging information" on page 
A-14 for details. 

f. If INADS alarming is used, double-click Serviceability to set up dial-out 
information for this MAS. See "INADS alarming information" on page A-15. 

(1) For COM port, select the communications port that the modem 
should use to initiate calls for alarm notification. This is typically 
COM3 if you used recommended USB port A on an Avaya MAS.

(2) For Phone number, enter the complete telephone number that 
the modem must dial to place an alarm notification with the 
remote support center. Include any special characters needed (for 
example, to access an outside line, insert pauses, and so on). 

(3) For Modem setup, enter the modem initialization (setup) string if 
one is required for the modem to make alarm notification calls. 

(4) Click OK to close this window. 

4. When configuration is complete, restart service again (see Step 2). 

5. When finished, close all open windows.

Completing initial MAS administration

This section describes the final steps for completing initial administration of this MAS.

Setting up and starting messaging services

To allow the Modular Messaging (MM) services to restart automatically during normal 
operation, and to start the messaging services:

1. Click Start > Run.

2. In the Run window Open field, type the following and press Enter:

C:\Avaya_Support\Scripts\serverrecovery.vbs 

The script takes a few seconds to run. Afterwards, all installed MM 
services will be started.

3. Optional. To verify that all services are started: 

a. Access the window to monitor services using one of these methods:

! Double-click the Monitor icon on the desktop (if present). In the 
left pane, click Services if it is not already selected. 
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! Right-click My Computer and select Manage. In the Computer 
Management window, the left (Tree) pane, expand Services and 
Applications, and then click Services.

b. In the right pane, scroll down to the list of Modular Messaging (MM) 
services. Verify that the Status column shows that service is Started for 
each installed messaging service.

c. If service is stopped or the Status column is blank, right-click the 
appropriate MM service and select Start.

4. When finished, close all open windows.

Verifying alarming setup 

Do this task only on an MAS that has the Messaging Application Server service 
installed on it. (On other MASs, alarming is not available.) 

To verify that alarm notification is working:

1. Click Start > Run.

2. In the Run window Open field, type cmd and press Enter.

3. In the command prompt window, type the following and press Enter:

testaom -v

4. Verify that the last line of the test reads:

Alarm origination test successful 

 

Note: For instructions on accessing the MAS alarm or error logs, see the 
Avaya Modular Messaging Software Messaging Application Server 
Administration Guide (PDF 3 MB) on the documentation media. 
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Completing the Domino setup

This section describes the final steps for completing the Domino system setup.

Editing the voice mail summary document

This procedure must be performed by the Domino system administrator or other 
authorized personnel. 

You must edit the Voice Mail Summary Document on the primary Domino directory 
server (and the secondary directory server if used) to configure the system to support 
the various Modular Messaging features such as message waiting indication (MWI). 
This document is also used to specify the default settings that appear for Modular 
Messaging subscribers in the Person document.

To edit the voice mail summary document:

1. Log in to the Domino server using an account that has privileges to 
assign permissions (such as administrator).

2. Open the Domino directory database file (such as names.nsf). See Item 
5 on the "Modular Messaging MAS planning form" on page A-7. 

3. Edit the Voice Mail Summary Document. For complete steps, see the 
Administrator�s Guide for Lotus Domino Unified Communications for 
Avaya, available on the IBM Lotus Documentation Web site 
www-10.lotus.com/ldd/doc under the product Domino Unified 
Communications 1.2.2. 

Installing the DUC client component

This procedure must be performed by the Domino system administrator or other 
authorized personnel. 

You must install the DUC client component on the Notes client machine of every user 
whom you will enable for DUC, so that they can use the Modular Messaging features. 
This procedure can be done manually or by using a script (�silent install�). See the 
Administrator�s Guide for Lotus Domino Unified Communications for Avaya, available 
from IBM Lotus, for this procedure. 

Note: You must enter the name of the MAS ACL group you created 
when you configured the Domino server. See Item 10 on the 
"Modular Messaging MAS planning form" on page A-7. 

CAUTION: You must do the following procedure before you do any 
subscriber administration, or the user permissions will fail. !

http://www-10.lotus.com/ldd/notesua.nsf/a08df36b2299a8bc8525665d006dce40/fa75f3e569ae6aa685256daa00566137?OpenDocument 
http://www-10.lotus.com/ldd/doc
http://www-10.lotus.com/ldd/notesua.nsf/a08df36b2299a8bc8525665d006dce40/fa75f3e569ae6aa685256daa00566137?OpenDocument
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To install the DUC client component on a Notes client machine manually: 

1. Log in to the client machine using an account that has local 
administration privileges (such as administrator). 

2. Insert the DUC CD or access an image of the CD on the corporate LAN.

3. Review the Readme file avucreadme.1st in the Doc directory for 
detailed instructions and updates (open this file with any text editor, such 
as Notepad). 

4. Verify that the installation prerequisites are met. These include:

a. Verify that the Notes client is not running. 

b. Verify that the Domino server is running. 

c. Verify that the user has at least Designer access to the mail file's ACL if you 
want to update the mail file design. 

5. Close all open applications.

6. Run the Setup program from the avClient directory. 

7. On the Software License Agreement screen, click Accept.

8. Complete the Domino Unified Communications Client for 1.2.2 for Avaya 
installation wizard: 

a. On the Welcome screen, click Next. 

b. On the Choose Destination screen, accept the default or click Browse to 
select the location where the Notes client is installed and where the DUC 
client software will be added. Click Next. 

c. On the Update Mail File Design screen, you can optionally select the option 
to �Update mail file� (this requires Designer access). Click Next. 

d. If prompted, enter the password for this Notes client ID. Click OK. 

e. On the Start Copying Files screen, click Next. 

The system installs the Avaya Modular Messaging Options package. 

f. On the Setup Complete screen, select Yes, I want to restart my computer 
now. 

g. Click Finish.

The system reboots.
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To verify that the Avaya Modular Messaging Options package was installed 
successfully:

1. Select and run the file <drive>:\Program Files\Avaya Modular 
Messaging\Common\UMOptions.exe 

2. If this does not run the Avaya Modular Messaging Options package, 
reinstall the DUC client. 

Synchronizing the clocks 

As a precaution, synchronize the clocks on all client PCs, MASs, and the Domino 
server. Otherwise, users might receive �access denied� errors when attempting to start 
the Avaya Modular Messaging Options package. The procedure for doing this varies. 
Contact the network systems administrator for assistance if needed. 

Note: This file might be named MMOptions.exe. 

For an update, this file is located under the existing directory: 
<drive>:\Program Files\Unified Messenger 

Note: Uninstalling the DUC client for Modular Messaging or local DUC 
administration components does not remove the Avaya Modular 
Messaging Options package. You must uninstall the Avaya 
Modular Messaging Options package separately. 
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Testing and backing up the system

This chapter describes how to perform acceptance tests to verify that the Modular 
Messaging system is providing full service. After functionality is verified, back up the 
system to protect the Modular Messaging configuration data.  

Topics in this chapter include: 

Note: Before you can successfully complete the tasks described in this 
section, you must have successfully completed the tasks in 
Chapter 9, ��Configuring the voice mail system.�� 

Section Page

Adding a test subscriber 10-2

Performing acceptance tests 10-3

� Setting up the port monitor 10-3

� Creating and sending a call answer message 10-4

� Retrieving test messages in integrated mode 10-4

� Creating and sending a test message in nonintegrated mode 10-5

� Testing the outcalling capability 10-6

� Running additional tests 10-8

Administering subsequent MASs 10-8

Removing the test subscriber 10-8

Backing up the system 10-9
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Adding a test subscriber

You must create and enable at least one test subscriber to verify Modular Messaging 
system functionality. See "Switch and messaging information" on page A-14 for test 
subscriber data. 

Use the Domino Administrator client to create or edit a Person document for a test 
subscriber in the appropriate Domino Directory to enable the subscriber for DUC. For 
complete steps, see the Administrator�s Guide for Lotus Domino Unified 
Communications for Avaya, available on the IBM Lotus Documentation Web site 
www-10.lotus.com/ldd/doc under the product Domino Unified Communications 
1.2.2. 

Considerations include:

! The mailbox for the test subscriber must be voice-enabled to use any 
Avaya Modular Messaging features. Also activate any specific features 
that you want to test. 

! The extension for the test subscriber must be administered on the PBX 
by the appropriate party. 

! Only members of the Subscriber Administration access control list (ACL) 
can run and use Avaya Modular Messaging Options in the Domino 
Administrator. If you want to use this package in an Administrative role, 
the account must be included in the Subscriber Administration ACL. See 
Step 7 on page 9-6. 

Additional considerations for setting up subscribers include:

! If you configure the preference for incoming e-mail as MIME (in the 
Person document), text-to-speech conversions might not work correctly. 
Avaya recommends that you configure this setting to the default setting 
(Keep in Sender�s Format or No Preference). 

! In the Person document, if �user name� is the first entry in the 
�FullName� property, the user name must be in hierarchical format (such 
as common name/organizational unit/organization/country code). If the 
user name is not in hierarchical format, you might receive an error event 
ID 140 and MWI will not work as expected. 

Note: If you are performing tests following a Modular Messaging software 
update, you might want to test the system using subscribers that 
are already administered. 

http://www-10.lotus.com/ldd/notesua.nsf/a08df36b2299a8bc8525665d006dce40/fa75f3e569ae6aa685256daa00566137?OpenDocument 
http://www-10.lotus.com/ldd/notesua.nsf/a08df36b2299a8bc8525665d006dce40/fa75f3e569ae6aa685256daa00566137?OpenDocument
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Performing acceptance tests

Do this task on every MAS that is set up to take calls. 

Verify correct system operation by performing the tests described in this section. 
 

Setting up the port monitor

This task is optional for a one-MAS system, but is recommended for a system that has 
multiple MASs that are set up to take calls. 

Tests calls can come in through the ports on various MASs in the system, depending 
on how the hunt group is set up on the PBX. If the Modular Messaging system has 
more than one MAS, use the port monitor to verify that the test calls you make are 
coming in on the ports of the MAS that you want to test.

To display the port monitor: 

1. Click Start > Programs > Avaya Modular Messaging > Port Monitor.

2. When the system prompts for the Message Application Server, select 
the MAS that you want to test (such as zorro). Click Select.

The Port Monitor window for this MAS is displayed. 

3. You can repeat Steps 1 and 2 to bring up Port Monitor windows for 
multiple MASs if desired. 

4. When you dial the Modular Messaging system message retrieval 
number during the acceptance tests, check the Port Monitor window to 
verify that the call is coming in on a port of the MAS that you want to test. 

5. If the Port Monitor does not show that the test call is coming in on the 
desired MAS, hang up and dial the Modular Messaging system message 
retrieval number again. 

The number of times you might have to dial depends on the switch 
administration. For example, the hunt group might be administered to 
send every new call to the next MAS in the system, or it might be 
administered to send all the calls to one MAS before it moves on to a 
subsequent MAS. 

CAUTION: Wait 5 minutes after completing the tasks in Chapter 9, 
��Configuring the voice mail system,�� to give the system time 
to update all servers in the voice mail and Windows domains 
with the correct Modular Messaging information. 

!
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Creating and sending a call answer message

The following test works only if call-coverage has been assigned on the switch to route 
unanswered calls to the extension for the test subscriber.

To create and send a call answer test message:

1. Call the test-subscriber extension from any other telephone. Allow the 
Modular Messaging system to answer.

2. Speak into the telephone and record the following or a similar test 
message after the tone:

�This is a test call answer message.�

3. Hang up the telephone to disconnect. 

Retrieving test messages in integrated mode

Test the fully integrated operation of the system as directed below. You need access to 
the actual telephone whose extension number is assigned to the test-subscriber 
mailbox to perform this test. 

To verify the receipt of the test messages in integrated mode:

1. If MWI is installed: Check the message waiting indicator (MWI) on the 
test-subscriber telephone. The MWI can be a light, a screen display, or a 
dial-tone stutter that you hear when you pick up the phone. 

If the MWI does not indicate that a call was received:

a. Verify that the Mailbox Monitor and MWI services are started.

(1) Access the window to monitor services using one of these 
methods:

! Double-click the Monitor icon on the desktop (if present). In the left 
pane, click Services if it is not already selected. 

! Right-click My Computer and select Manage. In the Computer 
Management window, the left (Tree) pane, expand Services and 
Applications, and then click Services.

(2) In the right pane, scroll down to the Modular Messaging (MM) 
services. Verify that the Status column shows that service is 
Started for each installed messaging service.

(3) If service is stopped or if the Status column is blank, right-click the 
appropriate MM service and select Start.

Note: The message-waiting lamp can take up to 1 minute to light on 
the appropriate telephone after a test message is sent.
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(4) When finished, close this window.

b. If service is started, check for a problem with the test subscriber 
administration, the switch integration or switch integration software, or the 
switch number administration for the test telephone. 

2. From the test-subscriber telephone, dial the Modular Messaging system 
message retrieval number.

The system voices the name of the test subscriber.

3. Enter the password for this mailbox and press . 

4. The first time you access this mailbox, you answer a series of prompts to 
set up the mailbox for operation. Answer all voice prompts as directed.

5. After the mailbox is set up, press  to review the new messages.

6. Press  to retrieve a voice message.

7. Listen to the message. If the message does not play properly, contact 
the remote support center.

8. Press  to erase this message.

9. Follow the voice prompts to retrieve the next message (if any), or press 
 to return to the main menu.

10. Hang up the telephone to disconnect when finished.

11. If MWI is installed: Check the MWI on the test-subscriber telephone. The 
MWI should be off. If it is not off, check the MWI administration on the 
MAS and the PBX. 

Creating and sending a test message in nonintegrated mode

To create and send a test message in nonintegrated mode: 

1. Dial the Modular Messaging system message retrieval number from any 
telephone that is not administered on the system.

The system voices the �Welcome to Avaya Messaging� prompt.

2. Press  to skip the system introduction. 

3. Enter the extension number for test-subscriber mailbox and press .

4. Enter the password for this mailbox and press . 

5. Press  to create a new message.

6. Speaking into the telephone, record the following or a similar test 
message after the tone.

#

1

1

7

*

#

#

#

2
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 �This is a test voice mail message.�

7. Press  to approve the message.

8. Enter the mailbox number for the test subscriber when prompted for the 
extension. Then press .

9. Press  twice (as prompted) to approve the message.

10. Press  again to send the test message to the test-subscriber mailbox.

11. Hang up the telephone to disconnect. 

12. Retrieve the message as described in "Retrieving test messages in 
integrated mode" on page 10-4.

Testing the outcalling capability

Test the outcalling capability of the system using the Avaya Modular Messaging 
Options package, available through the Notes client or the Domino Administrator 
program. See the Modular Messaging Subscriber Options User Guide (585-310-789, 
PDF 1 MB) on the documentation media for details on using this package if needed.

To test system outcalling from the Domino Administrator:

1. Run this test from the machine where you installed the DUC 
administration component to enable subscribers for Modular Messaging. 
See "Setting up Domino to support Modular Messaging" on page 4-3. 

2. Log in to Lotus Domino Administrator.

3. Browse to a Person document where Modular Messaging is enabled. 

4. On the Other tab, click Avaya Modular Messaging Options. 

5. The first time that you access this package, you must enter (or browse 
to) the NetBIOS name of the MAS to connect to. See Item 1 on the 
"Modular Messaging MAS planning form" on page A-7. Click OK. 

6. If a message indicates that multimedia is not available, click OK. 

7. Set up the recording and playback options to use a telephone near you:

a. In the Modular Messaging User Properties window, click the Media Setup 
tab. 

b. For When composing voice messages, select Telephone.

c. Click Configure.

d. In the Telephone Properties window, enter the extension number of a 
telephone near you. 

#

#

#

#
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e. Select or enter the name of this MAS if needed. Click OK. 

f. For When reviewing voice messages, select Telephone. 

g. Repeat Steps c through e to set up telephone playback. 

8. Verify that a name is recorded, and record one if needed: 

a. In the Modular Messaging User Properties window, click the Record 
Greetings tab.

b. Verify that the telephone will be used for recording and playback:

(1) Check the icon to the left of the status display. If it shows a 
telephone, continue with Step c.

(2) If the icon shows a terminal, right-click and select Telephone. The 
icon changes to show a telephone. Continue with Step c.

c. Under Standard Greetings, select Spoken Name. 

! If a green indicator is displayed next to this option, a name is 
already recorded. Go to Step 9. 

! If a name is not recorded: 

(1) Click Record (the red circle) on the player near the bottom of the 
window.

(2) When the telephone rings, answer it and record a name for the 
test subscriber after the tone. 

(3) When finished, click Stop (the black square) on the player. 

(4) Click OK. 

9. Play back the spoken name to test outcalling, as follows:

a. Click the Play button (large black single arrow) on the player near the 
bottom of the window. 

b. Answer the telephone when it rings. 

The picture of the phone should change to become off-hook. 

c. Listen for the system to play the spoken name of the test subscriber. 

d. Hang up the telephone. 

The picture of the phone should change back to being on-hook (this 
might take a couple of seconds).

10. When finished, click OK to close the Modular Messaging User 
Properties window.

11. Close the Lotus Domino Administrator window. 
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Running additional tests

You might want to run additional tests to verify the correct operation of features that are 
particularly important to the customer. For example:

! Automated Attendant

! Call Me

! Find Me

! Octel Analog Networking

To test these or other features, see the Avaya Modular Messaging Software Messaging 
Application Server Administration Guide (PDF 3 MB) on the documentation media for 
feature setup and operation instructions. 

Administering subsequent MASs 

Once you have tested and verified the installation of the first MAS, continue the 
installation procedure based on the number of MASs in the system:

! If you have another new MAS to configure, return to the appropriate 
chapter:

� To install another new Avaya MAS, return to Chapter 5, ��Configuring a 
new Avaya MAS.�� 

� To configure another customer-provided MAS, return to Chapter 6, 
��Configuring a customer-provided MAS.�� 

! If all of the new MASs are configured, continue with "Removing the test 
subscriber" below. 

Removing the test subscriber

When acceptance testing is complete, remove the test subscriber using the normal 
procedures for your version of IBM Lotus Domino.
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Backing up the system 

As a final installation task, set up the system to perform regular, scheduled backups of 
MAS-specific information using the normal backup procedures for this site. Avaya 
recommends that you do an attended backup now on every MAS to preserve the 
configuration information and to verify the backup function. 

Customers should consider the following when designing their backup program:

! Customized Tone Files: If analog port boards are installed in any MAS 
and you have created customized tone files, keep a copy of the tone 
files (*.tsf for Dialogic boards or *.ton for Brooktrout boards) in a network 
location where they are part of the normal backup procedure. Avaya 
suggests that all tone files be stored in the \Avaya_Support\Tone_Files 
directory. You might choose to back up this location or store a copy of 
the tone files elsewhere for backup.

! Caller Applications: Caller Applications (*.uma files), once deployed, are 
stored on each MAS within a folder that has a GUID. The location for this 
folder is \Program Files\Avaya Modular Messaging\VServer\CallerApps. 
Avaya recommends that you back up a copy of this folder as follows: 

Deployed caller applications cannot be backed up using NTBackup 
while the Modular Messaging (MM) Messaging Application Server 
service is running. However, you can make a copy of the CallerApps 
folder while this service is running, and then make a backup of that (you 
could choose to create scripts to carry out this function). See "Restoring 
Caller Applications after a catastrophic disk failure" on page E-3 for 
details on restoring Caller Applications if needed. 

! Licensing Files: Keep a backup of the licensing files (*.xml) safe on 
another device or in another location. 

! System State: Avaya suggests that you back up the system state of each 
MAS on a regular basis. The registry contains settings particular to the 
MAS.

! Spool: The directory \Program Files\Avaya Modular 
Messaging\Vserver\Spool stores messages that are sent while the MAS 
is offline from the message store. You should back up the Spool 
directory on each MAS. 

Note: Perform scheduled maintenance on the MAS routinely to keep the 
hard disk in good condition. See "Running recommended disk 
checks" on page 6-3. 
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11
Updating Unified Messenger R5.0 to

Modular Messaging software

This chapter describes how to update a system that is running Unified Messenger 
Release 5.0 software to Modular Messaging Release 1.1 software. 

Topics in this chapter include: 

Note: Do the tasks described in this section only if you are updating a 
system that is running Unified Messenger Release 5.0 software to 
Release 1.1 of the Modular Messaging software. 

Any systems that are running an earlier release of Unified 
Messenger must upgrade to Unified Messenger Release 5.0 
software before updating to Modular Messaging software.

Section Page
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Preparing the MAS for the update 11-5

Updating the Dialogic port board drivers 11-6

Updating messaging software on the MAS 11-10

Completing the update 11-17
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Overview

A system that is already running Unified Messenger Release 5.0 software can be 
updated to Modular Messaging Release 1.1 software, as described in this chapter. 

Update requirements

To successfully update a system to Modular Messaging Release 1.1, you need:

! A completed copy of the relevant planning forms, including: 

� "Planning form for update to Modular Messaging R1.1" on page F-3 

� "Modular Messaging R1.1 license request - IBM Lotus Domino 
system" on page A-13  

! Release 1.1 of the Avaya Modular Messaging Application Software on 
DVD or CD 

If the Modular Messaging application software is provided on a CD, you 
also need the following CDs: 

� Intel Dialogic Drivers CD

� Enhanced Email Reader Software containing ScanSoft 
Text-to-Speech (TTS) software in multiple languages (3 CDs) 

� Avaya Modular Messaging Documentation CD 

If the Modular Messaging software is provided on a DVD, the DVD 
contains all of the information listed on the separate CDs above. 

Note: Updating Modular Messaging software requires several server 
restarts. Plan to do the software update during low-usage hours. 

Note: Unified Messenger software will become �Modular Messaging� 
software following the update. Services that were labeled 
�Unified Messenger� automatically change to Modular 
Messaging (MM) services after the update, and the Unified 
Messenger service account will become the Modular 
Messaging service account. However, the path names in place 
for the Unified Messenger software will not change. 

CAUTION: Do not manually create a new Modular Messaging service 
account for the new software. Use the existing Unified 
Messenger account to do the update, or problems will occur. 

!
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! The most current configuration notes for integrating the MAS (and any 
Dialogic port boards in it) with the PBX or switch at this site. Get these 
from the www.avaya.com/support Web site, under Technical Database 
> Messaging > Applications > Modular Messaging > General Info. 
Download or print the configuration notes for this PBX integration. 

! If Brooktrout port boards are installed, a copy of the RealCT Direct 
Software Installation and Configuration Guide (available on the Avaya 
Unified Messenger CD) 

! Release 1.2.2 of Domino Unified Communications (DUC) for Avaya 
messaging software, available from IBM Lotus 

! Administrator�s Guide for Lotus Domino Unified Communications for 
Avaya, which contains instructions for updating the DUC software. It is 
available on the IBM Lotus Documentation Web site: 

a. Go to http://www-10.lotus.com/ldd/doc and click the documentation link by 
product. Click Domino Unified Communications, and then click 1.2.2.

b. Download or view the Domino Unified Communications administrator guide, 
readme file, and client help for Avaya. 

Update procedure

To update the system to Modular Messaging Release 1.1:

1. Obtain a license file for this system. See Appendix F, ��Obtaining a 
license for an update.��

2. Review the configuration notes for any changes that might be needed in 
the areas of board configuration, switch programming, and application 
configuration. Make any necessary changes as you do the update. 

3. Upgrade the DUC server component to DUC Release 1.2.2 on all 
Domino servers that contain DUC-enabled user mail files. 

4. Upgrade the DUC administration component to DUC Release 1.2.2 on 
all servers that are used for Domino administration. 

Note: The licensing process might take several hours or longer, 
depending on local procedures. 

Note: This step consists of two parts: updating the Domino directory 
design (the schema) once per Domino domain, and updating 
the administration component on every machine that will be 
used for administration (see Step 2 on page 4-3 for details). 

Do not skip the schema update step, or existing users might be 
locked out of their mailboxes. 

http://www-10.lotus.com/ldd/doc
http://www-10.lotus.com/ldd/notesua.nsf/a08df36b2299a8bc8525665d006dce40/fa75f3e569ae6aa685256daa00566137?OpenDocument
http://www.avaya.com/support
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5. Upgrade the Lotus Notes client on all MASs to Lotus Notes 6.0.1 CF3. 

6. Update all MASs to Release 1.1 using the procedures in this chapter. To 
begin, see "Preparing the MAS for the update" on page 11-5. 

7. When finished, upgrade all DUC-enabled Lotus Notes client machines to 
DUC Release 1.2.2 Client. 

8. Perform acceptance tests on the entire system.

9. Back up the new data. 

Because an update includes many steps, print the update checklist from Appendix B, 
��Installation checklists,�� and use it to track your progress. 

Considerations for multiple-MAS updates

In a multiple-MAS configuration, Avaya strongly recommends that all MASs that are 
running Unified Messenger be updated to Modular Messaging software as soon as 
possible. All MASs in the voice mail domain must be updated to Modular Messaging 
software before you can enable the new Modular Messaging features. 

If you are adding a new Modular Messaging machine to a multiple-MAS configuration, 
it cannot join an existing voice mail domain that only has Avaya Unified Messenger 
voice servers in it. You must first update one or more of the existing Avaya Unified 
Messenger Voice Servers, leave the system running for at least 15 minutes, and then 
add the new Avaya Modular Messaging server. 

Note: Completely update and test one MAS first, and let it run for 15 
minutes before updating any additional MASs. 

CAUTION: After the DUC administration component is upgraded to 
DUC Release 1.2.2, the Avaya Modular Messaging Options 
package will not work when it is run from the upgraded DUC 
Domino Administrator until all MASs have been updated to 
Modular Messaging Release 1.1.

!

CAUTION: All servers must meet the requirements listed in the Avaya 
Modular Messaging Concepts and Planning Guide (PDF 2 
MB), available on the documentation media shipped with the 
system. Review this document to verify that all the Domino 
servers, MASs, and client machines are ready to support 
Modular Messaging software.

!
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Preparing the MAS for the update

Do this task on every MAS. 

This section describes how to prepare each Messaging Application Server (MAS) in 
the system for the Release 1.1 Modular Messaging software update.

To prepare each MAS for the update: 

1. Make a current backup of the important system files, including any 
Brooktrout or customized tone files, before updating any software. See 
"Backing up the system" on page 10-9 for details. 

2. Verify that the anti-virus software is current. The virus-checking software 
used and the update method required vary per local implementation. 

3. Adjust required system values to support Modular Messaging. See 
"Adjusting system values" on page 6-6. 

4. Install required prerequisite software on this MAS, such as Microsoft 
Windows Simple Network Management Protocol (SNMP) services 
(required if this MAS will have the Messaging Application Server service 
installed on it, and if SNMP will be used for alarming at this site). See 
"Installing Windows prerequisite software" on page 6-8. 

5. Verify that Microsoft Windows system updates, security patches, and hot 
fixes are current. Check with the Windows administrator for the software 
update procedures to use at this site. 

6. For a multiple-MAS system: The PBX administrator must use the 
procedures appropriate for this PBX to busy out the ports for the MAS 
being updated and reroute calls to other MASs. Otherwise callers into 
the system might hear ring-no answer or a busy signal.

7. Log in to the MAS using the customer-specified Unified Messaging 
service account name (such as mmacct) and its password. See Item I3 
on "Planning form for update to Modular Messaging R1.1" on page F-3. 

8. Close any open windows on this MAS (including the Lotus Notes client, 
if open).

9. Stop and reset all Unified Messenger services as follows:

a. Click Start > Programs > Administrative Tools > Computer 
Management.

CAUTION: All Unified Messenger services must be stopped before you 
attempt to install the Modular Messaging Release 1.1 
software, or some software components (such as Mailbox 
Monitor) will not be installed. 

!
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b. In the Computer Management window, in the left pane, expand Services 
and Applications.

c. Click Services.

d. In the right pane, scroll down to the set of installed Unified Messenger 
services.

e. Double-click the first Unified Messenger service to open the properties 
window.

f. Set the Startup type to Manual, if it is not already set to Manual.

g. Under Service status, click Stop. 

h. Wait for service to stop, and then click OK to close this window.

i. Repeat Steps e through h for each Unified Messenger service.

j. Close the Computer Management window. 

Updating the Dialogic port board drivers

Do this task on every MAS that contains Dialogic port boards. 

This section describes how to replace the drivers for the Dialogic port boards.  

Preparing for driver installation

To prepare the MAS for the Dialogic driver update: 

1. Stop the Dialogic drivers as follows:

a. From the task bar, click Start > Programs > Dialogic System Software > 
Dialogic Configuration Manager - DCM. 

b. At the �Dialogic System Service (DSS) is running� message, click OK. 

The Dialogic Configuration Manager window is displayed.

c. To stop the Dialogic drivers, click the red Stop Service button and wait.

Note: Stop the Unified Messenger Voice Server service last. 

Note: If this MAS uses Brooktrout port boards, the drivers do not need to 
be updated. Continue with "Updating messaging software on the 
MAS" on page 11-10. 
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d. When drivers are stopped, close the Dialogic Configuration Manager 
window.

2. For analog boards: If a custom tone file was created, it must be backed 
up on another drive or copied to a new directory now, or it will be 
destroyed during the update. You can use the following procedure:

a. On the C: drive of the MAS, create a new directory named Avaya_Support 
with a subdirectory named Tone_Files. 

b. In the Windows Explorer window, navigate to the directory where the 
custom tone file is stored (for example, C:\Program Files\Dialogic\DATA).

c. If any tone files are present (files with a .tsf extension), select them. Use 
Ctrl+click to select multiple TSF files, if needed.

d. Right-click one of the selected files and select Copy.

e. Navigate to the C:\Avaya_Support\Tone_Files directory. 

f. In the right pane, right-click and select Paste to copy the .tsf files.

Uninstalling the existing Dialogic drivers

To remove the existing Dialogic 5.0.1 drivers: 

1. Insert the applications software media in the MAS drive. This is either:

! Avaya Modular Messaging Application Software DVD, or

! For a system that uses CD-ROMs, the Intel Dialogic Drivers CD. 

2. In Windows Explorer, navigate to the MAS removable-media drive (such 
as D:). 

3. Locate the Dialogic files. They are at the root directory on the CD or 
under a Dialogic Drivers subdirectory on the DVD. 

4. Double-click the file Uninstall_5_01.bat.

A command (cmd) window opens. Press any key to continue. 

5. If the Dialogic point release Ptr26599 for SR 5.01 for Windows is 
installed, this will be removed before any other components.

a. In the dialog box, select Remove and click Next.

b. At the confirmation message to remove the point release, click OK.

c. If the system reports any files as read only, click Yes to continue with the 
removal.

d. When prompted, select No, I will restart my computer later.

e. Click Finish. 
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f. Control returns to the batch file. Press any key to continue. 

6. At the �uninstall the Dialogic System Software and SDK� message, click 
Yes. 

7. When Uninstall pauses, close any open windows. Click OK.

The system stops services.

8. When prompted to Remove Shared File, select No to All.

9. When the Uninstall procedure is complete, the Remove Programs From 
Your Computer window might show that some elements were not 
removed. Click OK.

10. When prompted to reboot, click Yes.

Installing the new Dialogic drivers

To install the new Dialogic 5.1.1 base release drivers: 

1. Log back in to the server using the Unified Messenger service account 
name (such as mmacct) and its password.

2. A command (cmd) window opens, explaining which batch file to run 
next. Press any key to continue.

3. Right-click My Computer and select Explore.

4. In Windows Explorer, navigate to the MAS removable-media drive (such 
as D:), and locate the Dialogic files. 

5. Double-click the file Install_5_11.bat. 

The Intel Dialogic System Software and SDK for Windows System 
Release 5.1.1 for Windows wizard runs. When the installation is 
complete, the system automatically reboots. 

Applying the Dialogic Feature Pack

Update the new Dialogic drivers with the 5.11 Feature Pack (FP1): 

1. Log back in to the server using the Unified Messenger service account 
name (such as mmacct) and its password. 

2. A command (cmd) window opens, explaining which batch file to run 
next. Press any key to continue.

CAUTION: Several files have similar names. Verify that you 
are about to select the correct file before clicking it.!
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3. Right-click My Computer and select Explore.

4. In Windows Explorer, navigate to the MAS removable-media drive (such 
as D:), and locate the Dialogic files. 

5. Double-click the file Install_5_11_FP1.bat.

The System Release 5.1.1 Feature Pack 1 wizard runs.

6. On the Welcome screen, click Next.

7. On the License Agreement screen, click Yes.

8. On the Customer Information screen:

a. For User Name, type Modular Messaging. 

b. Type the appropriate company name, and then click Next.

9. On the Select Components screen:

a. Verify that the box to install the Program Files is checked.

b. Clear the checkbox to not install the online documentation.

c. Click Next.

10. The Start Copying Files screen is displayed. Click Next. 

This step might take several minutes to complete.

11. On the last screen, select Yes, I want to restart my computer now.

12. Click Finish.

The system reboots.

Reconfiguring the Dialogic port boards

When the reboot is complete, restore the configuration for the Dialogic boards: 

1. Log back in to the server using the Unified Messenger service account 
name (such as mmacct) and its password.

2. A command (cmd) window opens, explaining which batch file to run 
next. Press any key to continue.

3. Right-click My Computer and select Explore.

4. In Windows Explorer, navigate to the MAS removable-media drive (such 
as D:), and locate the Dialogic files. 

5. Double-click the file Restore_Config.bat.
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6. A command (cmd) window opens. Press any key to continue.

The program cleans up any temporary installation files and replaces 
certain files used by the Dialogic boards.

7. For a system that uses CD-ROMs, remove the Dialogic drivers CD from 
the MAS drive. 

8. Reconfigure and test the Dialogic port boards for this MAS. See 
"Configuring the port boards" on page 8-2.  

Updating messaging software on the MAS

Do this task on every MAS. 

This section describes how to update the Unified Messenger Release 5.0 software to 
Modular Messaging Release 1.1 software on the Messaging Application Server (MAS). 

Updating to Modular Messaging software

To update the Unified Messenger Release 5.0 software to Modular Messaging 
software:

1. Verify that you are logged in as the Unified Messenger service account 
(such as mmacct). 

2. Insert the application software disk in the MAS removable-media drive. 
This is either:

! The Avaya Modular Messaging Application Software DVD, or 

! For a system that uses CD-ROMs, the Avaya Modular Messaging 
Application Software and Languages CD. 

Note: Because the Dialogic Line Test application is not yet installed, 
you must insert the application software disk in the MAS drive. 
See Step 2 in "Testing the port boards" on page 8-10. When 
testing is complete, continue with the next section.

Note: If anti-virus software is installed, Avaya recommends that you 
disable it while you update the Modular Messaging software to 
prevent possible negative interactions. Enable the virus-checking 
software again after the update is complete.
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3. Close the drive door and wait for the green LED to go out. Click OK.

4. Run the Modular Messaging Installation Wizard as follows:

a. In Windows Explorer, navigate to the MAS drive (such as D:).

b. Navigate to the Install directory. 

c. Double-click the file Setup.exe.

The Modular Messaging Installation Wizard runs. 

5. On the main screen, verify that the Configuration drop-down box shows 
Lotus Domino.

6. All components that were previously installed on this machine, and the 
Diagnostic tools, are automatically selected. Verify that all necessary 
components for this MAS are selected. 

7. Click Install.

Most previously installed software components are updated 
automatically (no response is needed). New software components that 
are required for Release 1.1 are also installed. 

8. You might be prompted to enter information for the following 
components on any MAS that is used to handle calls: 

! Alarming Server 

! Messaging Application Server 

The wizards for these components must be completed as follows: 

a. When the appropriate server installation wizard runs, click Next.

b. When prompted, enter the following account information:

! For Domain, enter the NetBIOS name of the Windows domain 
(such as zodiac). See Item I2 on "Planning form for update to 
Modular Messaging R1.1" on page F-3. 

! For User Name and Password, enter the Unified Messenger 
(now Modular Messaging) service account name (such as 

Note: If a System Upgrade window is displayed, see "Running a 
system upgrade" on page 11-13. 

CAUTION: All Unified Messenger services must be stopped before you 
install the Modular Messaging Release 1.1 software, or 
some software components (such as Mailbox Monitor) will 
not be installed. See Step 9 on page 11-5 for details. 

!
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mmacct) and its password. See Item I3 on "Planning form for 
update to Modular Messaging R1.1" on page F-3. 

! Click Next. 

c. Click Install.

d. To complete the wizard, click Finish. 

9. You might be prompted to enter information for the following software 
components on any MAS that has these services installed:

! Mailbox Monitor Server 

! Call Me Server 

! Message Waiting Indicator (MWI) Server 

! Tracing Server 

If wizards for these components run, complete them as follows: 

a. When one of the above server installation wizards runs, click Next.

b. When prompted, enter name of this MAS machine (such as zippy). See 
Item I1 on "Planning form for update to Modular Messaging R1.1" on page 
F-3. Click Next. 

c. When prompted, enter the password for the Unified Messenger (now 
Modular Messaging) service account (such as mmacct). See Item I3 on 
"Planning form for update to Modular Messaging R1.1" on page F-3. Click 
Next. 

d. Click Install.

e. To complete the wizard, click Finish.

10. For a system that uses CD-ROMs, you are prompted to insert additional 
disks to install the RealSpeak Text-to-Speech software in multiple 
languages. When prompted to insert installation disk 2: 

a. Remove the Avaya Modular Messaging Application Software and 
Languages CD from the drive. 

b. Insert the first Enhanced Email Reader (Text-to-Speech) RealSpeak 
software CD in the drive and close the door. 

c. Wait for the green LED on the drive to go out. Click OK. 

d. After the disk is copied, you are prompted to insert the next disk: 

! Insert the next RealSpeak TTS software CD in the drive.

! Repeat Steps b through d for each RealSpeak TTS software CD.

Note: The system might take several minutes to process updates to 
the Messaging Application Server. 
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Allow several minutes for the RealSpeak software to install. When 
finished, the wizard returns to the main screen. 

11. To complete the update, click Close.

12. When prompted, click Restart to restart the system now. 

13. Remove the media from the MAS drive. 

Running a system upgrade

Do this task only if a System Upgrade window is displayed when you run the Modular 
Messaging Installation Wizard. 

If the required operating system components are not present on the target machine 
when the Modular Messaging installation wizard starts, the System Upgrade Screen is 
displayed automatically.

! If Windows Installer is not loaded on the system, the Ignore button is 
disabled and you must click Run System Upgrade to install at least the 
Windows Installer component. This procedure requires a reboot. 

! If Windows Installer is already loaded on the system, you can click 
Ignore to continue the installation without upgrading any other operating 
system components. This is recommended only when installing the 
Modular Messaging Domino Administration extensions. 

To run a system upgrade:

1. In the System Upgrade window, click Run System Upgrade.

The Operating System Upgrade screen is displayed. This screen lists 
the system components that will be installed on the system. 

2. Select the option for either:

! Upgrade Windows Installer only (if you are installing only Domino 
extensions components)

! Upgrade all required system components (used for most MAS 
machines that will run Modular Messaging software). 

3. Click Install.

When the required components have been upgraded, the System 
Upgrade Complete window is displayed.

Note: If you choose to ignore a system upgrade, some Modular 
Messaging components will fail to function correctly. 
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4. Click Restart to reboot this machine. 

5. Continue with your previous update activity. 

Configuring the MAS for the new software 

To configure this MAS for the new Modular Messaging software:

1. When the reboot is complete, log back in to the server using the Modular 
Messaging (MM) service account name (such as mmacct) and its 
password. (This was formerly the Unified Messenger service account.) 

The Messaging Application Server Configuration Wizard runs. 

It might take a few minutes to connect to the MAS.

2. On the Front End Database Update screen, click Next. 

The service starts up. 

3. The update procedure compares the prompts installed on the MAS with 
the existing voice mail domain prompts. If any prompts are absent, the 
Missing Prompts screen is displayed showing a list of the prompts that 
must be installed before the installation can continue. To do this:

a. On the Missing Prompts screen, note the missing prompt sets. The 
configuration wizard automatically attempts to locate the installation 
packages for these prompts.

b. If any installation packages cannot be found, a Locate Installation 
Package message is displayed. Click the text, and then click Browse. 

c. In the Browse for Folder window, navigate to the Prompts directory.

d. Select the folder containing the missing prompts, and click OK. 

e. Repeat Steps b through d for all prompts that cannot be found. 

f. When finished, click Next. (This button is not enabled until all the prompt 
installations are found.) 

4. On the User Information screen, click Next to set up user messaging 
information on the MAS. 

5. On the Setup Complete screen, click Finish. 

Note: If you are running Microsoft Windows NT4, you must reapply 
the latest service pack after a System Upgrade. 

Note: This step might take several minutes for a large database or 
global address list (GAL). 



May 2004

Updating Unified Messenger R5.0 to Modular Messaging software

11�15585-310-330, Issue 1

6. If you disabled the anti-virus software on this MAS, enable it again now. 

Installing the license file and configuring new features

After the Modular Messaging Release 1.1 software is installed, you must use the Voice 
Mail System Configuration (VMSC) program to do the following required steps: 

! Install the required license file (or notify remote technical support that the 
system is ready for the file installation, if remote support is used). 

! Set up Text-to-Speech (TTS) sessions on each MAS as needed. 

! Update the text message that explains what non-Avaya Modular 
Messaging recipients must do to play a Modular Messaging message. 

You can also set up optional features such as Multilingual Text-to-Speech, offline 
access for subscriber messages, and alarming service for the Modular Messaging 
voice mail domain using either the Avaya Initialization and Administration System 
(INADS) or a corporate Simple Network Management Protocol (SNMP) system. The 
need to implement these optional new features varies from site to site. 

To install the license file and configure new features:

1. See "Configuring domain-wide features" on page 9-3 and complete 
Steps 1 through 3. 

2. Set up the following new Modular Messaging features as required: 

a. Licensing: See Step 11 on page 9-9 for the procedure to install the 
required license file after it is obtained (procedures vary depending on 
whether or not remote technical support is used). For all systems, set up 
TTS sessions on each MAS as needed, after the license is installed.

b. Optional: If the Text-to-Speech (TTS) feature is used at this site, see 
Languages (Step 8) on page 9-7 to activate this feature. 

c. Optional: If Offline Access is used at this site, see Messaging (Step 9) on 
page 9-7 to activate this feature. 

d. Optional: To activate either INADS or SNMP alarming for the voice mail 
domain, see Serviceability (Step 10) on page 9-8. 

e. To set up INADS alarming on a specific MAS (requires a modem and the 
Messaging Application Server service to be installed on this MAS): 

(1) In the Voice Mail System Configuration window, expand Message 
Application Servers, and then expand the entry for the MAS 
(such as ZIPPY). 

(2) Click Serviceability to set up INADS service. See Step 3-f on 
page 9-14 under "Configuring MAS-specific parameters" for 
details. 



585-310-330, Issue 1

Avaya Modular Messaging for IBM Lotus Domino Release 1.1 Installation

11�16 May 2004

3. After an update, the text that explains what non-Avaya Modular 
Messaging recipients must do to listen to a Modular Messaging 
message will be out of date. To fix this problem: 

a. In the Voice Mail System Configuration window, double-click Audio 
Encoding. The Audio Encoding window is displayed. 

b. Insert the following text (or you can enter your own customized text): 

�The attached voice message was created by Avaya Modular 
Messaging. It can be played on a multimedia-enabled PC running 
Windows. To listen, please open the attachment.�

Desktop clients will not send the new text until that subscriber runs 
Avaya Modular Messaging Options once and clicks OK. 

c. Click OK to close the Audio Encoding - Voice Mail Domain window.

4. When configuration is complete, restart service if prompted. 

Setting up and starting messaging services

To allow the Modular Messaging (MM) services to restart automatically during normal 
operation, and to start messaging services:

1. Click Start > Run.

2. In the Run window Open field, type the following and press Enter:

C:\Avaya_Support\Scripts\serverrecovery.vbs 

The script takes a few seconds to run. Afterwards, all installed MM 
services will be started.

3. Optional. To verify that all services are started: 

a. Access the window to monitor services using one of these methods:

! Double-click the Monitor icon on the desktop (if present). In the 
left pane, click Services if it is not already selected. 

! Right-click My Computer and select Manage. In the Computer 
Management window, the left (Tree) pane, expand Services and 
Applications, and then click Services.

b. In the right pane, scroll down to the list of Modular Messaging (MM) 
services. Verify that the Status column shows that service is Started for 
each installed messaging service.

c. If service is stopped or if the Status column is blank, right-click the 
appropriate MM service and select Start.

4. When finished, close all open windows.
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Completing the update

Continue the Modular Messaging software update as appropriate:

1. If you have more than one MAS: 

a. For MAS#1 only, let the Modular Messaging software run for 15 minutes so 
that it can update shared data across the voice mail domain.

b. Return to "Preparing the MAS for the update" on page 11-5 to begin 
updating the next MAS.

c. Repeat the Modular Messaging software update procedure until all MASs 
are updated. 

2. Upgrade all DUC-enabled Lotus Notes client machines to DUC Release 
1.2.2 Client. See "Installing the DUC client component" on page 9-16 for 
complete steps. 

3. Verify that the system is working correctly. See "Performing acceptance 
tests" on page 10-3 and perform all the tests relevant to this system. 

4. When acceptance tests are complete, back up each MAS using the 
regular backup procedures for this site. See "Backing up the system" on 
page 10-9 for guidelines. 

5. When finished with each MAS, verify that the MAS disk is in good 
condition by running the following: 

! Disk Defragmenter system tool 

! chkdsk command 

6. If you are adding a new MAS to this system, begin the installation now. 

! To install a new Avaya Messaging Application Server (Avaya MAS), 
begin with Chapter 2, ��Installing Avaya-provided hardware.�� 

! To install a new customer-provided MAS, begin with Chapter 3, 
��Installing MAS port boards.�� 

Print the appropriate checklist from Appendix B, ��Installation checklists,�� 
and use it as a guide.

7. When finished, save all planning forms in a safe place. 

Note: If Brooktrout boards are installed, test each board using 
Multi-Channel Demo. See the Brooktrout RealCT Direct 
Software Installation and Configuration Guide, available on the 
Avaya Unified Messenger CD, for configuration and test 
information for Brooktrout port boards. 
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A
System planning forms

Overview

Implementing Modular Messaging software, and especially installing any new 
Avaya Messaging Application Server (Avaya MAS), requires careful network 
planning. Server names, IP addresses, domain names, accounts, extensions, 
and passwords must be administered correctly on each of the servers in the 
system. Some information must be provided by the customer in advance, or 
the installation cannot proceed. 

This appendix provides an overview of system planning and a set of forms for 
you to fill out prior to installation with the help of the local LAN, switch, and 
messaging administrators. Information includes:

! "Terminology" on page A-2 

! "Guidelines for completing the forms" on page A-4

! "Modular Messaging MAS planning form" on page A-7

! "Modular Messaging MAS planning form (completed example)" 
on page A-9

! "Modular Messaging logon accounts form" on page A-10

Note: For systems that will be maintained by Avaya, check with your 
regional representative for procedures for submitting and reviewing 
the planning forms. In North America, the Solution Support 
Organization (SSO) Tier III group should review the planning forms 
for thoroughness. Send the completed set of forms by email to 
mmtac@avaya.com and the email should be titled MM Planning 
Forms for Tier III Review. An SSO Tier III engineer will review the 
form, note any changes, and return it to the field contact. 
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! "MAS features list" on page A-11

! "Modular Messaging R1.1 license request - IBM Lotus Domino system" 
on page A-13

! "Required switch and messaging information" on page A-14

! "Support information" on page A-15

Terminology

The following terminology applies to the LAN administration process. 

Avaya MAS � A Messaging Application Server (MAS) where the hardware is provided 
by Avaya Inc., often with other optional peripheral devices. The port boards and much 
of the required software are pre-installed on an Avaya MAS.

Cluster � A group of two to six Domino servers that are set up to provide users with 
constant access to data, balance the workload among servers, improve server 
performance, and maintain performance when the size of the enterprise increases.

Corporate IP LAN and interface � Each MAS is connected to the LAN infrastructure 
constructed and maintained by the enterprise that purchased the system. The LAN is 
the corporate IP LAN, and might be identified as Local Area Connection 2 or Corporate 
LAC on an Avaya MAS. This LAN gives the MAS access to other machines and users.

Default IP gateway � The IP gateway to use if no other specified gateway is available. 
Each MAS has at most one default gateway connected to the corporate IP LAN. 

Domain name � A unique designator used to identify a group of related computers on 
the internet (for example, avaya.com). Domain names are hierarchical, and the labels 
go from more specific on the left to more general on the right. There can be any 
number of levels in the hierarchy. 

Domain Name Service (DNS) � An Internet protocol service most often used to 
resolve symbolic names to IP addresses. The DNS service is constructed on 
hierarchical domains with different sets of servers serving each hierarchical layer.

Domino domain � A collection of Domino servers and users that share a common 
Domino Directory. Users' domains are determined by the location of their server-based 
mail files. For a Domino server to communicate with a server in a different domain, you 
create a Domain document in the Domino Directory to define the name, location, and 
access to the other domain. A Domino domain can contain more than one voice mail 
domain. 

Domino server � A server that is running a compatible release of IBM Lotus Domino 
software. The Domino server provides a single message store that holds all messages 
(such as voice, email, and fax) that a subscriber receives. The peer Domino server 
handles message storage and processing for subscribers. The Domino Directory 
manages addressing and attributes for Avaya Modular Messaging subscribers and 
MAS units. Whenever one replica of the directory is updated, the change is 
automatically replicated to all other replicas of the directory in the organization. 



May 2004

System planning forms

A�3585-310-330, Issue 1

DNS server � A machine that has the DNS service active. Such a machine can resolve 
symbolic names for the DNS domain it serves to an IP address. 

Host name � The unique name of the machine. In Microsoft Windows terminology, this 
is often called the NetBIOS machine name. 

Initialization and Administration System (INADS) � The Avaya remote service 
support program for monitoring alarms and maintaining installed systems. 

IP address � A value used to identify a computer connected to a network. If a machine 
has multiple network interfaces, it will have multiple IP addresses, one for each 
connection to a different network. IP addresses are usually specified as four numbers 
separated by a period (for example, 10.9.55.183).

IP gateway � An IP address where IP packets are routed if the specified IP address is 
not on the network directly connected to an interface on the machine. An IP gateway is 
usually an interface on a router.

Messaging Application Server (MAS) � Any Microsoft Windows-based machine that 
is running Avaya Modular Messaging software. A customer-provided MAS has some 
different prerequisite hardware and software requirements than an Avaya MAS (for 
example, the port boards and additional Windows software must be installed), but the 
software installation and administration is nearly identical for both platforms. 

NetBIOS domain � A Microsoft Windows domain that is not fully qualified (has no 
periods). For example, zodiac.

NetBIOS name � The Microsoft Windows term for a host name, also called a NetBIOS 
machine name.

Point-to-Point Protocol (PPP) � An Internet standard protocol used for serial line 
connections, such as dial-up modems.

Subnet mask � A value used to tell which bits of an associated IP address are the 
network portion and which bits identify the specific host on the network. Each network 
interface has an IP address and an associated subnet mask.

Voice Mail Domain (VMD) � A group of one or more messaging application servers. 
Messaging (or voice) servers in a VMD share configuration properties of the VMD and 
subscribers to the VMD. A voice mail domain can contain subscribers in more than one 
Domino domain.

Windows domain � A grouping of network objects, such as users, groups, and 
computers. All objects in a domain are stored on the directory server, such as Active 
Directory. A directory can reside on one or more domain controllers within a domain. 
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Guidelines for completing the forms

Use the following guidelines to complete the planning forms for each Avaya Messaging 
Application Server (Avaya MAS) or customer-provided MAS that you must install. 

Completing the MAS planning form

Complete the "Modular Messaging MAS planning form" on page A-7 for every MAS 
that you install. See the "Modular Messaging MAS planning form (completed example)" 
on page A-9 for a sample completed form. 

To complete "Modular Messaging MAS planning form" on page A-7:

1. Item 1: For a customer-provided MAS, the machine (host) name is 
already assigned. Enter it for reference. 

For any Avaya MASs that will be installed, choose a unique NetBIOS 
machine name for each MAS (for example, zippy and zorro). You must 
keep track of what machine you are administering. In this guide, zippy is 
MAS#1, and zorro is a subsequent MAS. 

2. Item 2: For the Windows domain NetBIOS name, enter the name that 
the LAN administrator has already assigned to the Windows domain that 
this Modular Messaging system will join (for example, zodiac). 

3. Item 3: For the Peer Domino server, enter the NetBIOS machine or host 
name already assigned to the server that is to act as the primary Domino 
server for this MAS machine. Each MAS must have one directory server 
or cluster per Domino domain on which voice mail-enabled users exist.

CAUTION: Keep a copy of the completed planning forms handy during 
initial administration and system configuration. Save the 
planning forms in a safe place when installation is complete 
in case changes or updates are made to the system. Be sure 
to file records of passwords and account names securely.

!

Note: MAS machine names must be 14 or fewer characters long. 
Names shorter than 10 characters are recommended for ease 
in completing the online screens. The host and domain names 
can be any unique term that complies with local conventions. 

CAUTION: It is crucial to coordinate the IP addresses that will be used 
for any MASs with those on the corporate LAN. If you specify 
an Ethernet address for an Avaya server that conflicts with 
another Ethernet endpoint, the resulting traffic problems on 
the local area network can be extremely difficult to diagnose 
and solve.

!
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4. Item 4: For the Secondary Peer Directory server, enter the NetBIOS 
machine or host name already assigned to a Domino server in another 
domain. Use this field if more directory servers are required to support 
multiple Domino domains. 

5. Items 5 through 10: The Domino system administrator provides the 
information needed to create and register the Modular Messaging 
service account. 

6. Item 11: For MAS#1, choose a simple term for the voice mail domain 
(VMD) that the Modular Messaging software will create. This name can 
be similar to the Windows domain name, but it should be unique (for 
example, zebra). The peer directory server for the first MAS in the voice 
mail domain becomes the primary server in the voice mail domain. 

7. Item 12: If the Offline Access feature will be used in a multiple-MAS 
system, specify a shared location to be used for the offline message 
store (for example, \\zorro\OfflineStore). The remote store is used to 
synchronize messages in a multiple-MAS configuration. 

8. Items 13 through 21: For any new MASs that will be installed, enter the 
corporate LAN addresses, domain names, default gateway (if any), and 
WINS information (if needed). These values must be supplied by the 
corporate IP or LAN administrator.

! The IP address for any required DNS or WINS servers must be 
supplied by the corporate IP administrator. 

! The domain search order and any domain names must be supplied 
by the corporate LAN administrator in the order required. 

9. Items 22 and 23: Contact the appropriate administrator for site-specific 
information required for a Modular Messaging installation.

Note: The Domino Directory database might or might not be on the 
mail server. The Domino hierarchical server name consists of 
the Domino server name and the Domino domain name (for 
example, domino1\zeppelin). Use complete path names where 
required for clarity.

Note: Avaya strongly recommends that only static IP addresses be 
assigned to MAS interfaces and machines.

IP addresses should be configured on the corporate DNS 
servers (if used) by LAN personnel in keeping with local policy 
and practices. Customers also must register the corporate 
domain names for each MAS on any relevant corporate DNS 
servers.
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Completing the remaining planning forms

Complete the remaining planning forms as follows: 

1. Complete the "Modular Messaging logon accounts form" on page 
A-10 using the customer-provided account names and passwords 
for this site.

2. On the "MAS features list" on page A-11, have the customer specify 
the messaging services that they want to install on each MAS.

3. Complete the "Modular Messaging R1.1 license request - IBM Lotus 
Domino system" on page A-13, and specify the information that is 
required for new systems. 

4. Complete the "Required switch and messaging information" on page 
A-14 with help from the relevant messaging or switch administrator. 

5. Complete the required "Support information" on page A-15 with help 
from the customer and the organization responsible for providing 
ongoing maintenance of the system. This information varies, 
depending on whether INADS or SNMP alarming is to be used at 
this site. 

Note: This same form can be used to request a license for a Unified 
Messenger Release 5.0 update. In this case, follow the 
instructions in Appendix F, ��Obtaining a license for an update,�� 
to complete and submit the license request form. 
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Page 1 of 2

Modular Messaging MAS planning form

# Item MAS #1 MAS #2

1 Host name for this MAS (NetBIOS name)

2 Windows domain NetBIOS name �Use MAS#1 value�

3 Peer Domino server (host/NetBIOS name)

4 Secondary Directory server if needed 

5  Domino directory database name 

6  Domino hierarchical server name

7  Lotus Notes MAS account password 

8  Lotus Notes ID file name and complete path

9  External caller mailbox file path and name 

10  MAS ACL group name 

11 Voice mail domain name �Use MAS#1 value�

12 Offline message store 

13 Corporate domain name

14 Corporate IP address for this MAS

15 Corporate subnet mask for this MAS

16 Corporate default gateway IP address

17 Corporate DNS servers IP addresses 

18 Search order of DNS domains

19 Register the IP address for this connection in the DNS? 
Register the DNS suffix in the DNS?

20 WINS servers IP addresses 
(if WINS is required) 

21 Static IP addresses for remote access 
(2 required per MAS) 

22 Customer name: 
Organization: 

Windows domain administrator contact information:
IBM Lotus Domino administrator contact information:

23 Users who require system administration access: 

Users who require subscriber administration access: 
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Page 2 of 2Copy this form as many times as needed to set up all MASs. 

Modular Messaging MAS planning form (continued)

# Item MAS #3 MAS #4

1 Host name for this MAS (NetBIOS name)

2 Windows domain NetBIOS name �Use MAS#1 value� �Use MAS#1 value�

3 Peer Domino server (host/NetBIOS name)

4 Secondary Directory server if needed 

5  Domino directory database name 

6  Domino hierarchical server name

7  Lotus Notes MAS account password 

8  Lotus Notes ID file name and complete path

9  External caller mailbox file path and name 

10  MAS ACL group name 

11 Voice mail domain name �Use MAS#1 value� �Use MAS#1 value�

12 Offline message store 

13 Corporate domain name

14 Corporate IP address for this MAS

15 Corporate subnet mask for this MAS

16 Corporate default gateway IP address

17 Corporate DNS servers IP addresses 

18 Search order of DNS domains

19 Register the IP address for this connection in the DNS? 
Register the DNS suffix in the DNS?

20 WINS servers IP addresses 
(if WINS is required) 

21 Static IP addresses for remote access 
(2 required per MAS) 

22 Customer name: 
Organization: 

Windows domain administrator contact information:
IBM Lotus Domino administrator contact information:

23 Users who require system administration access: 
Users who require subscriber administration access: 
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The following planning form shows a completed example for a two-MAS system. These 
sample values are used in this guide for illustration purposes only. 

Modular Messaging MAS planning form (completed example)

# Item MAS #1 MAS #2

1 Host name for this MAS (NetBIOS name) zippy zorro

2 Windows domain NetBIOS name zodiac �Use MAS#1 value�

3 Peer Domino server (host/NetBIOS name) domino1 domino1

4 Secondary Directory server if needed domino2 domino2

5  Domino directory database name names.nsf names.nsf

6  Domino hierarchical server name domino1/zeppelin domino1/zeppelin 

7  Lotus Notes MAS account password MMA$acct1 MMA$acct2 

8  Lotus Notes ID file name and complete path C:\temp\masacct1.id C:\temp\masacct2.id

9  External caller mailbox file path and name mail\zippy.nsf mail\zorro.nsf

10  MAS ACL group name Zebra_ACL_Group Zebra_ACL_Group

11 Voice mail domain name zebra �Use MAS#1 value�

12 Offline message store \\zorro\OfflineStore \\zorro\OfflineStore 

13 Corporate domain name loc.avaya.com loc.avaya.com

14 Corporate IP address for this MAS 10.9.83.72 10.9.83.39

15 Corporate subnet mask for this MAS 255.255.255.0 255.255.255.0

16 Corporate default gateway IP address 10.9.83.254 10.9.83.254

17 Corporate DNS servers IP addresses 10.9.1.39
10.9.1.2

10.9.1.39
10.9.1.2

18 Search order of DNS domains loc.avaya.com
avaya.com

loc.avaya.com
avaya.com

19 Register the IP address for this connection in the DNS? yes
Register the DNS suffix in the DNS? yes

20 WINS servers IP addresses 
(if WINS is required) 

10.152.6.24
10.9.6.8

10.152.6.24
10.9.6.8

21 Static IP addresses for remote access 
(2 required per MAS) 

10.168.2.200
10.168.2.201

10.168.2.202
10.168.2.203

22 Customer name: Messaging Administrator
Organization: Avaya Inc.
Windows domain administrator contact information: name, email, telephone number 
IBM Lotus Domino administrator contact information: name, email, telephone number 

23 Users who require system administration access: craft
Users who require subscriber administration access: Subscriber Administrators
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Account logon names and passwords should be site-specific for security reasons. 

 

Modular Messaging logon accounts form

# Account Logon name 
(customer specified) Password Used for

A1 Local administrator 
account for
MAS#1 (required)

customer specified 
(for example, mas1-admin)

Local administration 
for this MAS

A2 Local administrator 
account for 
MAS #2 (if present)

customer specified 
(for example, mas2-admin)

Local administration 
for this MAS

A3 Local administrator 
account for 
MAS #3 (if present)

customer specified 
(for example, mas3-admin)

Local administration 
for this MAS

A4 Local administrator 
account for 
MAS #4 (if present)

customer specified 
(for example, mas4-admin)

Local administration 
for this MAS

A5 Local administrator 
account for 
MAS #5 (if present)

customer specified 
(for example, mas5-admin)

Local administration 
for this MAS

Add as many local accounts as needed to support all MASs. 

A6 Modular Messaging (MM) 
service account

customer specified 
(for example, mmacct) 

MAS messaging 
services (MM) 
administration 

A7 Technical support remote 
access account

customer specified 
(for example, craft)

Remote access 
maintenance 
account for MM

CAUTION: Avaya strongly recommends that passwords and account 
names on the MAS be at least 8 characters long and not 
composed of easily guessed words or numeric 
combinations, including sequential or repeated numbers. For 
best security, use a combination of upper case, lower case, 
and alphanumeric characters. 

Account names: You can use special characters including 
underscore (_), period (.), and dash (-), but not the symbols 
" / \ [ ] : ; | = , + * ? < > (a space is also strongly discouraged). 

Passwords: At least one of the first 7 characters should be a 
symbol, such as a pound sign (#) or a punctuation mark, but 
not a percent symbol (%).

Do not use the examples shown above as the actual MAS 
account names. They are provided for example purposes 
only. Make sure that you are satisfied with the Modular 
Messaging account names and passwords that you choose. 
They are not easy to change later.

!
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MAS services and features

Working with the customer, fill out the following table to specify the Modular Messaging 
services and optional features to install on each MAS. Guidelines include: 

! If only one MAS is installed, all required services are installed on that 
machine. Check off the features to install in the MAS#1 column. 

! If more than one MAS is installed:

� Install the Call Me Server and MWI Server software on the same MAS. 
These services must be co-resident with the Mailbox Monitor Server. 
They should be installed on the MAS with the fewest ports if possible, 
or on the MAS with the second fewest ports if the Tracing Server is 
installed (the Tracing Server places the greatest demand on an MAS). 

� Install the Tracing Server on an MAS that is not hosting the Call Me or 
MWI software. Always put the Tracing Server service on the MAS with 
the fewest ports, or on its own machine. 

 

* Specify the maximum number of concurrent sessions for a feature based on expected usage.

Copy this form as many times as needed to assign features to all MASs at this site. 

MAS features list

Messaging service to install Max. # of 
sessions:*

on 
MAS#1

on 
MAS#2

on 
MAS#3

on 
MAS#4

on 
MAS#5

Call Me Server

Message Waiting Indicator (MWI) Server 

Both use Mailbox Monitor Server and should be on 
the same MAS. Install these services only once per 
voice mail domain (VMD). 

Caller Applications Editor N/A

Tracing Server (Install only once per VMD.) N/A

Text-to-Speech (If required, note languages to use. 
Specify the number of sessions for each MAS.)

Messaging Application Server

Prompt Files
(One set is required for each MAS that will run the 
Messaging Application Server software. List the 
default file set first and any additional prompt file 
sets if needed.)

N/A

Language Packs
(Specify additional languages to install if needed. 
List the desired default language first. Install the 
same set of languages on each MAS.)

N/A
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Required licensing information 

Provide information to complete a licensing request, as shown in "Modular Messaging 
R1.1 license request - IBM Lotus Domino system" on page A-13. Your choices for 
providing this information might vary per region. See "Sending the license request" on 
page F-9 for contact information for various regions. Note that license request 
submission procedures for new system installations and updates can vary. 

Required licensing information includes:

! Required only for updates, or if remote access will not be used during 
the installation, Items L1 through L4 as follows: 

� VMD ID: Paste the information obtained from the system into the 
document where you want to record this information (for example, the 
editable Word version of "Modular Messaging R1.1 license request - 
IBM Lotus Domino system" on page A-13). Alternatively, you can open 
a text-editor application (such as Notepad) to capture this data. 

! For new systems, see �If remote technical support will not be 
used for this system� on page 9-10 for this procedure. 

! For updates, see "Obtaining license data for an update" on page 
F-4 for this procedure, and for the process to determine the 
correct number of TTS sessions to use in the next item. 

� TTS sessions and engine: Specify the number of TTS sessions 
required for each TTS engine type. 

For new systems, the TTS engine is always ScanSoft RealSpeak, 
Any Language. Use the Max. # of sessions for Text-to-Speech on 
"MAS features list" on page A-11 to specify the total number of TTS 
sessions to license for this system.

� Number of seats: Specify the actual number of purchased seats. 

� Type of license: Specify if this is a new system installation, or an 
update from Unified Messenger Release 5.0. 

! Required if remote access will be used, Items L5 through L8. 

! Required customer and contact information: Specific items vary per 
region. The license request form lists all commonly requested items. 

Note: Use this same form if you are updating a Unified Messenger R5.0 
system to Modular Messaging Release 1.1 software. However, you 
must provide information for Items L1 through L3 as specified in 
Appendix F, ��Obtaining a license for an update.�� 

Note: Remote access might be needed only during the licensing 
process, and can be removed upon completion. If remote 
access will be used during the installation, verify that it is set up 
and working on the designated MAS.
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Modular Messaging R1.1 license request - IBM Lotus Domino system 

# Required licensing information Value

Platform: IBM Lotus Domino 

For updates, or if remote access will not be used during the installation, specify the following: 

L1 VMD ID 

L2 Text-to-Speech (TTS) sessions required (specify number of TTS sessions to license per engine):
� ScanSoft RealSpeak, Any Language (all new systems):
� Fonix DECtalk, US English (updates only): 
� ScanSoft TTS-3000, International (updates only): 

L3 Number of purchased seats 

L4 Type of license (specify new system or Unified Messenger R5.0 update): 

If remote access will be used during the installation, specify access information for the MAS: 

L5 Complete dial-in access number for MAS 

L6 Windows domain to log into 

L7 Modular Messaging service account user name 
and password (for updates, use UM account) 

L8 Technical support account user name and 
password 

Customer and contact information (some items vary per region): 

Direct Operations or Business Partner name

SAP order number (for new systems) 
or Maestro Case ID (for updates) 

FL number

Requested completion date

Planned installation date and completion time 

Customer name

Requester name

Requester contact information (include all that apply):
Complete telephone number:
Mobile or cell phone number: 
Fax number: 
Email address: 

Site location (country, town): 

Alternate contact name and information, if applicable:

Comments: 
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Switch and messaging information 

Collect the required information from the relevant administrator prior to installation. 
Always obtain the latest configuration notes for this particular switch or PBX (see 
"Information on the Web" on page 1-2 for this procedure).

Required switch and messaging information

Item Value Notes

Extension numbers for the port boards on the 
MAS, and the switch ports to which they 
connect.
Note: Distribute the port board extensions 

over a number of switch boards if 
possible for greater reliability.

Use format: 
cabinet carrier slot port 

Connects to extension 
number: 

Number of digits in voice mailbox extension: �

Are port groups required? If yes, supply 
name, use, and number of ports. (For 
example, MWI outgoing only, 2 ports.)

Port group 1: Port group 2: 

DID numbers used for:

� MM hunt group for messaging services:

� MAS dial-in number (one per modem):

Complete dial-in number 

Test subscriber information:
� Name 
� Password 
� Extension number to test telephone
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Support information 

Fill out the appropriate section below, depending on how alarming will be implemented 
at this site: either through the Avaya Initialization and Administration System (INADS) 
or through a corporate Simple Network Management Protocol (SNMP) system. 

Technical support information required for every installation includes:

! Alarming notification used at this site (INADS, SNMP, or none): _______

! Product ID number for MAS: __________________________________

INADS alarming information

Supply the following information to allow the MAS modem to initiate outgoing calls: 

! Communications (COM) port that each modem should use to initiate 
alarm notification calls. This is COM3 for the recommended USB port A 
on the MAS: _________________

! Complete alarm destination telephone number: ___________________

! Modem setup (initialization) string required for the modem to make the 
alarm notification calls. See the documentation included with the modem 
for details: ________________________________________________

SNMP alarming information

Supply the following information if SNMP alarming is to be used at this site: 

! Network Management Station IP address or fully qualified domain name 
for the corporate network management system (NMS) that will monitor 
the Modular Messaging system for alarm notifications (traps): 
_________________________________________________________

! Context (community) to which the NMS belongs (see the SNMP NMS 
documentation for details): ___________________________________

! Acknowledgement type: choose either Return Trap (to have traps 
actively acknowledged by the NMS) or Ping Surround (to have the MAS 
send a ping to the NMS before and after sending a trap. If the pings 
succeed, the NMS is assumed to have received the trap): 
_________________________________________________________ 

Note: If SNMP alarming is used, it is the responsibility of the customer to 
provide and provision the SNMP network management system, 
and to configure it to receive (and optionally acknowledge) the 
traps generated by the Modular Messaging system. 
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B
Installation checklists

Overview

This appendix contains checklists to help guide you through the various 
installation and update tasks. Before beginning a new Modular Messaging 
installation or update, print the checklist relevant to the procedure that you will 
be performing. Check off the steps as you complete them to ensure that you 
do not overlook any important tasks.

Checklists include:

! "New Modular Messaging installation on a customer-provided 
MAS" on page B-2

! "New Modular Messaging installation on an Avaya MAS" on 
page B-5

! "Unified Messenger R5.0 to Modular Messaging software 
update" on page B-9 

Note: If you are adding a new MAS to an existing Unified Messenger or 
Modular Messaging system, do the software update first if an 
update is required. After the update is complete, install the new 
MAS using the appropriate new installation checklist. 
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New Modular Messaging installation on a customer-provided MAS

This checklist applies to a new Modular Messaging installation on a customer-provided 
MAS. As you complete a procedure, make a check mark in the � � column.

Modular Messaging on a customer-provided MAS installation checklist 

Task Description Page Comments

Complete preinstallation planning:

1. Complete the planning forms in Appendix A. Requires input 
from LAN, messaging, switch, and system administrators. 

A-1 See the appropriate 
customer administrators. 

2. Assemble and review the required documentation. 1-2 Web access required.

3. Review security issues. 1-4

4. Obtain anti-virus software for the MAS if required. 1-4 Customer obtains. 

5. Arrange for LAN administration of the MAS system. 
Register MAS corporate FQDNs on the DNS if required. 
Note: Avaya is not responsible for installation, administration, 
or test of communications between customer PCs and LAN. 

1-6 See LAN administrator.

Time of administration and 
site requirements vary. 

6. Verify that the PBX or switch is administered. 1-6 See switch administrator.

7. Gather the necessary tools and test equipment. 1-7

8. Collect any software CDs that will be needed during the 
installation (such as for Microsoft Windows OS, IBM Lotus 
Domino software, SP updates, or anti-virus software). 

N/A Leave customer CDs and 
DVDs on-site.

Install any required hardware:

9. Install the Dialogic port boards, including:
� Prepare for the installation.
� Set jumpers and switches.
� Install the Dialogic software and drivers.

3-2 See the Dialogic 
documentation for details.

IP H.323 integrations skip 
this step. 

10. Connect the MAS port boards to the switch or PBX. 3-12 Do as required. 

11. Install and configure the modem for each MAS. 3-13 Do as required. 

Prepare to install the Modular Messaging software:

12. Set up Domino to support Modular Messaging, including:
� Install DUC server component on each Domino mail server.
� Install DUC administration components for Domino 

directory design and for subscriber administration.
� Register each MAS as a Notes user and record file data. 
� Create an ACL group for the MAS voice servers and add it 

to the Domino Directory in each domain as needed.
� Create the required Domino ACL roles and assign them to 

the ACL group and administrators as needed. 
� Edit the ACL of the Domino Directory and Administration 

Requests database for the correct level of access. 

4-3 Requires Domino 
administrator access. 

 (1 of 3)
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13. Set up the Windows system to support Modular Messaging: 
� Set up a Modular Messaging service account and a remote 

access account for ongoing maintenance. 
� Add a computer account for each MAS to the domain.
� Set up each MAS to support remote access. 

4-5 Requires Windows domain 
administrator access. 

Set up the MAS for Modular Messaging: 

14. Configure the network card on the MAS if needed. 6-3 Use static IP addresses. 

15. Install and update anti-virus software on the MAS. 6-3 Do if required. Installation 
procedures vary. 

16. Install the latest Microsoft Windows system updates, security 
patches, and hot fixes. 

6-3 Do if required. Procedures 
vary. 

17. Run MAS disk checks (chkdsk and defragmenter tool). 6-3 Do as required. 

18. Join the Microsoft Windows domain. 6-4

19. Add the Modular Messaging accounts to the local 
administrators group for this MAS. 

6-5 Required to install the 
software.

20. Adjust system values on the MAS for Modular Messaging:
� Event Viewer
� File and Printer Sharing properties
� Windows 2000 Server operating system properties 

6-6

21. Log in as the Modular Messaging service account. 6-7

22. Install Microsoft Windows prerequisite software if needed on 
this MAS (such as SNMP).

6-8 Requires Microsoft 
Windows OS CD.

23. Prepare the MAS to support Domino software, including:
� Install the Notes client as a single user on the MAS.
� Copy the Modular Messaging account ID file to the MAS.
� Configure the Notes client to connect to the Domino server. 
� Close the Notes client when finished. 

6-9 Requires IBM Lotus 
Domino software. 

Set up the Notes client for 
the Modular Messaging 
service account. 

Install and configure the Modular Messaging software:

24. Disable anti-virus software on the MAS for Modular Messaging 
software installation. 

7-3 Optional but 
recommended. 

25. Install Modular Messaging software components using the 
Installation wizard.

7-3 Install on each MAS based 
on the planning forms.

26. Use Messaging Application Server Configuration Wizard to:
� Identify the Domino servers. 
� Set up (on MAS#1) or join the voice mail domain. 

7-8 Steps vary for MAS#1 and 
a subsequent MAS.

27. Enable the anti-virus software on the MAS. 7-10 Do as required. 

Modular Messaging on a customer-provided MAS installation checklist 

Task Description Page Comments

 (2 of 3)
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28. Set up remote access on each MAS. 7-11

29. Configure and test the port boards, including:
� For analog cards, create or use an appropriate tone file.
� Configure each port board.
� Test incoming and outgoing calls on each board.

8-2 Configuration notes 
required.

IP H.323 integrations skip 
this step. 

30. If multiple languages are installed, specify preferred language. 9-3 Do if required. 

31. Verify that Modular Messaging service is started. 9-4

32. Use the Voice Mail System Configuration program to:
� Enable the Modular Messaging services you installed.
� Configure the MAS for this PBX.
� Set up specific features for each MAS.
� Install the license file when received, and then set up TTS 

sessions on each MAS as needed. 

9-4 Configuration notes 
required.

33. Arrange to obtain a license for this system. 9-9 Local procedures vary. 

34. Set up and start MAS messaging services. 9-14

35. Verify the alarming setup on the MAS. 9-15  Do as required. 

36. Complete the Domino setup, including:
� Edit the voice mail summary document.
� Install the DUC client component on subscriber machines.
� Synchronize the server clocks with all client machines. 

9-16 Requires Domino 
administrator access. 

Test and back up the system:

37. Create and enable a voice-enabled test subscriber for Modular 
Messaging. 

10-2 Requires Domino 
administrator access. 

38. Perform acceptance tests, including:
� Create and receive test messages in both integrated and 

nonintegrated mode. 
� Test system outcalling using Modular Messaging Options. 
� Test additional features if required for this site. 

10-3 For multiple MASs, use the 
Port Monitor to track calls. 

39. Install and configure each subsequent MAS. 10-8 Repeat these procedures 
as needed.

40. Remove the test subscriber. 10-8 Requires Domino 
administrator access. 

41. Back up the data on every MAS. 10-9

42. Schedule routine disk maintenance for the MAS. 10-9 Use local procedures. 

43. Save the planning forms in a safe place. A-4

Modular Messaging on a customer-provided MAS installation checklist 

Task Description Page Comments

 (3 of 3)
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New Modular Messaging installation on an Avaya MAS

This checklist applies to a new Modular Messaging installation using an Avaya 
Messaging Application Server (Avaya MAS). As you complete a procedure, make a 
check mark in the � � column.

Modular Messaging on an Avaya MAS installation checklist 

Task Description Page Comments

Complete preinstallation planning:

1. Complete the planning forms in Appendix A. Requires input 
from LAN, messaging, switch, and system administrators. 

A-1 See the appropriate 
customer administrators. 

2. Assemble and review the required documentation. 1-2 Web access required.

3. Review security issues. 1-4

4. Obtain anti-virus software for the MAS if required. 1-4 Customer obtains. 

5. Arrange for LAN administration of the Avaya MAS system. 
Register MAS corporate FQDNs on the DNS if required.
Note: Avaya Inc. is not responsible for the installation, 
administration, or test of communications between customer 
PCs and the LAN. 

1-6 See LAN administrator.

Time of administration and 
site requirements vary. 

6. Verify that the PBX or switch is administered. 1-6 See switch administrator.

7. Gather the necessary tools and test equipment. 1-7

8. Collect any software CDs that will be needed during the 
installation (such as for Microsoft Windows OS, IBM Lotus 
Domino software, SP updates, or anti-virus software). 

N/A Leave customer CDs and 
DVDs on-site.

Install the hardware:

9. Review preinstallation site requirements, including:
� Environmental requirements
� Weight and space requirements
� Customer-provided cabinet requirements
� Installation area requirements
� Power and grounding requirements
� Demarcation points 

2-3

10. Unpack the Modular Messaging system hardware and 
peripheral components.

2-7 Open boxes as instructed 
to reuse packing materials.

11. Assemble and identify the system components. 2-7

12. Attach mounting brackets and handles to UPS and any EBM 
units as needed, and then cable the units together.

2-10 Optional. Do if UPS and 
any EBMs are present.

13. Attach the front bezel to each MAS. 2-16

 (1 of 4)
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14. Attach rails for rack-mount or rubber spacers for stackable 
configuration to each MAS.

2-16 Use appropriate method for 
this site. 

15. Connect the Avaya MAS system power cables. 2-20

16. If present, connect the MAS port boards to the switch or PBX. 2-21 See the Dialogic 
documentation for details.

17. Connect each MAS to the corporate LAN. 2-22

18. Assemble the KVM switch. Steps include:
� Attach mounting brackets to KVM switch (if needed).
� Connect KVM switch to monitor, keyboard, and mouse.
� Connect the KVM switch to each MAS.

2-23 Optional. Procedure varies, 
depending on type of KVM 
switch purchased.

19. Attach the required ferrites to the video cables and QSIG port 
board cables (if present).

2-27

20. Set up the external modem for each MAS. 2-28

21. Power up the Avaya MAS system. 2-30

Prepare to install the Modular Messaging software:

22. Set up Domino to support Modular Messaging, including:
� Install DUC server component on each Domino mail server.
� Install DUC administration components for Domino directory 

design and for subscriber administration.
� Register each MAS as a Notes user and record file data. 
� Create an ACL group for the MAS voice servers and add it 

to the Domino Directory in each domain as needed.
� Create the required Domino ACL roles and assign them to 

the ACL group and administrators as needed.
� Edit the ACL of the Domino Directory and Administration 

Requests database for the correct level of access.

4-3 Requires Domino 
administrator access. 

23. Set up the Windows system to support Modular Messaging: 
� Set up a Modular Messaging service account and a remote 

access account for ongoing maintenance. 
� Add a computer account for each MAS to the domain.
� Set up each MAS to support remote access. 

4-5 Requires Windows domain 
administrator access. 

Set up the Avaya MAS:

24. Switch the monitor to show the correct MAS. 5-2

25. Complete the Windows 2000 Server Setup Wizard to:
� Localize system information. 
� Assign IP addresses and DNS information. 
� Specify WINS information if needed. 
� Join the Microsoft Windows domain. 

5-4 Use the planning forms.

26. Test IP addresses on the corporate network using ping. 5-11

Modular Messaging on an Avaya MAS installation checklist 

Task Description Page Comments

 (2 of 4)
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27. Install and update anti-virus software on the MAS. 5-12 Do if required. Installation 
procedures vary. 

28. Install the latest Microsoft Windows system updates, security 
patches, and hot fixes. 

5-12 Do if required. Procedures 
vary. 

29. Prepare the MAS to support Domino software, including:
� Install the Notes client as a single user on the MAS.
� Copy the Modular Messaging account ID file to the MAS.
� Configure the Notes client to connect to the Domino server. 
� Close the Notes client when finished. 

5-12 Requires IBM Lotus 
Domino software. 

Set up the Notes client for 
the Modular Messaging 
service account. 

30. Complete the Modular Messaging OS Component 
Configuration Wizard to: 
� Identify the message store. 
� Set up Modular Messaging account information. 

5-15 Use the logon accounts 
form.

31. Log in as the Modular Messaging service account. 5-16

Install and configure the Modular Messaging software:

32. Disable anti-virus software on the MAS for Modular Messaging 
software installation. 

7-3 Optional but 
recommended. 

33. Install Modular Messaging software components using the 
Installation wizard.

7-4 Install on each MAS based 
on the planning forms.

34. Use Messaging Application Server Configuration Wizard to:
� Identify the Domino servers. 
� Set up (on MAS#1) or join the voice mail domain. 

7-8 Steps vary for MAS#1 and 
a subsequent MAS.

35. Enable the anti-virus software on the MAS. 7-10 Do as required. 

36. Set up remote access on each MAS. 7-11

37. Configure and test the port boards, including:
� For analog cards, create or use an appropriate tone file.
� Configure each port board.
� Test incoming and outgoing calls on each board.

8-2 Configuration notes 
required.

IP H.323 integrations skip 
this step. 

38. If multiple languages are installed, specify preferred language. 9-3 Do if required. 

39. Verify that Modular Messaging service is started. 9-4

40. Use the Voice Mail System Configuration program to:
� Enable the Modular Messaging services you installed.
� Configure the MAS for this PBX.
� Set up specific features for each MAS.
� Install the license file when received, and then set up TTS 

sessions on each MAS as needed. 

9-4 Configuration notes 
required.

41. Arrange to obtain a license for this system. 9-9 Local procedures vary. 

Modular Messaging on an Avaya MAS installation checklist 

Task Description Page Comments
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42. Set up and start MAS messaging services. 9-14

43. Verify the alarming setup on the MAS. 9-15  Do as required. 

44. Complete the Domino setup, including:
� Edit the voice mail summary document.
� Install the DUC client component on subscriber machines.
� Synchronize the server clocks with all client machines. 

9-16 Requires Domino 
administrator access. 

Test and back up the system:

45. Create and enable a voice-enabled test subscriber for Modular 
Messaging. 

10-2 Requires Domino 
administrator access. 

46. Perform acceptance tests, including:
� Create and receive test messages in both integrated and 

nonintegrated mode. 
� Test system outcalling using Modular Messaging Options. 
� Test additional features if required for this site. 

10-3 For multiple MASs, use the 
Port Monitor to track calls. 

47. Install and configure each subsequent MAS. 10-8 Repeat these procedures 
as needed.

48. Remove the test subscriber. 10-8 Requires Domino 
administrator access. 

49. Back up the data on every MAS. 10-9

50. Schedule routine disk maintenance for the MAS. 10-9 Use local procedures. 

51. Save the planning forms in a safe place. A-4

Modular Messaging on an Avaya MAS installation checklist 

Task Description Page Comments
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Unified Messenger R5.0 to Modular Messaging software update

Use this checklist when you update an existing Unified Messenger Release 5.0 system 
to run Modular Messaging Release 1.1 software. As you complete a procedure, make 
a check mark in the � � column. 

Note: If you are adding a new MAS to an existing Unified Messenger or 
Modular Messaging system, do the software update first if an 
update is required. After the update is complete, install the new 
MAS using the appropriate new installation checklist. 

Modular Messaging Release 1.1 update checklist 

Task Description Page Comments

Prepare for the update:

1. Complete the update planning forms. Requires customer input 
from the appropriate system administrators. 

A-13, 
F-3

Do in advance of update if 
possible. 

2. Arrange to obtain a license for this system. If possible, get the 
license file in advance of the update. 

F-1 Local procedures vary. 

3. Assemble and review the required documentation. 11-2 Web access required.

4. Collect any software CDs that will be needed during the update 
(such as for Microsoft Windows OS, IBM Lotus Domino 
software, SP updates, or anti-virus software). 

11-2 Leave customer CDs and 
DVDs on-site.

5. Upgrade the DUC server component on all Domino servers 
that contain DUC-enabled user mail files.

11-3 Do as required. Use IBM 
documentation. 

6. Upgrade the DUC administration component for the Domino 
directory design (the schema) once per Domino domain. 

11-3 Do as required. Use IBM 
documentation. 

7. Upgrade the DUC administration component on every 
machine that is used for Domino administration. 

11-3 Do as required. Use IBM 
documentation. 

8. Upgrade the Lotus Notes client on all MASs to 6.0.1 CF3. 11-4 Do as required. Use IBM 
documentation.

Prepare to update each MAS:

9. Back up important system files, including any tone files. 10-9 

10. Verify that the anti-virus software is current. 11-5 Do if anti-virus software is 
installed. 

11. Adjust system values on the MAS for Modular Messaging:
� Event Viewer
� File and Printer Sharing properties 
� Windows 2000 Server operating system properties

6-6

12. Install Microsoft Windows prerequisite software for Release 
1.1, such as SNMP service if required at this site. 

6-8 Requires Microsoft 
Windows OS CD. Install on 
MAS if required. 
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13. Verify that the latest Microsoft Windows system updates, 
security patches, and hot fixes are installed. 

11-5 Local procedures vary. 

14. Busy-out and reroute the ports for this MAS if possible. 11-5 Use PBX procedures.

15. Log in to the MAS to be updated using the Unified Messenger 
service account. 

11-5 This will become the 
Modular Messaging service 
account. 

16. Close any open windows (including the Lotus Notes client). 11-5  

17. Stop and reset all Unified Messenger services. 11-5

18. Update the Dialogic port board drivers, including:
� For analog cards, copy custom tone files to a safe place. 
� Stop and uninstall the existing drivers. 
� Install and update the new drivers. 
� Reconfigure and test the Dialogic port boards. 

11-6 Configuration notes 
required.

Installations that use 
Brooktrout port boards skip 
this step. 

Install and configure the Modular Messaging software:

19. Disable anti-virus software on the MAS for Modular Messaging 
software installation. 

11-10 Optional but 
recommended. 

20. Update the Modular Messaging software using the Installation 
wizard.

11-10

21. Complete a system upgrade if prompted. 11-13 Do if required.

22. Complete the Messaging Application Server Configuration 
Wizard to update the MAS configuration. 

11-14

23. Enable the anti-virus software on the MAS. 11-15 Do as required. 

24. Use the Voice Mail System Configuration program to:
� Install the license file when received, if needed. 
� Set up TTS sessions on each MAS.
� Update the text message for non-Avaya subscribers. 
� Set up optional Release 1.1 features if required such as 

alarming, TTS, and offline access of subscriber messages. 

11-15 Do this for MAS#1. 

25. Set up and start MAS messaging services. 11-16

26. Allow 15 minutes for the update information to be shared. 11-17 Do this for MAS#1. 

27. Update each additional MAS. 11-17 Repeat these procedures 
as needed.

Complete the update:

28. Upgrade all DUC-enabled Lotus Notes client machines. 9-16

Modular Messaging Release 1.1 update checklist 

Task Description Page Comments
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29. Perform acceptance tests, including:
� Create and receive test messages in both integrated and 

nonintegrated mode. 
� Test system outcalling using Modular Messaging Options. 
� Test additional features if required for this site. 

10-3 For multiple MASs, use the 
Port Monitor to track calls. 

30. Back up the data on every MAS. 10-9

31. Run MAS disk checks (chkdsk and defragmenter tool). 11-17 Do as required. 

32. Add any new MASs to this system if required. 11-17 Use the new system 
installation checklist. 

33. Save the planning forms in a safe place. A-4

Modular Messaging Release 1.1 update checklist 

Task Description Page Comments
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C
Creating a new tone file

Overview

This appendix describes how to build a tone file for Dialogic analog port boards by 
using the PBXpert utility to learn PBX tones. 

This procedure must be done after the port boards are administered on the switch, but 
before you configure them using the Intel Dialogic Configuration Manager. See 
"Configuring analog port boards" on page 8-3. 

You can use PBXpert either automatically or manually to learn the call progress tones 
for this PBX and store them in a Tone Set File (TSF). Many tone sets can be stored in a 
single TSF file. 

! Automatic Learning: PBXpert uses two different channels on the Dialogic 
voice board to set up tones and learn the resulting call progress tones 
automatically. See "Learning tones automatically" on page C-2.

Note: If Brooktrout port boards are installed, use the RealCT Direct 
Software Installation and Configuration Guide, available on the 
Avaya Unified Messenger CD, to create a tone file if needed.

CAUTION: Use the configuration notes for this particular PBX or switch 
integration to administer the port boards. See "Required 
documentation" on page 1-2 for instructions on obtaining the 
configuration notes. The port boards must be administered 
on the switch before you can proceed.

!
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! Manual Learning: PBXpert uses one channel on the Dialogic voice 
board and a telephone to set up tones and learn the resulting call 
progress tones manually. PBXpert prompts you how and when to use 
the telephone. See "Learning tones manually" on page C-7.  

Learning tones automatically

This section describes the following procedures:

! "Running the PBXpert wizard" on page C-2 

! "Consolidating and saving the TSF file" on page C-6

! "Using the new TSF in Dialogic Configuration Manager" on page C-6

Running the PBXpert wizard

The PBXpert wizard guides you through learning the tones used by this PBX and 
saving the information as a TSF file. PBXpert can learn the following tones: 

! Dial tone

! Ringback

! Busy

! Reorder (fast busy)

! Disconnect

To run the PBXpert wizard: 

1. Start the Dialogic voice cards. 

a. You should have already started the Intel Dialogic Configuration Manager. 
See Steps 1 through 3 in "Configuring analog port boards" on page 8-3. 

b. Click the green Start Service button on the button bar. 

When service is started, the Stop Service button becomes active and 
the installed boards show a green light. 

Note: If only one line is connected to the Dialogic voice board, you 
must use Manual Learning.
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2. Click Start > Programs > Intel Dialogic System Software > PBXpert.

The PBXpert main window is displayed (see Figure C-1 on page C-3). 
Most fields are blank until tones are learned.

! If you are using PBXpert for the first time after installation, the 
PBXpert wizard starts automatically.

! If the PBXpert wizard does not start automatically, click Tones > 
Tone Wizard.  

Complete the PBXpert wizard screens as follows: 

1. When the PBXpert Wizard Welcome screen is displayed, click Next. 

2. On the PBX Information screen:

! Under PBX, enter the name of the manufacturer (such as Mitel) and 
the model of the PBX (such as SX-2000).

Note: You can change the default settings in the wizard if you are 
familiar with this PBX environment and the Dialogic API. Any 
settings that you change are saved when you exit PBXpert. For 
help on a particular screen, click the Help button in the wizard.

Figure C-1. PBXpert main window
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! You can use the automatically created Tone Set File name as it is 
shown on the screen, or alter it as desired.

! Click Next.

3. On the TAPI Information screen, use the default values. Click Next.

4. On the Select a Board screen:

! Select the Dialogic board to use.

! Click Next.

5. On the Select the Calling Resource screen, for the Line A Calling 
Channel: 

! For Select the Channel, enter the port number or channel to use.

! For Phone Number, enter the extension number of this port. See 
"Required switch and messaging information" on page A-14 for port 
board extensions.

! Click Next.

6. On the Select the Calling Resource screen, for the Line B Called 
Channel: 

! For Select the Channel, enter a port number or channel that is 
different from Line A.

! For Phone Number, enter the extension number of this port. 

! Click Next.

7. On the Settings Confirmation screen:

! Verify the settings. Click Back if you need to change anything.

! Verify that the Run Wizard Auto-Test box is checked.

! Click Next.

8. The Auto Line Test window is displayed while PBXpert verifies the 
connection between the two specified channels. 

! If you see a �Test finished successfully!� message, click OK to close 
this window and proceed.

! If the line test fails, click OK to close this window. Click Back on the 
wizard, adjust the settings, and try the test again.

9. On the Learn Tones screen, click Next to begin learning tones 
automatically.
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The Learn Tones window is displayed. See Figure C-2 on page C-5.  

10. When PBXpert completes learning, the system displays buttons that 
allow you to keep or discard the data.

! If the tones were learned without errors, select Keep Data. The 
Learn Tones window closes and you can proceed.

! If errors occurred, select Discard Data. The window closes. Click 
Back on the wizard, adjust the settings, and try to learn the tones 
again. You cannot test or save the tone file if it contains errors. 

11. On the Verifying the Learn screen, click Next to test the learned tones.

! If the test succeeds, click OK to close the test window and proceed.

! If the test fails, click OK to close this window. Click Back on the 
wizard, adjust the settings, and try the test again. 

12. The Summary of Results screen shows the final wizard status and tone 
definitions. Click Finish.

Tone definitions are displayed in the main window (see Figure C-3 on 
page C-6). 

Note: You can click Cancel at any time during the test to stop 
automated learning.

Figure C-2. Learn Tones window (learning in progress)
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Consolidating and saving the TSF file

You must consolidate and save the new TSF file so that you can use it with the Dialogic 
voice driver. To do this:

1. Click Tones > Consolidate.

2. When finished, click File > Save to save the new TSF file.

a. In the Save As window, navigate to the following directory to ensure that the 
file will be backed up: C:\Avaya_Support\Tone_Files 

(If you use the default DATA directory, this file will not be backed up.) 

b. Specify a file name with file type of TSF (such as Mitel-SX-2000.tsf).

Using the new TSF in Dialogic Configuration Manager

To use the new TSF that you just created: 

1. Return to the Intel Dialogic Configuration Manager window.

Figure C-3. Sample tone definitions in main window 
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2. Click the red Stop Service button on the button bar.

3. Return to Step 4 in "Configuring analog port boards" on page 8-3 and 
complete board configuration and testing.

Learning tones manually

This section describes the following procedures:

! "Running PBXpert" on page C-7 

! "Adding a new tone set" on page C-8 

! "Learning tone definitions" on page C-8 

! "Testing the tone set" on page C-10

! "Consolidating and saving the TSF file" on page C-10 

! "Using the new TSF in Dialogic Configuration Manager" on page C-10 

Running PBXpert

To run PBXpert manually: 

1. Start the Dialogic voice cards. 

a. You should have already started the Intel Dialogic Configuration Manager. 
See Steps 1 through 3 in "Configuring analog port boards" on page 8-3. 

b. Click the green Start Service button on the button bar. 

When service is started, the Stop Service button becomes active and 
the installed boards show a green light. 

2. Click Start > Programs > Intel Dialogic System Software > PBXpert.

The PBXpert main window is displayed (see Figure C-1 on page C-3). 
Most fields are blank until tones are learned.

3. If you are using PBXpert for the first time after installation, the PBXpert 
wizard starts automatically. If the PBXpert32 Wizard starts, click the 
Don�t run wizard at startup checkbox and click the Cancel button.

A new, empty TSF is now active.

4. In the PBXpert main window, click Settings on the button bar.
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5. In the Settings window:

a. For Line A, enter the Board Number (such as 1) and the Channel Number 
or port number.

b. The Manual mode checkbox should be checked.

c. For Line B, for Phone Number, enter extension for this port or channel. See 
"Required switch and messaging information" on page A-14 for port board 
extensions

You can use the default values for all the other fields in this window. 
Click Help for more information if needed.

d. Click OK.

Adding a new tone set

To add a new tone set to a TSF:

1. From the PBXpert main window, click Edit > New Tone Set.

2. In the New Tone Set window:

a. Enter the PBX Manufacturer (such as Mitel) and Model name (such as 
SX-2000).

b. Click OK.

The PBXpert main window shows the manufacturer and model names 
you entered. The tone definitions are set to zero.

Learning tone definitions

To add tone definitions to the new tone set:

1. From the PBXpert main window, click Tones > Learn.

2. On the Start Learn window:

a. Select the tones for the Dialogic cards to learn (the default is all tones). 

b. Click Start Learn to have PBXpert start learning tones.

Note: If you are familiar with this PBX environment and the 
Dialogic API, you can change these default settings. Any 
settings that you change are saved when you exit PBXpert.
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The Learn Tones window is displayed (see Figure C-4 on page C-9). 

3. You are prompted to listen for ringing, and to pick up or replace the 
telephone handset during the test. When the message box pops up, do 
the requested action, and then click OK. 

4. When the learning process has finished, tone definitions appear in the 
Learn window. Keep or discard the data as follows:

! If the tones were learned without errors, select Keep Data. The 
Learn Tones window closes and you can proceed.

! If errors occurred, select Discard Data. The window closes. Click 
Back on the wizard, adjust the settings, and try to learn the tones 
again. You cannot test or save the tone file if it contains errors. 

The Learn window closes. The new tone definitions appear in the 
PBXpert main window. See Figure C-3 on page C-6 for an example. 

Note: Click Cancel at any time to stop learning.

Figure C-4. Learn Tones window (learning complete)
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Testing the tone set

The Test function verifies that the consolidated tone set in the active TSF works 
correctly with the Perfect Call call-progress analysis utility. 

To test the newly learned tones:

1. In the main PBXpert window, click Tones > Test.

2. A Test window is displayed. 

When testing is complete, test results are displayed in the Test window.

3. Verify that the tone definitions of the learned tones are correct.

Consolidating and saving the TSF file

You must consolidate and save the new TSF file so that you can use it with the Dialogic 
voice driver. To do this:

1. Click Tones > Consolidate.

2. When finished, click File > Save to save the new TSF file.

a. In the Save As window, use the default DATA directory. 

b. Specify a file name with file type of TSF (such as Mitel-SX-2000.tsf).

Using the new TSF in Dialogic Configuration Manager

To use the new TSF that you just created: 

1. Return to the Intel Dialogic Configuration Manager window.

2. Click the red Stop Service button on the button bar.

3. Return to Step 4 in "Configuring analog port boards" on page 8-3 and 
complete board configuration and testing.
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D
Reloading software on an Avaya

MAS

Overview

This appendix describes how to reload the operating system and application software 
on an Avaya Messaging Application Server (Avaya MAS). This procedure can be used 
to install new software on a new system, or to put the required software on the hard 
disk if the MAS suffered a catastrophic disk failure and a hard disk had to be replaced. 

Loading new MAS software

To copy new software to the Avaya Messaging Application Server (Avaya MAS):

1. The KVM switch is connected to the MAS through one of the VGA 
computer ports. Verify that the monitor is showing the correct MAS:

! For a Belkin OmniView Pro2 KVM: To have the monitor show a 
different server, slowly press Scroll Lock, then Scroll Lock again, 
and then the up (or down) arrow key to change to the server 
connected to a higher (or lower) port number. 

Alternatively, you can type the port number instead of pressing the up 
or down arrow key (such as 02 for port 2). See the KVM switch 
documentation for complete user instructions.

! If the monitor does not show the correct server, see "Connecting the 
KVM cables" on page 2-25 and verify that the cable connections are 
correct. To correct cabling problems, power down the system and 
correct the cabling. Then power up the system again. 
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2. Insert the Avaya Modular Messaging OS Boot Software DVD into the 
DVD drive.

Wait for green LED on the drive to go out. 

3. Press Ctrl+Alt+Del to reboot the system.

a. In the Windows Security window, click Shut Down...

b. In the Shut Down Windows window, select Restart and click OK.

4. When the machine begins to boot, it displays a warning that the hard 
drive contents will be overwritten.

a. Press any key to continue. 

A message confirms that the hard drive will be overwritten.

b. Press any key to continue.

The MAS begins to copy the disk image to the hard disk. The entire copy 
procedure might take 15 to 20 minutes. 

5. When finished, the program prompts you to remove the media before 
the system reboots.

a. Remove the DVD from the drive and close the drive door. 

b. Press any key to continue. 

6. When the reboot is complete, the Windows 2000 Server Setup Wizard 
runs. Complete the wizard as follows:

a. On the Your Product Key screen, type the Windows product key for this 
MAS (each unit has a unique product key). 

b. Click Next.

c. On the Licensing Modes screen, do nothing. The wizard continues the 
setup process on its own.

The machine automatically reboots. 

7. When the reboot is complete, proceed as follows:

! If a Found New Hardware wizard does not run, continue with Step 8.

Note: This number must be entered exactly as shown. It is located on 
a sticker or tag on the side or rear of each MAS unit.

CAUTION: Do not touch the keyboard once the software starts loading, 
or the software will not install properly.!
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! If a Found New Hardware wizard runs, you must complete it first, or 
the software will not install correctly. The system runs the hardware 
wizard once for every Dialogic port board installed in the MAS.

Temporarily disable the Dialogic hardware as follows: 

a. On the Welcome screen, click Next. 

b. On the Install Hardware Device Drivers screen, accept the default option 
(Search for a suitable driver) and click Next.

c. On the Locate Driver Files screen, clear the checkbox for Specify a 
location (no boxes will be checked). Click Next.

d. On the Driver Files Search Results screen, verify that Disable the device is 
selected.

e. Click Finish.

f. Repeat Steps a through e for each repetition of the wizard.

8. Double-click the MM_Setup.bat icon on the desktop. 

A C:\WINNT\system32\cmd.exe window is displayed. 

9. The program prompts you to load the required application software:

a. When prompted, insert the Avaya Modular Messaging Application Software 
DVD or CD into the DVD drive.

b. Wait for green LED on the drive to go out. 

c. Press any key to continue. 

The system reports that it copied the D:\MM_Load\MM_Load.bat file. 

d. Press any key to continue. 

The machine displays the list of files that were copied. 

e. Press any key to continue. 

10. When prompted to remove the media:

a. Remove the DVD or CD from the drive and close the drive tray door.

b. Press any key to continue. 

The system reports that the Mini-Setup program will run after the 
system reboots. 

c. Press any key to continue. 

The machine stores the information and shuts down. 

11. To bring the MAS into service, continue with Chapter 5, ��Configuring a 
new Avaya MAS.��
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E
Recovering from a catastrophic disk

failure

Overview

This appendix summarizes the procedure for restoring a Messaging Application Server 
(MAS) if the hard disk drive failed and had to be replaced. 

To recover from a catastrophic disk failure, you will need:

! This guide and other required documentation for system installation. See 
"Required documentation" on page 1-2 for a complete list.

! For an Avaya-provided MAS only, the Avaya Modular Messaging OS 
Boot Software DVD.

! A copy of the completed planning forms, which should be on file. See 
Appendix A, ��System planning forms.�� 

Recovery procedure

Follow the steps in this section for:

! "Restoring an MAS after a catastrophic disk failure" on page E-2

! "Restoring Caller Applications after a catastrophic disk failure" on page 
E-3

Note: Verify that the planning forms are accurate and up-to-date. When 
you restore the MAS machine, you must duplicate exactly the 
information from the original setup (machine names, domain 
names, passwords, and so on) to avoid problems.
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Restoring an MAS after a catastrophic disk failure

To restore any MAS following a catastrophic disk failure:

1. The faulty drive must be replaced and the operating system reloaded 
and brought up to date. 

! For an Avaya MAS: Follow these steps:

(1) See �IDE drive replacement� on the documentation media for 
hardware replacement steps. 

(2) Install the operating system on the new disk drive. Follow the 
steps in Appendix D, ��Reloading software on an Avaya MAS.��

(3) When the disk is restored, return the Avaya MAS to service as 
described in Chapter 5, ��Configuring a new Avaya MAS.��

! For a customer-provided MAS: Follow these steps:

(1) Use the hard disk restoration procedures appropriate for this site 
to replace the hardware and reload the operating system. 

(2) When the disk is restored, return the MAS to service as described 
in Chapter 6, ��Configuring a customer-provided MAS.��

2. For every MAS, complete the installation procedures in Chapter 7, 
��Installing and configuring the Modular Messaging software,�� up to the 
section "Configuring the MAS" on page 7-8. 

3. When you reach "Configuring the MAS" on page 7-8, do these steps: 

a. The Messaging Application Server Configuration Wizard automatically runs. 
Complete Steps 1 through 4 as directed. 

b. For Step 5, on the Voice Mail Domain Selection screen, you must join the 
voice mail domain as a Subsequent server in an existing voice mail 
domain (even if this is MAS#1).

c. Continue with the wizard as directed until Step 8. If the Caller Applications 
Editor was installed, proceed as directed in "Restoring Caller Applications 
after a catastrophic disk failure" on page E-3. 

d. Complete the wizard as directed in "Configuring the MAS" on page 7-8. 

4. Complete the rest the MAS installation through Chapter 9, ��Configuring 
the voice mail system.�� 

5. Reinstall any previously installed patches on this MAS.

mdide.htm
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6. Restore data files from backup including spooled messages, customized 
caller applications, and prompts. See "Restoring Caller Applications 
after a catastrophic disk failure" on page E-3 if relevant for this MAS. 

7. Reinstall any other software that was previously installed on this MAS. 

8. Complete the steps in "Performing acceptance tests" on page 10-3 and 
perform all the tests relevant to this system.

9. When you are satisfied that the system is running correctly, back up the 
restored MAS using the regular backup procedures at this location. See 
"Backing up the system" on page 10-9 for details. 

Restoring Caller Applications after a catastrophic disk failure

The procedure for restoring the Caller Applications Editor software varies depending 
on how it is installed at this site. 

If MAS#1 is the only MAS in the voice mail domain, or if Caller Applications have been 
deployed on only the MAS that has had the hard disk replaced: 

1. Stop the Modular Messaging (MM) Messaging Application Server 
service as follows:

a. Double-click the Monitor icon on the desktop.

b. Select the Services (Local) item in the left pane if it is not already selected.

c. In the right pane of the Monitor window, scroll down to the MM Messaging 
Application Server service. 

d. RIght-click the service and select Stop. 

e. Wait for service to stop, and then click OK to close this window.

2. From the MAS backup files, restore the CallerApps directory to the 
correct location: 
C:\Program Files\Avaya Modular Messaging\VServer\CallerApps

3. Restart the Messaging Application Server service. Follow the procedure 
in Step 1, but select Start when you right-click the service.

If you are restoring any MAS to service in a multiple-MAS system and if Caller 
Applications has been deployed on one or more of the other MASs that are still 
operational and their services are running:

1. In the Messaging Application Server Configuration Wizard, on the Caller 
Application screen, accept the default setting to get the Caller 
Application information from the voice mail domain. 

CAUTION: Do not restore the System State following a catastrophic disk 
failure.!
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2. If you skip this screen or have problems with Caller Applications after 
installation, restore the CallerApps directory as described for a single 
MAS deployment above.

3. If you still encounter problems after following these procedures, restore 
the CallerApps *.uma files to a convenient location and redeploy Caller 
Applications. 
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F
Obtaining a license for an update

Overview

This appendix describes how to gather information required for a license, and how to 
request a license file for a Unified Messenger Release 5.0 system that is to be updated 
to Modular Messaging software. 

Modular Messaging Release 1.1 requires a license file to be installed to enable full 
functionality of the system. Without the license file, a maximum of 10 subscribers can 
be administered. For a system that is already in service with more than 10 subscribers 
administered, no new subscribers can be added to the system until the license file is 
received and installed. 

Topics in this appendix include: 

! "Completing the update planning form" on page F-2

! "Obtaining license data for an update" on page F-4

! "Sending the license request" on page F-9

Planning to submit a license request

The license file is installed near the end of the software update process. However, 
because a license file typically takes a minimum of 3 hours to obtain, it should be 
applied for as early in the update process as possible. Depending on the region, you 
might be required to submit a license activation request several days in advance of 
when the license file will be needed.



585-310-330, Issue 1

Avaya Modular Messaging for IBM Lotus Domino Release 1.1 Installation

F�2 May 2004

If you do not submit the license file request before you begin the update, the system 
can still be updated, but no new subscribers can be added until the license file is 
installed. After the software is updated, you can obtain the voice mail domain identifier 
(VMD ID) from the Voice Mail System Configuration (VMSC) program just as you would 
for a new system installation (see Step 11 on page 9-9).

This procedure is not recommended for updates because of the time delay between 
submitting a license activation request and receiving the license file (at least 3 hours 
during the business week). The recommended procedure is to obtain the required 
licensing information and submit the license request well in advance of the update, 
using the tools and procedures described in this appendix. 

Obtaining the MmVMDAudit tool 

For a Unified Messenger Release 5.0 system, you cannot obtain the crucial voice mail 
domain identifier (VMD ID) from the existing user interface. The only way to get this 
critical piece of information prior to running the Modular Messaging Release 1.1 
software update is to use the MmVMDAudit tool. 

The MmVMDAudit tool is available from the Avaya Support Web site. Go to 
www.avaya.com/support and look under Technical Database > Messaging > 
Applications > Modular Messaging > R 1.1 > PCN. The tool is provided in 
downloadable form from the Product Correction Notice (PCN) page. 

Completing the update planning form

In addition to the documentation and software required for an update (see "Update 
requirements" on page 11-2), you must collect the following information from the 
system itself. This information will be used during the update process.

To complete the "Planning form for update to Modular Messaging R1.1" on page F-3: 

1. Item I1: List every MAS in the system. 

Note: If you plan to update the system over a weekend, you might want 
to apply for the license file a couple of days earlier than it will be 
required, so that you are certain that you receive the file before the 
business week ends. See "Sending the license request" on page 
F-9 for the procedure for submitting a license request and for the 
regional business hours of operation. 

Note: If appropriate, you can begin system and software update activities 
immediately after you submit a license request. You do not need to 
wait for the license file to be returned before you begin the update 
procedure. 

http://www.avaya.com/support
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2. Item I2: For the Windows domain name, enter the NetBIOS name that is 
already assigned to the Windows domain that this Unified Messenger 
system is part of (for example, zodiac).

3. Item I3: Enter the name and password for the customer-specified Unified 
Messenger Release 5.0 service account (for example, mmacct). 

Note: Different MASs can run different Unified Messenger 
software components. For each MAS that has the 
Messaging Application Server service installed on it, specify 
the number of Text-to-Speech (TTS) sessions and the TTS 
engine required. 

Note: Unified Messenger software will become �Modular Messaging� 
software after the update, and the Unified Messenger service 
account will become the Modular Messaging service account. 

Planning form for update to Modular Messaging R1.1

# Required update information Value

I1 Name of each MAS present in the system: 

MAS#1 (required): 

MAS#2: 

MAS#3: 

MAS#4: 

MAS#5: 

MAS#6: 

MAS#7: 

MAS#8: 

MAS#9: 

MAS#10: 

Note: For each MAS that has the Messaging Application Server service installed on it, specify the number of 
Text-to-Speech (TTS) sessions per MAS and the TTS engine required. See "Obtaining license data for 
an update" on page F-4 to determine the number and type of TTS engines to use: 

� Fonix DECtalk, US English 
� ScanSoft TTS-3000, International 

I2 Windows domain name 

I3 Unified Messenger (or Modular Messaging) 
service account user name and password 

Comments: 
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Obtaining license data for an update

For a Unified Messenger Release 5.0 system update, obtain the required data for the 
license request using these steps: 

! "Using the MmVMDAudit tool" below 

! "Calculating the number of TTS sessions" on page F-6

! "Recording the required licensing information" on page F-7 

Using the MmVMDAudit tool

The MmVMDAudit tool gathers important system information that is required to 
generate the license file. To obtain the MmVMDAudit tool, see "Obtaining the 
MmVMDAudit tool" on page F-2. 

The MmVMDAudit tool is supplied as a single executable file, which must be copied to 
a suitable location from which it can be run. Because the MmVMDAudit.exe file 
depends on other Modular Messaging or Unified Messenger software components for 
its operation, it can be run only on a machine on which Unified Messenger client or 
administration software has been installed (such as the Subscriber Options package, 
Voice Mail System Configuration program, or the Caller Applications Editor). It can also 
be copied to any MAS in the voice mail domain.

To install and run the MmVMDAudit tool: 

1. Log in to the appropriate machine (such as an MAS or a client machine 
that is used for subscriber administration). 

2. Copy the MmVMDAudit.exe file to a suitable location. Avaya 
recommends that you use the directory 
Program Files\Unified Messenger.

3. To run the tool, double-click MmVMDAudit.exe. 

The Modular Messaging VMD Audit window is displayed. 

4. To establish communication with the Unified Messenger software, click 
Connect. 

The MmVMDAudit tool attempts to establish communication with a 
Messaging Application Server (MAS) in the voice mail domain (VMD) 
that has been accessed most recently by the Voice Mail System 
Configuration (VMSC) program on this machine. This should take just a 
few seconds. 

5. After communication is established, the Modular Messaging VMD Audit 
window displays the information needed to create a license. Note or 
capture this information as follows: 
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a. VMD name: Note the description for the voice mail domain. This name is 
not required for license generation. However, if multiple voice mail domains 
exist at a site, verify that the information that is being displayed is from the 
VMD for which you need to obtain a license. 

If the wrong VMD is displayed:

(1) Close the Modular Messaging VMD Audit window.

(2) Click Start > Programs > Unified Messenger > Voice Mail 
System Configuration.

(3) In the Voice Mail System Configuration window, select the correct 
voice mail domain. 

(4) Close the Voice Mail System Configuration window. 

(5) Return to Step 3 to run the tool again. 

b. VMD ID: This field shows the unique voice mail domain identifier. This 
information is crucial for obtaining the license file. If the identifier is copied 
incorrectly, the new license file cannot be installed. 

To capture the VMD ID information:

(1) Click Copy to the right of the VMD ID field. 

(2) Open the document where you want to record this information (for 
example, the editable Word version of "Modular Messaging R1.1 
license request - IBM Lotus Domino system" on page A-13). 
Alternatively, you can open any text-editor application (such as 
Notepad) to capture this data for later use. 

(3) Right-click and select Paste to copy the VMD ID from the 
clipboard to the appropriate place in the editable document. See 
Item L1 on "Modular Messaging R1.1 license request - IBM Lotus 
Domino system" on page A-13. 
 

c. MASs in VMD: This field shows the number of MASs that are currently 
administered in this voice mail domain. Make a note. 

d. Administered seats: This value shows the number of seats that are 
actually administered on the Unified Messenger system at this time. This 
number might not be the actual number of seats that the customer 
purchased. If possible, use the original purchase records to verify the actual 
number of purchased seats. 

CAUTION: Use the copy-and-paste method of recording the VMD ID if 
possible. If you try to manually enter the VMD ID, it is easy to 
make mistakes. The VMD ID in the generated license must 
exactly match that of the target system or it will fail to install. 

!
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6. Save the information you recorded in your license data document. 

7. When finished, close the Modular Messaging VMD Audit window. 

Calculating the number of TTS sessions

Because Unified Messenger Release 5.0 systems support up to 12 Text-to-Speech 
(TTS) sessions per TTS engine for each MAS, you must verify the type and number of 
TTS sessions that are presently in use as follows: 

1. Log in to an MAS in the VMD for which you need to obtain a license. 

2. Click Start > Programs > Unified Messenger > Voice Mail System 
Configuration.

3. In the Voice Mail System Configuration window, expand the correct 
voice mail domain. 

4. To determine if this system is set up for multiple TTS engines: 

a. Double-click Languages.

b. In the Languages - Voice Mail Domain window, note if the checkbox to 
Enable Multilingual Text to Speech is checked.

! If the checkbox is checked, this system is currently using two 
types of TTS engine: Fonix DECtalk, US English and ScanSoft 
TTS-3000, International. Multiple TTS engines are permitted. 

! If the checkbox is clear, this system is using only one type of TTS 
engine: Fonix DECtalk, US English. 

c. Click OK to close this window. 

5. To determine the actual number of TTS sessions currently in use: 

a. In the Voice Mail System Configuration window, expand Message 
Application Servers. 

b. Expand the entry for the first MAS. 

c. Double-click Text-to-Speech. 

CAUTION: If you cannot verify the actual number of purchased seats, 
you can use the Administered seats number to generate 
the license. The number of seats will be locked at that value 
when the license is installed and cannot be increased except 
through an after-market purchase. Be aware that using the 
administered (vs. actual) number of seats might be a 
customer dissatisfier, particularly if the customer has 
purchased more seats than are currently administered. 

!
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d. In the Text-to-Speech window, on the General tab, record the number of 
TTS sessions that are currently in use on this MAS. 

e. Expand the entry for the next MAS. 

f. Repeat Steps c through e until you have recorded the actual number of TTS 
sessions in use on every MAS in the system. 

g. Click OK to close this window.

6. Add the total number of TTS sessions from all MASs in the system (see 
Step 5). You will license this number of sessions. 

7. Determine the quantity of TTS sessions to license for each type of TTS 
engine as follows: 

! If the customer wants to keep DECtalk only, assign the total number 
of TTS sessions to the TTS engine type Fonix DECtalk, US English. 

! If the customer wants to keep TTS-3000 only, assign the total number 
of TTS sessions to the TTS engine type ScanSoft TTS-3000, 
International. 

! If the customer wants to keep both the DECtalk and TTS-3000 
engines, specify the number of TTS sessions to use for each TTS 
engine type. For example, if the total number of TTS sessions is 10, 
you might assign 6 sessions to Fonix DECtalk, US English and 4 
sessions to ScanSoft TTS-3000, International. 

8. Record and Save this information in your license data document. See 
Item L2 on "Modular Messaging R1.1 license request - IBM Lotus 
Domino system" on page A-13.

9. When finished, close the Voice Mail System Configuration window.

Recording the required licensing information

After you have gathered the required information from the system using the previous 
procedures, provide all additional required information to complete the licensing 
request. Your choices for recording this information might vary per region. See 
"Sending the license request" on page F-9 for details on local procedures. 

Note: This field assigns the same number of TTS sessions to both 
the Fonix DECtalk, US English and the ScanSoft TTS-3000, 
International engines, although the latter engine is used only if 
Enable Multilingual Text to Speech is enabled (see Step 4). 

Note: The option to keep both TTS engines is permitted only if 
Enable Multilingual Text to Speech is enabled (see Step 4). 
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License request documents include:

! "Modular Messaging R1.1 license request - IBM Lotus Domino system" 
on page A-13 editable Word document, available from the Avaya 
support Web site. Go to www.avaya.com/support and look under 
Technical Database > Messaging > Applications > 
Modular Messaging > R 1.1. For instructions on locating the forms, see 
"Information on the Web" on page 1-2. 

! "Modular Messaging R1.1 license request - IBM Lotus Domino system" 
on page A-13. This form is identical to the Word version listed above. 
You can print this page, fill in all required fields, and fax it to the 
appropriate regional support site (if your region supports faxed license 
activation requests). Most regions prefer an electronic file to reduce 
errors (typically the license request form above sent by email). 

If you create your own document, it must contain all of the required information listed in 
"Modular Messaging R1.1 license request - IBM Lotus Domino system" on page A-13, 
as noted below:

! Always required: Type of license (PCN update), plus Items L1 through 
L4 on "Modular Messaging R1.1 license request - IBM Lotus Domino 
system" on page A-13 as described below: 

� VMD ID: Paste the information obtained on page F-5. 

� TTS sessions and engine: Specify the number of sessions and the 
engine type. See "Calculating the number of TTS sessions" on page 
F-6 for details. 

� Number of seats: Use the original purchase records to verify the 
actual number of purchased seats if possible. See Administered 
seats on page F-5 for details. 

� Platform: Specify IBM Lotus Domino. 

! Required if remote access will be used: Items L5 through L8. 

! Required customer and contact information: Specific items vary per 
region. The license request form lists all commonly requested items. 

Note: For most systems, specify only one TTS engine type for all 
sessions currently in use. Only systems that have Multilingual 
Text to Speech enabled can license both TTS engines. 

Note: Remote access might be needed only during the licensing 
process, and can be removed upon completion. If remote 
access will be used during the update procedure, verify that it 
is set up and working (for example, place a test call to the 
support organization). If needed, see your original installation 
documentation for details about remote access setup. By 
convention, the remote support organization dials in to MAS#1. 

http://www.avaya.com/support
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Sending the license request

The procedure for sending the licensing information varies per region. Continue with 
the appropriate section based on your location:

! "Submitting requests in APAC" below 

! "Submitting requests in Australia" on page F-10

! "Submitting requests in CALA" on page F-11 

! "Submitting requests in Canada" on page F-11 

! "Submitting requests in EMEA" on page F-12 

! "Submitting requests in North America (excluding Canada)" on page 
F-13  

Submitting requests in APAC

The recommended procedure for Business Partners and Direct Customers in the Asia 
Pacific (APAC) region is: 

1. Obtain the current instructions for completing a license activation 
request and check for new procedures. Follow the instructions, but be 
sure to include all required information as described in this appendix. 

2. Complete the license request form, providing the information required 
for an update. See "Modular Messaging R1.1 license request - IBM 
Lotus Domino system" on page A-13. 

3. Submit the license request form to the Regional Technical Assistance 
Center (RTAC) at least 2 (two) working days prior to the Requested 
Completion Date. 

4. When completed, send the license request form to: 

! Email: sgcoe@avaya.com 

! Fax: +65 6872-8688 

Note: Always check with your regional representative for recent changes 
to the licensing process and for regional variations. Procedures 
and hours of operation are subject to change. 

Note: If you use the process described in this guide, you do not have 
to wait for the day of the update to obtain the VMD ID. 
Business Partners must provide the VMD ID on the license 
request form, because remote technical support is available 
only for Direct Customers in this region. 
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License file generation and license activations are completed Monday through Friday 
between the hours of 9 AM and 6 PM Singapore time only. There are no after hours 
activations. Plan accordingly to obtain the license file in time for the scheduled update. 

Submitting requests in Australia

The recommended procedure for Business Partners and Direct Customers is: 

1. Obtain the current instructions for completing a license activation 
request in this region. Follow the instructions, but be sure to include all 
required information as described in this appendix. 

2. Complete the license request form, providing the information required 
for an update. See "Modular Messaging R1.1 license request - IBM 
Lotus Domino system" on page A-13. 

3. Submit the license request form to the Regional Center of Excellence 
(RCOE) at least 2 (two) working days prior to the Requested 
Completion Date. 

4. When completed, send the license request form by email to 
aubcshelp@avaya.com. 

License file generation and license activations are completed Monday through Friday 
between the hours of 8:30 AM and 5 PM Sydney, Australia time only. There are no after 
hours activations. Plan accordingly to obtain the license file in time for the scheduled 
update. 

Note: The RTAC will return a Maestro case ID. Include this case ID in 
any future correspondence and emails. 

Note: If you use the process described in this guide, you do not have 
to wait for the day of the update to obtain the VMD ID. 
Business Partners must provide the VMD ID on the license 
request form, because remote technical support is available 
only for Direct Customers in this region. 

Note: The RCOE will return a Maestro case ID. Include this case ID 
in any future correspondence and emails. 
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Submitting requests in CALA 

The recommended procedure for Business Partners and Direct Customers in the 
Central America and Latin America (CALA) region is: 

1. Obtain the current instructions for completing a license activation 
request in this region. Follow the instructions, but be sure to include all 
required information as described in this appendix. 

2. Complete the license request form, providing the information required 
for an update. See "Modular Messaging R1.1 license request - IBM 
Lotus Domino system" on page A-13. 

3. You must open a Maestro case by calling GRC at 781-331-0860 and 
submit the license request form at least 72 business hours (nine working 
days) prior to the Requested Completion Date.

4. When completed, send the license request form and the Maestro case 
ID by fax to +011 5255 78787825 to the Global Response Center (GRC). 

License file generation and license activations are completed during local business 
hours only. There are no after hours activations. Plan accordingly to obtain the license 
file in time for the scheduled update. 

Submitting requests in Canada

The recommended procedure for Business Partners and Direct Customers is: 

1. Obtain the current instructions for completing a license activation 
request in this region. Follow the instructions, but be sure to include all 
required information as described in this appendix. 

2. Complete the license request form, providing the information required 
for an update. See "Modular Messaging R1.1 license request - IBM 
Lotus Domino system" on page A-13. 

3. You must open a Maestro case at least 5 (five) working days prior to the 
Requested Completion Date. To open a Maestro case:

! Call Avaya at 1-800-387-4268

Note: If you use the process described in this guide, you do not have 
to wait for the day of the update to obtain the VMD ID. 

Note: Include the Maestro case ID in any future correspondence and 
emails. 

Note: If you use the process described in this guide, you do not have 
to wait for the day of the update to obtain the VMD ID. 
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! Go to http://webticketing.avaya.com and open a case. Use 
description License activation for MM 1.1 and priority Severity 2. 

4. Submit the license request form at least 5 (five) working days prior to the 
Requested Completion Date.

5. When completed, send the license request form and the Maestro case 
ID by fax to (905) 752-8609. 

License file generation and license activations are completed Monday through Friday 
between the hours of 8 AM and 5 PM EST only. There are no after hours activations. 
Plan accordingly to obtain the license file in time for the scheduled update. 

Submitting requests in EMEA

The recommended procedure for Business Partners and Direct Customers in the 
Europe, Middle East, and Africa (EMEA) region is: 

1. Obtain the current instructions for completing a license activation 
request in this region. Follow the instructions, but be sure to include all 
required information as described in this appendix. 

2. Complete the license request form, providing the information required 
for an update. See "Modular Messaging R1.1 license request - IBM 
Lotus Domino system" on page A-13. 

3. You must submit the form at least 2 (two) working days prior to the 
Requested Completion Date.

4. When completed, submit the license request form to the Regional 
Technical Support Center (RTSC) based in Budapest, Hungary: 

! Email: cscservices@avaya.com 

! Fax: +31-70-414- 8799 

License file generation and license activations are completed Monday through Friday 
between the hours of 9 AM and 6 PM CET only. There are no after hours activations. 
Plan accordingly to obtain the license file in time for the scheduled update. 

Note: Include the Maestro case ID in any future correspondence and 
emails. 

Note: If you use the process described in this guide, you do not have 
to wait for the day of the update to obtain the VMD ID. 

Note: The RTSC will return a Maestro case ID. Include this case ID in 
any future correspondence and emails. 

http://webticketing.avaya.com
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Submitting requests in North America (excluding Canada) 

For Business Partners and Direct Operations in North America (including the United 
States but not Canada), the recommended procedure is: 

1. Obtain the current instructions for completing a license activation 
request in this region. Follow the instructions, but be sure to include all 
required information as described in this appendix. 

2. Complete the license request form, providing the information required 
for an update. See "Modular Messaging R1.1 license request - IBM 
Lotus Domino system" on page A-13. 

3. When finished, send the completed file by email to osg@.avaya.com. 
The file must be transmitted in electronic form to minimize errors in 
transcribing values (such as the VMD ID). 

License file generation and license activations are completed Monday through Friday 
between the hours of 6 AM and 5 PM Pacific Time only. There are no after hours 
activations. Plan accordingly to obtain the license in time for the scheduled update. 

For licensing questions, contact:

! Email: osg@avaya.com 

! Avaya Direct: 408-922-1822

! Business Partners: 877-295-0099 

Note: If you use the process described in this guide, you do not have 
to wait for the day of the update to obtain the VMD ID. 
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G
Removing Modular Messaging

components

Overview

This appendix describes how to remove Modular Messaging software components 
from a machine where they are currently installed. You might use this procedure if you 
want to change the Messaging Application Server (MAS) on which a particular feature 
is installed, or to remove Modular Messaging software packages or tools from a 
Microsoft Windows machine that is used for administration. 

Removing software components

To remove Modular Messaging software components:

1. Click Start > Settings > Control Panel.

2. From the Control Panel window, double-click Add/Remove Programs.

3. In the Add/Remove Programs window, scroll down the list of currently 
installed programs to locate the Modular Messaging software 
components installed on this machine. 

All Modular Messaging components begin with MM. 

4. Click the Modular Messaging software component you want to remove 
(for example, click MM Caller Applications Editor). 

5. Click Remove.

6. If prompted to confirm the deletion:

! Click Yes to remove the selected component.
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! Click No to leave this component installed on this machine. 

When the component removal is complete, the next item in the 
Add/Remove Programs window is selected. 

7. Repeat Steps 3 through 6 to remove additional software components, if 
needed.

8. When finished, close this window.



IN-iMay 2004 585-310-330, Issue 1

Index

A
about this book, i-ix
acceptance tests, 10-1, 10-3 to 10-6, 10-8, 11-17
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overview, 5-2
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errors, 9-18
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running, 9-18
uninstall, 9-18
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Brooktrout port boards, 10-9, 11-3, 11-5, 11-17, C-1
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Avaya MAS, 2-20
ferrites, 2-27
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UPS and EBMs, 2-13
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Call Me - Voice Mail Domain window, 9-5
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configuring an Avaya MAS, 5-1, 5-4, 5-15
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configuring the voice mail system, 9-1 to 9-2
corporate FQDN, A-5
corporate LAN

administering, A-4
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settings on Avaya MAS, 5-6
terminology, A-2
testing addresses with ping, 5-11

creating a new tone file, C-1 to C-2, C-7
creating test messages, 10-3, 10-5
CT bus cable, 3-8
customer responsibility for system security, 1-4
customer-provided MAS, A-3

adding accounts to local group, 6-5
adjusting system values, 6-6
configuring, 6-1
installation checklist, B-2
installing port boards, 3-1
join a Windows domain, 6-4
network card, 6-3
remote access, 7-12
required hardware, 1-8, 3-2
required software, 6-9
virus-checking software, 6-3

D
default gateway, 5-6, A-2

demarcation points, 2-6
Diagnostic Tools, 7-4 to 7-5
Dialogic Configuration Manager, 8-3, 8-5, 8-7, C-1 to 
C-2, C-7
Dialogic Configuration Manager Properties window, 8-3, 
8-6, 8-8
Dialogic drivers, 3-9, 11-6 to 11-8
Dialogic Line Test Application window, 8-10 to 8-12
Dialogic Line Tester program, 8-10
Dialogic port boards, see port boards
DID numbers, A-14
directory server, A-2
DNS server, A-3
DNS setup, 5-6 to 5-7, A-5
documentation, i-xii, 1-2 to 1-3
domain name, A-2, A-4 to A-5
Domain Name Service (DNS), A-2
domain suffix, 5-8
domain-wide feature setup, 9-3
Domino directory database file, 7-9, 9-16
Domino directory updates for Modular Messaging, 4-3
Domino domain, A-2
Domino server, 1-8, A-2, A-4

editing voice mail summary document, 9-16
hierarchical name, 5-13, 6-10, 7-8
peer Domino server, 4-4, 5-13, 6-10, 7-8, A-2, A-4
preparing for Modular Messaging, 4-3

Domino software required, 4-2, 5-12, 6-9, 11-3
Domino Unified Communications (DUC) software, see 
DUC, 4-2
Domino Unified Communications Client for 1.2.2 for 
Avaya installation wizard, 9-17
DUC

acceptance test with administration 
component, 10-6
administrator guide, 1-2, 4-3, 9-16, 10-2, 11-3
install administration component, 4-3, 11-3
install client component, 9-16
install server component, 11-3
requirements, 4-2, 11-3
templates for Modular Messaging, 4-3
update to Modular Messaging, 11-3

DVD contents, 1-3, 11-2

E
E1-QSIG boards

cabling, 2-22, 3-12
configuring, 8-7
jumper settings, 3-7
testing, 8-10

EBM installation, 2-10
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edit the voice mail summary document, 9-16
edit TTS sessions, 9-11
enable subscribers for Modular Messaging, 4-3, 10-2
enabling Microsoft Windows services, 6-8
environmental conditions, 2-3
error logs on MAS, 9-15
Ethernet cabling, 2-22
event viewer, 6-6, 9-4, 9-13
extended battery module (EBM), see EBM

F
ferrites, 2-27
flat-panel monitor, 2-23, 2-27
Found New Hardware wizard, 3-9, 5-10, D-3
front bezel on Avaya MAS, 2-16

G
grounding requirements, 2-5
guidelines for completing planning forms, A-4

H
hard disk repairs, i-xi, D-1, E-1
hardware installation

Avaya MAS, 2-1, 2-14, 2-16 to 2-17, 2-19 to 2-20
cabling, 2-22, 2-26, 3-12
ferrites, 2-27
front bezel, 2-16
hardware list, 2-7, 3-2
KVM switch, 2-23 to 2-26
packing materials, 2-8
port board cables, 3-12
port boards, 3-2, 8-2
power cables, 2-20
preinstallation requirements, 1-8, 2-3, 3-3
sample installed system, 2-8, 2-19
unpack system hardware, 2-7
unpack the hardware, 3-4
UPS and EBMs, 2-10
USB modem, 2-28, 9-14

help using the system, i-xiii
host name, A-3 to A-4
how to use this book, i-x
humidity requirements, 2-3
hunt group for messaging services, A-14

I
INADS alarming, 9-8, 9-14, 11-15, A-15
information on the Web, 1-2
initial administration for PBX or switch and LAN, 1-6, A-5

Initialization and Administration System (INADS), see 
INADS, A-3
install a license, 9-10
install Modular Messaging software, 7-3
installation

Avaya MAS setup, 5-1
backing up system, 10-9
checklist, B-1
configuring port boards, 8-1
configuring voice mail system, 9-1 to 9-2
creating a new tone file, C-1
customer-provided MAS, 6-1
DUC administration component, 4-3
DUC client component, 9-16
DUC server component, 4-3
hardware installation, 2-1, 3-1
load new operating system, D-1
Modular Messaging software, 7-1, 7-3
planning forms, A-1
preinstallation requirements, 1-1
preparing to install Modular Messaging, 4-1
testing the system, 10-1

integrated mode test, 10-4
Intel Dialogic Configuration Manager window, 8-3, 8-5, 
8-7, C-6, C-10
Intel Dialogic Configuration Manager, see Dialogic 
Configuration Manager
Intel Dialogic System Software and SDK for Windows 
System Release 5.1.1 for Windows wizard, 3-10, 11-8
intended audience, i-ix
Internet Protocol (TCP/IP) Properties window, 5-6, 5-9
IP address, A-3
IP address administration, 5-6, 7-13, A-4 to A-5
IP gateway, A-3
IP H.323 integration, i-xi, 1-8, 2-15, 3-2, 5-10, 8-1

J
join a voice mail domain, 7-9, 11-4, E-2
join a Windows domain, 5-9, 6-4

K
key components of Avaya MAS, 2-14
keyboard, monitor and mouse setup, see KVM switch
KVM switch

installation, 2-23 to 2-26
showing the correct server, 5-2, D-1

L
LAN

administration, 5-6
demarcation points, 2-6
initial administration, A-5
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terminology, A-2
Language Packs, 7-5, A-11
language preference on MAS, 9-3
languages, A-11
Languages - Voice Mail Domain window, 9-7, F-6
Learn Tones window, C-5, C-9
learning tones, C-1 to C-2, C-7
license

backup file, 10-9
obtain or install, 9-9 to 9-10, 11-3, 11-15
request file or support, 9-9 to 9-10, A-12, F-1, F-7, 
F-9

License Import wizard, 9-11
links to other files, i-xi
loading new MAS software, D-1
local administrator account, 5-15, 6-4 to 6-5, 6-8, A-10
Local Area Network (LAN), see LAN, A-2
logon accounts, A-10
Lotus Notes Client Configuration wizard, 5-13, 6-10
Lotus Notes, see Notes

M
mail templates in DUC for Modular Messaging, 4-3
mailbox file for MAS, 4-4, 7-8
Mailbox Monitor Server, 7-5 to 7-6, 11-12, A-11
MAS administration

access permissions, 9-6
computer accounts, 4-6
in VMSC, 9-4, 9-12, F-5 to F-7
load new software, D-1
remove software, G-1
setting up remote access, 7-11
subsequent MAS, 10-8
testing port boards, 8-10

MAS port board installation, 3-8
MAS services and features, A-11
MAS-specific parameters, 9-12
maximum number of concurrent sessions, A-11
Message Waiting Indicator - Voice Mail Domain 
window, 9-6 to 9-7
Message Waiting Indicator (MWI) Server, 7-5 to 7-6, 9-5, 
11-12, A-11
Message Waiting Indicator (MWI), see MWI
Messaging Application Server, 7-5, A-11
Messaging Application Server (MAS), see MAS, A-3
Messaging Application Server Configuration wizard, 7-8, 
11-14, E-2 to E-3
messaging service recovery procedures, 9-14, 11-16
messaging services to install, A-11

Microsoft Windows services required, 6-8
Microsoft Windows services, see Windows services
Microsoft Windows updates, 1-5, 5-12, 6-3, 6-9, 11-5
MM Messaging Application Server, 8-10, 9-4, 9-13, E-3
MmVMDAudit tool, F-2, F-4
modem configuration, 7-14, 9-14
modem installation, 2-28, 3-13
Modular Messaging accounts, 4-5, 4-7, 5-15, 6-5, A-10
Modular Messaging Installation wizard, 5-16, 7-3 to 7-4, 
11-11, 11-13
Modular Messaging MAS planning form, A-4, A-7 to A-9
Modular Messaging OS Component Configuration 
wizard, 5-15
Modular Messaging services

start, 9-4, 9-12, 10-4
stop, 9-12, 11-5

Modular Messaging software installation, 7-1, 7-3
monitor keyboard, and mouse setup, see KVM switch
MultiTech modem, 2-28, 7-14
MWI

configuring, 9-5
installing software, 7-5 to 7-6, 11-12
maximum number of sessions, 9-13, A-11
testing operation, 10-4

N
NetBIOS domain, F-3
NetBIOS name, A-3 to A-4
network addressing on Avaya MAS, 5-6
network card configuration, 6-3
network planning, A-1
nonintegrated mode test, 10-5
Notes client

on client machines, 9-17, 11-4, 11-17
on MAS, 5-13 to 5-14, 6-9, 6-11, 11-4
update to Modular Messaging, 11-4, 11-17

Notes user ID file for MAS, 4-4, 5-13, 6-9 to 6-10, 7-6, 7-8

O
obtain a license, 9-9, A-12 to A-13, F-1
offline access feature, 7-10, 9-7, 11-15, A-5
Offline Storage Location screen, 7-10
online help, i-xiii
Options package for Avaya Modular Messaging, see 
Avaya Modular Messaging Options package
outcalling test, 8-12, 10-6

P
passwords
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guidelines, A-10
Modular Messaging logon accounts form, A-10
security, 1-5, A-6

PBX
configuration notes, 1-2, 8-2, 8-10, 8-12, 9-3, 9-12 to 
9-13, 11-3, A-14, C-1
configuring, 9-11
demarcation points, 2-6
integration, 9-13
planning form, A-14
supported integrations, 9-11

PBXpert utility for tones file, C-1, C-7
PBXpert wizard, C-2
peer directory server, 7-8, A-5
peer Domino server, 4-4, 5-13, 6-10, 7-8, A-2, A-4
performing acceptance tests, 10-3, 10-5 to 10-6, 10-8, 
11-17
permissions

Modular Messaging accounts on Windows, 4-5 to 
4-6, 6-5
remote access, 4-7, 9-6
Subscriber Administration window, 9-7
System Administration window, 9-6
voice server and administrators, 4-4

Person document
default settings, 9-16
testing, 10-2, 10-6
updates for Modular Messaging, 4-3, 10-2

Phone And Modem Options window, 7-14
ping IP addresses, 5-11
planning forms, i-x, 1-6, A-1

MAS features list, A-11
Modular Messaging logon accounts form, A-10
Modular Messaging MAS planning form, A-7 to A-9
Modular Messaging R1.1 license request, A-12
switch and messaging information, A-14
update to Modular Messaging R1.1, F-2

Point-to-Point Protocol (PPP), A-3
port boards

Brooktrout, 10-9, 11-3, 11-5, 11-17, C-1
configuring, 3-13, 8-1 to 8-2, 8-5, 8-7, 9-13 to 9-14, 
11-10
connecting cables, 3-12
drivers and software, 3-9
extension numbers, A-14
hardware wizard, 3-9
installation, 3-1 to 3-3, 3-8
jumper settings, 3-4
supported boards, 3-2, 8-2
testing, 3-13, 8-7, 8-10, 8-12, 11-10
updating drivers, 11-6

power cables for Avaya MAS, 2-20
power requirements, 2-4
preferred language, 9-3

preinstallation planning, 1-6, A-1
preinstallation requirements, 1-1

customer machines, 4-2
hardware, 1-8
LAN and PBX or switch administration, 1-6
security, 1-4 to 1-5
tools, 1-7

preparing to install Modular Messaging software, 4-1
prerequisite software for MAS, 5-12, 6-9
primary language, 9-7
product ID number, 9-8, A-15
Prompt Files, 7-5, A-11

R
rack-mount setup

Avaya MAS, 2-17
KVM switch, 2-23
sample installed system, 2-8
UPS and EBMs, 2-10

recovering from a catastrophic disk failure, E-1
register MAS as Notes user, 4-4
related resources, i-xii
remote access

account setup, 4-5, 4-7, 5-15, 6-5, 9-6, A-10
licensing, 9-9, 11-15, F-8
MAS setup, 4-6, 5-14, 7-11, 7-13

remote support center, i-xii, 9-9, 11-15, F-8 to F-9
remove MAS software, G-1
remove test subscribers, 10-8
required Domino software, 4-2, 5-12, 6-9, 11-3
restart Modular Messaging service, 9-12
restricted-access location, 2-4
retrieve test messages, 10-4
run Modular Messaging Installation wizard, 7-3, 11-11

S
safety requirements, 2-4 to 2-5
scheduled backup, 10-9
secondary peer directory server, A-5
security, 1-4 to 1-5

passwords, A-6, A-10
permissions to access system, 9-6

Security - Voice Mail Domain, 9-6
security patches, 1-4 to 1-5, 5-12, 6-3, 6-9, 11-5
sending test messages, 10-3, 10-5
service accounts, see Modular Messaging accounts, 4-5
Serviceability - Voice Mail Domain window, 9-8
set emulation boards

cabling, 2-22, 3-12
configuring, 8-5
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jumper settings, 3-6
testing, 8-10

setting up Domino for Modular Messaging, 4-3, 9-16
setting up remote access, 4-6, 7-11
show correct server on monitor, 5-2, D-1
Simple Mail Transport Protocol (SMTP) software, 6-8
Simple Network Management Protocol (SNMP) service, 
see SNMP
Simple Network Management Protocol (SNMP) 
software, 6-8
site requirements

customer-provided cabinet, 2-3
demarcation points, 2-6
environmental conditions, 2-3
installation area, 2-4
power and ground, 2-4 to 2-5
test equipment, 1-7
weight and space considerations, 2-3

SNMP
alarming setup, 9-8, A-15
enabling trap service, 6-9, 9-9
install service, 6-8

software shipped with system, 1-3
space considerations, 2-3
stackable configuration

Avaya MAS, 2-19
KVM switch, 2-24
UPS and EBMs, 2-12

start Modular Messaging services, 9-14, 11-16
starting up the Avaya MAS, 5-3
static IP addresses, 7-13, A-5
subnet mask, A-3
Subscriber Options, see Avaya Modular Messaging 
Options package
subsequent MAS, 5-2, 10-8, 11-17, A-4

administer, 10-8
configuration, 7-10, 9-12
join a voice mail domain, 7-9

switch and messaging information, A-14
switch, see PBX
synchronize clocks, 9-18
system hardware, see hardware installation
system planning forms, A-1
System Release 5.1.1 Feature Pack 1 wizard, 3-10, 11-9
system security, 1-4 to 1-5
System Upgrade screen, 11-13

T
T1/E1 connections, 2-4
T1-QSIG boards

cabling, 2-22, 3-12

configuring, 8-7
jumper settings, 3-7
testing, 8-10

TCP/IP settings, 5-6 to 5-7, 5-9
technical assistance, i-xii
technical support account, see remote access 
account, 6-5
Telephone User Interface, 9-5
telephones for acceptance testing, 1-7, 10-3
Telephony Configuration wizard, 9-12
Telephony Interface configuration, 9-13 to 9-14
temperature requirements, 2-3
templates in DUC for Modular Messaging, 4-3
terminology, A-2
test equipment, 1-7, 10-3
test subscriber, A-14

remove, 10-8
set up, 10-2

testing IP addresses using ping, 5-11
testing outcalling capability, 8-12, 10-6
testing port boards, 3-13, 8-10, 11-10
testing the system, 10-1, 11-17
Text-to-Speech (TTS) feature, 7-7, 9-7, 9-11, 11-12, 
11-15, A-11, F-6 to F-7
tone file, 8-3 to 8-4, 10-9, 11-5, 11-7, C-1, C-5, C-9
tools for installation, 1-7
Tracing Server, 7-5 to 7-6, 11-12, A-11
track messaging service startup, 9-4, 9-13
trademarks, i-xii
training, i-xiii
TTS sessions

licensing, A-12, F-6, F-8
specifying per MAS, 9-11, A-11

U
Unified Messenger Release 5.0 updates, 11-1
Unified Messenger services, stop and reset, 11-5
uninterruptible power system (UPS), see UPS
unpack hardware, 3-4
unpack the hardware, 2-7
update Domino directory design, 4-3
update to Modular Messaging, 9-18

acceptance tests, 11-17
Avaya Modular Messaging Options package, 11-4, 
11-16
backups, 11-17
checklist, B-9
completing the update, 11-17
configuring MAS, 11-14
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configuring new features, 11-15
Dialogic drivers, 11-6
DUC software, 11-3
from Unified Messenger Release 5.0, 11-1
join a voice mail domain, 7-9, 11-4
license for UM updates, 9-9 to 9-10, A-12, F-1
multiple-MAS configuration, 11-4
Notes client, 11-4, 11-17
obtain a license, A-12 to A-13, F-1
overview, i-xi, 11-2 to 11-3
planning forms, A-12, F-2
preparation, 11-5
prerequisite software, 11-5
requirements, 11-2
running system upgrade, 11-13
start Modular Messaging services, 11-16
supported port boards, 8-2, 8-5, 8-7
test subscribers, 10-2
testing port boards, 8-10 to 8-11
updating Modular Messaging software, 11-10

UPS installation, 2-10
USB modem, 2-28, 7-14
using links in this book, i-xi

V
ventilation of servers, 2-4
verifying alarming setup, 9-15
virtual memory size for MAS, 6-7
virus-checking software, 1-5, 5-12, 6-3, 11-5
VMD ID, obtaining, 9-10, F-5
voice mail domain, 7-9, 9-4, A-3, A-5, F-5 to F-7
voice mail summary document editing, 9-16
Voice Mail System Configuration (VMSC) setup, 9-1 to 
9-2, 9-12, 11-15

Call Me Server, 9-5
Languages, 9-7, F-6
Licensing, 9-9, 9-11
Message Waiting Indicator Server, 9-5
Messaging Application Servers, 9-12 to 9-13, F-6
Offline Access, 9-7
PBXs, 9-11, 9-13
port boards, 9-13
Security, 9-6
Serviceability, 9-8, 9-14
Telephone User Interface, 9-5

Voice Mail System Configuration window, 9-4, 9-12, 
11-16, F-5 to F-7

W
Web access to documentation, 1-2
weight and space considerations, 2-3
Windows 2000 Server Setup wizard, 2-30, 5-1, 5-4, D-2
Windows Components wizard, 6-8

Windows domain, A-3
Windows product key, 5-5, D-2
Windows services

installing, 6-8
SNMP service, 6-8
SNMP Trap service, 6-9, 9-9
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